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1 Introduction to Siebel CRM 
Integration Pack for Trade 
Promotion Management

Preface
Welcome to the Siebel CRM Integration Pack for Trade Promotion Management Implementation 
Guide.

TTY Access to Oracle Support Services
Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the United 
States of America 24 hours a day, seven days a week. For TTY support, call 800.446.2398.

Accessibility of Links to External Web 
Sites in Documentation
This documentation may contain links to Web sites of other companies or organizations that Oracle 
does not own or control. Oracle neither evaluates nor makes any representations regarding the 
accessibility of these Web sites.

Structure
1 Introduction to Siebel CRM Integration Pack for Trade Promotion Management

2 Siebel CRM Integration Pack for Trade Promotion Management Environment

3 Installation and Configuration

4 Integrations

Related Documents
For more information, read the following documents:

■ Oracle Trade Management Implementation Guide

■ Oracle Trade Management User Guide

■ Siebel Consumer Goods Guide



Siebel CRM Integration Pack for Trade Promotion Management 
Implementation Guide Version 1.00

Introduction to Siebel CRM Integration Pack for Trade Promotion Management ■ Do 
Not Use Database Tools to Modify Oracle Applications Data

8 

Do Not Use Database Tools to Modify 
Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data Browser, database 
triggers, or any other tool to modify Oracle Applications data unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and maintain 
information in an Oracle database. But if you use Oracle tools such as SQL*Plus to modify Oracle 
Applications data, you risk destroying the integrity of your data and you lose the ability to audit 
changes to your data.

Because Oracle Applications tables are interrelated, any change you make using an Oracle 
Applications form can update many tables at once. But when you modify Oracle Applications data 
using anything other than Oracle Applications, you may change a row in one table without making 
corresponding changes in related tables. If your tables get out of synchronization with each other, 
you risk retrieving erroneous information and you risk unpredictable results throughout Oracle 
Applications.

When you use Oracle Applications to modify your data, Oracle Applications automatically checks that 
your changes are valid. Oracle Applications also keeps track of who changes information. If you enter 
information into database tables using database tools, you may store invalid information. You also 
lose the ability to track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.

Glossary
360° View. A screen within the Oracle Customer Online application that displays a comprehensive 
list of contracts, credit information, email interactions, install base, invoices, orders, quotes, 
payments, projects, and service requests for a given customer.

Account. In Oracle, an account describes the specific attributes of a party that are relevant to the 
selling relationship that the implementing organization has established with a party. An account in 
Oracle cannot exist by itself without a party. It can be associated with an individual (person) or a 
company (organization). 

BES. Oracle Business Event System based on Oracle Workflow

BOM. Bill of materials - defines components and hierarchy of a product.

BPEL. Business Processes Execution Language, a standards-based extensible language.

Catalog Category. A category is a logical classification of items that have similar characteristics.

Category Set. Category sets may be used as a means to develop custom lists of items on which 
to report and sort. A category set is a distinct grouping scheme and consists of categories.

CBM. The “created_by_module” column in TCA tables

CDH. Oracle Customer Data Hub

Chargeback. Amount of a deduction that is rejected by the manufacturer and charged back to the 
wholesaler/retailer.
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Connector. Siebel product that supports point-to-point integration

Consumer Products Goods or CPG Manufacturer. Consumer Products manufacturers typically 
sell one of the following types of consumer products: Durable Goods, Packaged Goods, Food and 
Beverage, Health and Beauty and Configured Products. One key characteristic of Consumer Products 
Manufacturers is that they sell “consumer” products but typically always use a retailer, distributor or 
wholesaler to distribute their product instead of selling directly to the consumer. Consumer Products 
Manufacturers have a unique requirement because they offer their customers trade dollars to market 
and sell their products.

Contact. In Oracle E-Business Suite 11i, a contact describes a specific relationship between two 
parties, more specifically between an Organization and a Person party, which is also called an 
Organization Contact. The Organization Contact can also be associated with a Customer Account in 
Oracle, which is then called an Account Contact. In Siebel CRM On Demand a contact describes an 
individual customer that may or may not be related to an Account (Organization customer) or 
another Contact (individual customer).

Consumer Products Industry. The Consumer Products industry is divided into two segments: 
Durables and Non-Durables. Durable goods are items that the purchaser assumes will be used for 
long periods of time. Examples are washer/dryers, refrigerators, exercise equipment, bicycles, and 
clothing. Non-Durable goods include 3 sub segments. 1.) Shelf stable consumables (such as cereal, 
shampoo, and cleaners) 2.) Perishable food (such as fresh baked goods and refrigerated food) 3.) 
Beverages. 

Corporate Promotion. A trade promotion designed to drive sales across numerous accounts and 
generated by a manufacturer at a national, divisional or corporate level.

Customer. In Oracle E-Business Suite 11i, a customer is defined as a party with whom the 
implementing organization has established a selling relationship. All relevant information of the 
specific selling relationship with a party is modeled in the account layer entities in Oracle, whereas 
all the base information like name, address information, contact points are modeled in the party layer 
entities. A customer in Oracle can be an individual (person) in case of a Business-to-Consumer 
relationship or a company (organization) in case of a Business-to-Business relationship. In Siebel 
CRM On Demand, a customer can be either modeled as an Account or as a Contact. An Account in 
Siebel is the equivalent of an organization party plus account in Oracle, and a Contact is the 
equivalent of a person party plus account in Oracle.

Deal.  A record that consists of the funding source, estimated costs, and parameters for the trade 
offer presented.

Deduction. When an account does not pay the full amount of a manufacturer’s invoice for the 
settlement of a trade related expense.

EAI.  Enterprise Application Integration

EBS. Oracle E-Business Suite Applications

FMW. Oracle Fusion Middleware

Fund Group.  A Siebel Trade promotions concept for facilitating the creation of multiple trade funds.

Fund Transfers.  Moving the assignment of a trade fund from one account to another.

Install Base. An Oracle record of the goods and services a customer owns.
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Item. A product or service that is manufactured or sold. Item can be used to represent grouping 
assemblies or placeholder such as phantoms.

Live Budget.  A live budget is a fully accrued budget that starts at zero and increases based on 
order activity. In some systems this is referred to as a Rolling Fund. The initial budget is calculated 
based on a past shipment period and as shipments are made, the fund accrues additional budget 
amounts.

Merchandising Activity.  The details of one aspect of a trade promotion. A trade promotion can 
have 1 or more merchandising activities/types. For example, a Summer Promotion can be comprised 
of 3 Merchandising Activities/Types: Temporary Price Reduction of $100 off/case given directly off of 
the invoice, Temporary Price Reduction of $250 off/case given in the form of a rebate and a $2000 
Lump sum payment for putting up an end aisle display promoting my products. 

Middleware. Integration software that is used to connect applications, such as Webmethods.

OAF. Oracle Applications Framework for Development

Order Management. Refers to organizations as warehouses on all Order Management windows 
and reports.

Organization. A business unit such as a plant, warehouse, division, department, and so on.

OS. The “orig_system” column in TCA table

OWB. Oracle Warehouse Builder

Party. In Oracle E-Business Suite 11i, more specifically in the Trading Community Architecture 
(TCA), a party is defined as any individual or organization with whom the implementing organization 
can do business. A party in Oracle TCA can be a customer, in case a selling relationship has been 
established or for example a vendor or an employee. The same party can have multiple such roles 
within Oracle E-Business Suite 11i. This integration solution addresses those parties in Oracle E-
Business Suite 11i that represent customer data. 

Period.  Duration of time for the promotion. By default, the Start and End dates for the promotion, 
shipment, and consumption fields are equal to the start and end dates of the period.

Plan.  A group of trade promotions

Pre-authorized deduction.  Manufacturer provides retailer prior approval to take a deduction to 
settle a trade payment claim.

SOD. Siebel CRM On Demand Application

Tactics. Select tactics to use for the promotion. For example, select a feature display or temporary 
price reduction as a tactic to promote the selected promoted category.

TCA. Trading Community Architecture

Trade Fund.  An amount of money appropriated for the execution of trade promotions. Can be fixed 
or accrual.
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Trade Promotion.  A term used in the Consumer Product industry to refer to a merchandising event 
done for, or given to, a retailer in exchange for selling or better positioning the manufacturer's 
products. Can be a discount given either off-invoice or in the form of a bill back based on incoming 
sales orders or can be a lump sum payment unrelated to sales orders. Can be made up of one or 
more merchandising activities/types. The promotion stores high-level information like customer, 
dates, and description. Trade promotions are always funded out of funds specifically targeted for 
trade promotions.

UAN.  Universal Application Network, a Siebel integration product that support hub-spoke 
environment

Write Off.  Amount of a deduction that cannot be identified and therefore is absorbed by the 
manufacturer

WS. Web Service
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2 Siebel CRM Integration Pack for 
Trade Promotion Management 
Environment

This chapter contains the following information:

■ About Siebel CRM Integration Pack for Trade Promotion Management on page 13

■ Software Requirements on page 13

■ Cross-References on page 14

About Siebel CRM Integration Pack for 
Trade Promotion Management
The Siebel CRM Integration Pack for Trade Promotion Management integrates information between 
Siebel Trade Promotion Management and Oracle Trade Management. This integration provides the 
following functionality:

■ Synchronizing Foundation objects with modules such as Customers and Products

■ Synchronizing Siebel Trade Deal with Oracle Trade Management Offer

■ Synchronizing Siebel Flexible Budgets from Trade Promotions to Oracle Trade Management 
Budgets and Offers

■ Synchronizing Siebel Live Funds with Oracle Trade Management Budgets

■ Synchronizing Oracle E-Business Suite Deductions with Siebel Trade Promotion Management 
Deductions for notification that a deduction needs resolution

■ Enabling Siebel Trade Promotion Management Deduction Disposition back to Oracle E-Business 
Suite Deductions 

Software Requirements
The software requirements for Siebel CRM Integration Pack for Trade Promotion Management are as 
follows:

■ Oracle 10.1.3.1 Application Server Enterprise Edition

■ Oracle E-Business Suite, 11.5.10 CU2

■ Oracle JDeveloper 10.1.3.1 (upgraded to the latest patch)

■ Oracle SOA Suite 10.1.3.1 (upgraded to the latest patch)
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Cross-References
To support ongoing customer integration between Oracle Trade Management and Siebel Trade 
Promotion Management, a cross reference of the unique identifiers of customer data is maintained 
in the middle tier of the integration. The entities that are cross referenced on the Siebel side are 
account, address, and contact, which correspond to organization, party site, and organization 
contact in Oracle Trade Management and Oracle E-Business Suite.

For newly created customer and product records in Oracle Trade Management that need to be 
synchronized with Siebel Trade Promotion Management, Oracle Trade Management publishes Oracle 
unique identifiers that can be mapped to the External ID attribute of the appropriate entity in Siebel 
Trade Promotion Management to establish the cross-references within Siebel Trade Promotion 
Management.

For updated customer and product records that need to be synchronized with Siebel Trade Promotion 
Management, Oracle publishes the Oracle unique identifiers. The Siebel Trade Promotion 
Management Web Service interfaces are able to uniquely identify the records in Siebel Trade 
Promotion Management that need to be updated.

Similarly, on the Siebel side, newly created or updated fund, deduction, and promotion records in 
Siebel Trade Promotion Management are correctly reflected in corresponding records in Oracle Trade 
Management.

Language Support
The Siebel CRM Integration Pack for Trade Promotion Management supports only the English-
American language for databases. This language uses the WE8MSWIN1252 character set.
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3 Installation and Configuration

This chapter contains the following information:

■ Downloading and Installing Siebel CRM Integration Pack for Trade Promotion Management 
Software on page 15

■ Configuring the Oracle E-Business Suite Environment on page 21

■ Configuring the Siebel Trade Promotion Management Environment on page 33

■ Setting Up Common Integration Server (Including DVMs and Common Services) on page 130

■ Process of Deploying BPEL Processes Using Oracle JDeveloper on page 148

■ Synchronizing Records after the Oracle Server Has Gone Down on page 152

Downloading and Installing Siebel CRM 
Integration Pack for Trade Promotion 
Management Software
Read the following topics to learn how to download and install the software and patches needed for 
Siebel CRM Integration Pack for Trade Promotion Management.

■ Downloading Required Software on page 15

■ Installing Oracle E-Business Suite Patches on page 16

■ Installing Fusion Middleware Software on page 17

■ Installing Oracle Fusion Middleware and Oracle JDeveloper Patches on page 18

Downloading Required Software
The required software for Siebel CRM Integration Pack for Trade Promotion Management is available 
on Oracle E-Delivery.

To download the files

1 Log in to Oracle E-Delivery (http://edelivery.oracle.com).

2 From the Product Pack menu, choose Oracle Application Integration Architecture.

3 From the Platform menu, choose your platform, and click Go.

4 Download the following files:
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■ Siebel CRM Integration Pack for Trade Promotion Management Implementation Guide, v1.0 
(Documentation_TPMIPv1.0.zip)

■ Oracle Database 10g Release 2 (10.2.0.1) (file name(s) and count vary by platform)

■ Oracle Database 10g Release 2 Patches (DB_Patches_AIAv1.0.zip)

■ Oracle SOA Suite 10g (10.1.3.1.0) (file name(s) and count vary by platform)

■ Oracle Fusion Middleware 10.1.3.1 Patches (FMW_Patches_AIAv1.0.zip)

■ Siebel CRM Integration Pack for Trade Promotion Management, v1.0, E-Business Suite Patch 
(EBS_Patches_AIAv1.0.TPM.zip), which contains the following files:

❏ E-Business Suite Generic Patch (EBS_Patches_AIAv1.0.TPM_generic.zip)

❏ E-Business Suite Operating System Patch (as needed)

■ Siebel CRM Integration Pack for Trade Promotion Management, v1.0, Siebel CRM Patches

■ Siebel CRM Integration Pack for Trade Promotion Management, v1.0 
(SEBLTPMIntegPkEBSTMv1.0.zip)

Installing Oracle E-Business Suite Patches
Install the Oracle E-Business Suite patches described in this section. If a patch has already been 
installed, there is no need to reinstall it. The latest version of each patch can be downloaded from 
http://metalink.oracle.com.

NOTE: Always check Metalink for the latest versions of all patches.

To install Oracle E-Business Suite Patches

1 Download the Oracle E-Business Suite patch. The file name is:
EBS_Patches_AIAv1.0.TPM.zip.

2 Use a zip utility to extract the Oracle E-Business Suite generic patches and applicable operating 
system patch from the patch file.

Extracting from the patch file yields a set of patch zip files.

3 Apply each of these patches to your Oracle E-Business Suite application.

Operating System Patch File Name

AIX Based Systems (32-bit) EBS_Patches_AIAv1.0.TPM_aix.zip

HP Tru64 UNIX EBS_Patches_AIAv1.0.TPM_tru64.zip

HP-UX PA-RISC (32-bit) EBS_Patches_AIAv1.0.TPM_hpux11.zip

Linux x86 EBS_Patches_AIAv1.0.TPM_linux.zip

Microsoft Windows (32-bit) EBS_Patches_AIAv1.0.TPM_winnt.zip

Solaris Operating System (SPARC 32-bit EBS_Patches_AIAv1.0.TPM_solaris.zip
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4 Install the patches listed in Table 1, in the specific order of installation.

Installing Fusion Middleware Software
Install the following Fusion Middleware components:

1 Oracle Database 10g Release 2 (10.2.0.1) Enterprise Edition. 
Download and install the database only if you do not already have an Oracle 10.2.0.2 (or higher) 
database instance available for the SOA Suite to access. For information on installing Oracle 
Database, refer to the Oracle Technology Network. Oracle Technology Network link has the 
following URL:
http://www.oracle.com/technology/documentation/index.html
After installation, apply the appropriate patch from DB_Patches_AIAv1.0.zip (choose the patch 
appropriate to the operating system that your database is installed on.) This patch brings the 
database up to required version 10.2.0.2.

2 SOA Suite 10g10.1.3.1
For information on installing Oracle SOA Suite, refer to the Oracle Application Server 
Documentation Library. The library is available on the Oracle Technology Network.
Oracle Technology Network link has the following URL:
http://www.oracle.com/technology/documentation/index.html.
Click Oracle Application Server 10g Release 3 (10.1.3.1)
Make sure to install the full SOA suite using the Advanced Installation Mode.

3 Oracle JDeveloper 10.1.3.1 (Studio Version)
Download Oracle JDeveloper from:
http://www.oracle.com/technology/software/products/jdev/archives.html.
This is a free download. Support for JDeveloper is not included. If desired, support for JDeveloper 
can be purchased separately. For information on installing Oracle JDeveloper, refer to the Oracle 
Technology Network. Oracle Technology Network link has the following URL:
http://www.oracle.com/technology/documentation/index.html

Table 1. Patches Needed for Oracle E-Business Suite

Order Patch Number Comments

1 3618299 TCA Patchset HZ.n

2 4280097 Customer - HZ.N fixes party merge

3 5046954 Customer - TCA Backported Integration Service Patch

4 5221609 Customer – Integration patch

5 6021150 Simple Products

6 6021155 Simple Products - Integration patch. Backports business event 
changes.

7 5929632 OZF - Trade Management
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4 Oracle Warehouse Builder 10gR2 10.2.0.1 (optional component)
Oracle Warehouse Builder is an optional component that should be used to perform initial data 
synchronization from Oracle E-Business Suite to Siebel CRM if customer or product data already 
exists in Oracle E-Business Suite. Use of OWB for initial data synchronization requires the ETL 
and Data Quality options from Oracle Warehouse Builder. OWB is not included in this media pack 
and, if needed, must be licensed separately.

Installing Oracle Fusion Middleware and Oracle 
JDeveloper Patches
Install all Fusion Middleware and JDeveloper patches described in this section. If any particular patch 
has already been installed, there is no need to reinstall it. The latest version of each patch can be 
downloaded from http://metalink.oracle.com.

To install SOA Suite patches

1 Download the Fusion Middleware and JDeveloper patches. The file name is:
FMW_Patches_AIAv1.0.zip

2 Unzip the file to yield the mandatory bug-fix patches listed in the following table.

3 Apply each of these patches to your installation.

4 Refer to the ReadMe.txt in each patch for guidance on how to apply the patch.

Patch Number Comments

5473225 Fixes problems that involve catching an exception during a transform.

5596476 Fixes problems that involve the XSLT map not rendering in the user 
interface.

5609537 Fixes issues with commit in child processes.

5917910 Fixes problems that involve:

■ Creating <XSL:variable> with value "&#0;"

■ Java heap error on Service Oriented Architecture Suite, V10.1.3.1 
release on Linux.

■ Invoking PL/SQL procedure with a large output parameter.

5931554 Fixes problems that involve:

■ Cross-reference feature

■ XPATH function, LOOKUP-DVM, but does not work in assign activity of 
Business Processes Execution Language.
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Deployment Steps
The following deployment steps are listed at a high level. Some of the steps are simple, and this 
section provides instructions for them. Others are described in more detail in subsequent sections. 

1 Before you begin:

■ Verify EBS Environment for such items as test logons, Concurrent Manager, and Database 
Connect Strings.

■ Verify Siebel Environment for such items as test logons, and Database Connect Strings.

■ Verify 10.1.3 Environment for such items as test launch of BPEL Console, ESB Console, and 
Application Server Control. Deploy and test a simple BPEL Process. Test connectivity from 
Jdeveloper. 

❏ NOTE: Required 10.1.3 ST Patches: The following ST patches are required to be installed 
in the 10.1.3 environment to proceed. Verify with that these are applied.

❏ 5917910: ISSUE WITH CREATING <XSL:VARIABLE> WITH VALUE "&#0;" JAVA HEAP 
ERROR ON SOA 10.1.3.1 GA RELEASE ON LINUX INVOKING PLSQL PROCEDURE WITH 
LARGE OUTPUT PARAMETER CAUSES OUT-OF-HEAP SPACE

❏ 5596476: XSLT MAP NOT RENDERING IN THE UI.

❏ 5609537: COMMIT IN CHILD PROCESS HAPPENS EVEN IF THE PARENT BPEL PROCESS IS 
FAULTED

❏ 5931554: XPATH FUNCTION LOOKUP-DVM DOES NOT WORK IN ASSIGN ACTIVITY OF 
BPEL CROSS REFERENCE FEATURE IN 10.1.3.1. See Post-Installation Instructions for Patch 
5931554 on page 21 for further details about this patch.

❏ 5473225: UNABLE TO CATCH AN EXCEPTION DURING A TRANSFORM 

2 Download and configure a released build for Siebel CRM Integration Pack for Trade Promotion 
Management:

a Download the required SEBLTPMIntegPkEBSTMv1.0.zip to <SOA Home>\bpel\samples.

b Unzip to SEBLTPMIntegPkEBSTMv1.0 folder.

c Go to <SOA Home>\bpel\samples\SEBLTPMIntegPkEBSTMv1.0\ SEBLTPMIntegPkEBSTM\SetUp.

d Open CRMIntegProcessParametersTPM2TM.xml and, against each parameter name, replace the 
current parameter value with a current relevant value for deployment of BPEL processes.

3 Make the following changes in CRMIntegProcessParametersTPM2TM.xml:

a Change PARAMVALUE for PARAMNAME "http://127.0.0.1:8888/orabpel/default" to "http://your 
SOA host: port/orabpel/your bpel domain".

b Change PARAMVALUE for PARAMNAME "http://127.0.0.1:8888/orabpel/xmllib" to http://your 
SOA host: port/orabpel/xmllib.

c Change PARAMVALUE for PARAMNAME <property name="PARAMNAME">[SIEBEL SERVER 
LOCATION]</property> to <property name="PARAMVALUE">http://<Siebel Server Location>/
eai_enu/start.swe</property>.
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d Change PARAMVALUE for PARAMNAME <property name="PARAMNAME">[SIEBEL 
USERNAME]</property> to <property name="PARAMVALUE"> UserName=<Siebel 
Username></property>.

e Change PARAMVALUE for PARAMNAME <property name="PARAMNAME">[SIEBEL 
PASSWORD]</property> to <property name="PARAMVALUE"> Password=<Siebel 
Password></property>.

4 From the command prompt, navigate to <SOA 
Home>\bpel\samples\SEBLTPMIntegPkEBSTMv1.0\SEBLTPMIntegPkEBSTM\SetUp\scripts and 
execute the following command:

■ For Windows:

java -jar EditParam.jar -i <SOA Home>\bpel\samples\SEBLTPMIntegPkEBSTMv1.0\ 
SEBLTPMIntegPkEBSTM\BusinessProcesses -f <SOA 
Home>\bpel\samples\SEBLTPMIntegPkEBSTMv1.0\ 
SEBLTPMIntegPkEBSTM\SetUp\CRMIntegProcessParametersTPM2TM.xml -verbose -t 
D:\temp

■ For Linux:

<SOA_HOME>/jdk/bin/java -jar EditParam.jar -i <SOA Home>/bpel/samples/
SEBLTPMIntegPkEBSTMv1.0/SEBLTPMIntegPkEBSTM/BusinessProcesses -f <SOA Home>/
bpel/samples/SEBLTPMIntegPkEBSTMv1.0/ SEBLTPMIntegPkEBSTM/SetUp/
CRMIntegProcessParametersTPM2TM.xml -verbose -t /tmp

NOTE: To run EditParam.jar, you need Java Development Kit version 1.4 or newer installed.

For all the BPEL Processes in the Business Processes folder, all the parameter names set are 
replaced with the values as set in CRMIntegProcessParametersTPM2TM.xml.

5 Apply prerequisite patches and set up the Oracle E-Business Suite environment. See Configuring 
the Oracle E-Business Suite Environment on page 21.

6 Apply prerequisite patches and set up the Siebel environment. See Configuring the Siebel Trade 
Promotion Management Environment on page 33.

7 Perform common integration setups. See Setting Up Common Integration Server (Including DVMs 
and Common Services) on page 130.

8 Deploy BPEL processes. See Process of Deploying BPEL Processes Using Oracle JDeveloper on 
page 148.

9 Set syncMaxWaitTime in BPELConsole. The default wait time is only 45 seconds in the BPEL 
console. Logon to BPELConsole Manage BPEL Domain and set the syncMaxWaitTime value to 120 
seconds.

10 Before you start to compile any Siebel artifacts, make sure that the Script Compilation Folder is 
set correctly: 

a In Siebel Tools go to the View > Options > Scripting tab.

b For the Script compilation folder, set the value as (for the ST environment) 
D:\19224\eappweb\PUBLIC\enu. If you do not set this value, then the configurator launch fails.
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Post-Installation Instructions for Patch 5931554
Make sure to follow the post-install step for patch 5931554, especially the following patch 
post-installation instructions:

To perform post-installation instructions for patch 5931554

1 Execute the sql file $ORACLE_HOME/integration/esb/sql/oracle/xreftables.sql.

2 Restart all managed components if you are on a mid-tier installation:

$ORACLE_HOME/opmn/bin/opmnctl startall

3 Make sure that ASControl is restarted as well, from OS services console.

4 To patch JDev, copy over $ORACLE_HOME/integration/esb/lib/bpm-ide-common.jar to the 
following:

a $JDEV_HOME/integration/lib/ after backing up 

b $JDEV_HOME/integration/lib/bpm-ide-common.jar

Configuring the Oracle E-Business Suite 
Environment
This section contains the following information:

■ Patches on page 21

■ Setting Profile Options for a Customer on page 22

■ Defining Oracle Trade Management on page 22

Patches
Oracle E-Business Suite 11.5.10 CU2 and Oracle Trade Management rollup 3 are the baseline for 
installation. Apply the following Oracle E-Business Suite patches to the Oracle E-Business Suite 
environment. Patches are listed by Oracle E-Business Suite participating module:

1 Customer 

a 3618299 (HZ.N)

b 4280097 (HZ.N oneoff to fix party merge)

c 5046954 (TCA Bakported Business Objects)

d 5221609 (Genesis Specific Code for customers)

2 Products

a 6021150 (Simple)

b 6021155 (back porting business event changes)
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3 Trade Management

a 5929632(OZF)

Setting Profile Options for a Customer

To set profile options for a customer
■ Set the following profile options at the site level as indicated in the following table.

.

Defining Oracle Trade Management
This section covers the definition of the elements of Oracle Trade Management. Complete the 
following tasks in the order listed:

1 Creating an Employee on page 22

2 Importing a Resource for an Oracle Trade Management User on page 23

3 Creating an Oracle Trade Management User on page 24

4 Setting System Profiles on page 25

5 Setting the Oracle Accounts Receivable System Option for Write-Off Limits on page 26

6 Setting System Parameters on page 26

7 Creating a Budget Approval Bypass Rule on page 27

8 Creating a Trade Profile on page 28

9 Creating a Trade Profile on page 28

Creating an Employee

To create an employee

1 Log into Oracle Forms with HRMS Manager Responsibility.

2 Navigate to People > Enter & Maintain.

3 In the Find Person box, select New.

4 Enter the following information:

Profile Value to Set

HZ: Execute API Callouts All Events Enabled

HZ: Format Business Object Business 
Events as Bulk

N
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■ Last Name and First Name

■ Title

■ Gender

■ Type = Employee

■ Social Security # (This is checked against existing Social Security numbers.)

■ Birth Date

5 Save your work.

6 Select Assignment and enter the following:

■ Organization

■ Team/Group

■ Location

■ Supervisor

If a dialog box with Update and Correction buttons appears, then select Correction to revise 
existing data and Update to create a new record.

7 Save your work.

8 Select Yes to use the new location.

9 Save your work.

Importing a Resource for an Oracle Trade Management User

To import a resource

1 Log into Forms with CRM Administrator responsibility.

2 Navigate to Resource Manager > Maintain Resources > Import Resources.

Resource Category is defaulted to Employee.

3 In the Name field, pick the employee that you created in the step Creating an Employee on 
page 22.

4 Click Search.

One record appears in Search Results panel.

5 Click Start Import.

The Set Resource Attributes form opens.

6 Click OK.

The Review and Import Selected Resources form opens

7 Click Save Resource.

8 After the confirmation appears, Click OK.
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9 Navigate to Resource Manager.

10 Select the user as the resource.

11 Click Details.

12 On the Roles tab, select a role type of Sales and a role of Sales Representative.

13 On the Group tab, select a group with Usages of Sales and TeleSales and Oracle Trade 
Management.

14 Make sure that the Group Member Role Sales Representative is associated with the above group 
on the Resource Details window, and save your work.

Creating an Oracle Trade Management User

To create an Oracle Trade Management user

1 Log into Forms with System Administrator responsibility.

2 Navigate to the Security > User > Define > Users form.

3 In the User Name field, enter SIEBEL.

4 In the Person field, pick the employee you created in the step Importing a Resource for an Oracle 
Trade Management User on page 23.

5 In the Responsibilities block, assign the following responsibilities to the Implementation User:

■ General Ledger Super User

■ HRMS Manager

■ Inventory

■ CRM Administrator

■ Oracle Trade Management User

■ Oracle Trade Management Administrator

■ Account Manager

■ Workflow User Web Applications

■ System Administrator

■ Oracle Receivables

■ Oracle Payable

■ Advanced Pricing

■ Receivables Manager

6 Save your work.

7 Assign the resource to the group selected in AMS: Admin Group profile option.

8 Run the concurrent request AMS: Group Access Refresh.
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Setting System Profiles
You must set values for budget-related system profiles, deduction-related system profiles, and 
deduction-related system profiles.

To set system profiles

1 Set values for budget-related system profiles according to the following table:

2 Set values for deduction-related system profiles according to the following table:

3 Use the following table to set values for promotion-related system profiles according to your 
business requirements:

BR # Profile Option Value Comments

1 OZF: Allow committed budget to 
exceed total budget

Yes None

2 OZF: Allow Recalculation of Committed 
Budget

Yes None

3 OZF: Validate market and product 
eligibility between object & budget

No None

BR # Profile Option Value Comments

1 OZF: Implement Payables Integrations Yes None

2 OZF: Derive Accrual Account during 
Claims Settlement

No None

3 OZF: Implement Contra Charge 
payment method

No None

4 OZF: AR Credit Method For Rule Prorate None

5 OZF: Under Write Off Threshold 
Approval Required

No None

6 OZF: AR Credit Method For Installment Prorate None

7 OZF: Allow Un-Related Ship To On 
Claims

Yes None

BR # Profile Option Value Comments

1 OZF: Default phase for Line Group level 
discounts

None

2 OZF: Default phase for Line level 
discounts

None

3 OZF: Default phase for Order level 
discounts

None
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Setting the Oracle Accounts Receivable System Option for Write-Off 
Limits
You must set the Oracle Accounts Receivable system option for Write-off Limits Per Receipt to resolve 
non-invoice deduction with the write-off settlement method.

To set the Accounts Receivable system option for write-off limits

1 Navigate to Receivables, Vision Operations (USA) > Setup > System > Systems Options > 
Miscellaneous.

2 Set Write-off Limits Per Receipt = -100 to 100.

Setting System Parameters
Use Table 2 to set values for system parameters based on your business requirements.

4 OZF: Default value for print on invoice 
flag

None

5 OZF: Default Bucket for discount rules None

6 OZF: Default value for product 
precedence

None

7 OZF: Offer Override Flag in QP None

8 OZF: Default value for incompatibility 
group

None

Table 2. System Parameters for Oracle E-Business Suite

BR # Name Description Comments

1 Set of Books

2 Accounting Method

3 GL Accounts

4 Receivable Batch Source

5 Credit Memo Transaction Type

6 Chargeback Transaction Type

7 Payable Source

8 Payable Payment Terms

9 Write Off Activity

BR # Profile Option Value Comments
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Creating a Budget Approval Bypass Rule
Use the following procedure to create approval rules to bypass the budget approval workflow.

To bypass the budget approval workflow

1 Log into CRM self service as user SIEBEL with Oracle Trade Management User responsibility.

2 Navigate to Administration > Trade Management > Setup > Approval Rule > Create.

3 Enter the following information and click Create:

■ Approval Rule Name

■ Start Date

■ Approval Rule For = Root Budget Request

■ Budget Category = SIEBEL

■ Setup Type = SIEBEL FIXED FUND

■ Minimum Amount = 0

The Approvers table appears in the bottom half of the window.

4 Enter the following information and click Update:

■ Order=1

■ Type=User

■ User/Role=the user that you just created

The application successfully creates a bypass approval rule for the fixed fund.

5 Navigate to Administration > Trade Management > Setup > Approval Rule > Create.

6 Enter the following information and click Create:

■ Approval Rule Name

■ Start Date

■ Approval Rule For = Root Budget Request

■ Budget Category = SIEBEL

■ Setup Type = SIEBEL LIVE FUND

■ Minimum Amount = 0

The Approvers table appears in the bottom half of the window.

10 Claim Type

11 Claim Reason

Table 2. System Parameters for Oracle E-Business Suite

BR # Name Description Comments
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7 Enter the following information and click Update:

■ Order=1

■ Type=User

■ User/Role=the user that you just created

The application successfully creates a bypass approval rule for the accrual fund.

Creating a Trade Profile
This section covers the creation of a trade profile. 

NOTE: The values defined in a customer's trade profile override the values set in system parameters, 
which are set as defined in Setting System Parameters on page 26.

Complete these tasks in the order listed:

1 Entering Basic Customer Information on page 28

2 Defining Autopay Parameters on page 29

3 Defining Claim Parameters on page 29

4 Defining Earnings Payments Parameters on page 30

5 Defining a Valid Pair for Deduction Type and Deduction Reason on page 31 

Entering Basic Customer Information
Use the following procedure to enter basic customer information.

To enter basic customer information

1 Log in to Oracle Trade Management.

2 Navigate to Administration > Trade Management > Customer > Trade Profiles.

3 On the Trade Profile Overview page, click Create.

4 Enter the basic customer information in the Party Name, Account Number, Site Use, and Address 
fields.

a If the customer already has a trade profile, then it is displayed when you select the party name 
or account number. 

b The primary Bill To site for the account is displayed by default. To change the site, click the icon 
next to the Site Use and select another site. 

Sites are striped by organization. As such, the site can be used only within an operating unit.

5 If the customer is also a vendor, then enter the vendor information in the Vendor, Vendor Site, 
and Address fields.

a A vendor is a person or company that sells to your company. Vendors are set up in Oracle 
Payables and are separate from TCA. To settle claims using a check, you must set up that 
customer as a vendor in Oracle Payables and Purchasing.



Installation and Configuration ■ Configuring the Oracle E-Business Suite Environment

Siebel CRM Integration Pack for Trade Promotion Management
Implementation Guide Version 1.00

29

b Values for Vendor and Vendor Site are mandatory for the Checkbook-Check Settlement 
method.

c The trade profile provides a link between the two setups in the two systems. Vendor information 
on claims is completed automatically. Therefore, claim processors do not need to determine this. 
Vendors are not striped by organization. They can be seen and used across operating units. If 
the vendor is not set up in the trade profile, then the claim owner must enter the vendor 
information on the first claim to be settled by check for this account. When this occurs, the trade 
profile information for the account is updated automatically.

Defining Autopay Parameters
If Autopay is used, then it evaluates the accruals for this customer and automate payments as 
required. If it is not used, then automatic payments are not made even if accruals exist. To define 
Autopay parameters for the Trade profile, use this procedure, which continues from the previous 
step.

To define Autopay parameters for this customer

1 Select the Autopay check box.

2 Enter a numeric value in Frequency and select a Frequency Unit.

Together, these values define the frequency with which the customer is paid. These values 
override those in system parameters. For example, if you enter 1 as the frequency and select 
month as the frequency unit, then this customer is paid once a month as long as the threshold 
amount is met.

3 Enter a Threshold Amount.

The threshold amount is also used to trigger Autopay. The threshold currency is the functional 
currency of the set of books selected in system parameters. For example, if frequency is set to 
once each month and the threshold amount is $100, then the customer is paid whenever one of 
these two conditions is met.

4 Select a Payment Method:

■ Check: If selected, then you must fill in vendor and vendor sites fields.

■ On Account Credit Memo: If selected, then you must fill in the Site Use field. This field 
retrieves the Bill-to Site of the customer account.

Defining Claim Parameters
To define Autopay parameters for the Trade profile, use this procedure, which continues from the 
previous step.
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To define autopay claim parameters

1 Enter the days due.

Claim managers may require that claims for this account are resolved within a certain number 
of days. Enter that number here.

For example, your company may require that all claims for an important customer account are 
resolved with 15 days of creation. In the customer trade profile, you can assign 15 as the default 
days due. If a claim for this customer account is created on January 1, then the due date defaults 
to January 16.

2 Enter values for the overpayment and deduction writeoff thresholds.

Deductions and overpayments less than the amounts specified here are automatically written off.

Threshold example are as follows:

■ Writeoff Threshold (Deduction) example: Suppose that you enter 200 as the threshold. If you 
receive a deduction of $190, then it is under the threshold and is eligible for automatic 
writeoff. Always enter a positive number here.

■ Writeoff Threshold (Overpayment) example: Suppose that you enter 150 as the threshold. If 
you receive an overpayment of $140, then it is under the threshold and is eligible for 
automatic writeoff.

Defining Earnings Payments Parameters
The values selected for earnings payment parameters for a trade profile determine customer 
eligibility and the threshold for unearned payments for offers. These affect all promotional claims 
and deductions except those related to scan data offers, whether they are settled by credit memo or 
check. If a customer does not have a trade profile, then the application behaves as if the trade profile 
setting is Null.

If no explicit threshold is set either on the System Parameters page or on the trade profile, but 
unearned payments are allowed, then the threshold is zero. Claim payment within the thresholds can 
be settled like any other promotional claim and go through the regular claim approval process.

To define earnings and payments parameters for the Trade profile, use this procedure, which 
continues from the previous step.

To define earning and payments parameters

1 Select a value for the Unearned Payments for Offers field:

■ Null: The customer may or may not be eligible for unearned payments depending on the 
system parameter setting. If set to Allow for All, then this customer is eligible for unearned 
payments. If set to Allow for Selected, then this customer is not eligible for unearned 
payments.

■ Allow: Unearned payments are always allowed for this customer. This setting overrides the 
system parameter setting.

■ Disallow: The customer is not eligible for unearned payments for offers regardless of the 
system parameter setting.
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2 Select a threshold type:

■ Amount: Threshold is a currency amount. If 50 is entered in the threshold field, then the 
threshold is $50. (Assuming the currency being used is U.S. dollars.)

■ Percent: Threshold is a percentage. If 90 is enter in the threshold field, then the threshold is 
90% of the earnings.

■ Unconditional: The threshold is infinity. Special approval for overriding the unearned 
payments threshold is never required. Claims simply go through the regular claim approval 
process.

3 Enter a value in the Threshold field.

This value can be greater than 100 if the threshold type is Percent.

■ Example for Percent: The threshold is 20%. Customer Y's earnings total $10,000 for an offer. 
Claim payments up to $12,000 can be made.

■ Example for Amount: The value is 2,000, and the functional currency is $. Customer Y's 
earnings total $10,000 for an offer. Claim payments up to $12,000 can be made.

4 Select the Override Threshold check box to allow the initiation of settlements for unearned 
payments where the amount is greater than the threshold.

These claims are subject to both the regular approval process and a special approval process, 
and. This setting overrides the setting on the System Parameters page.

Defining a Valid Pair for Deduction Type and Deduction Reason
Several valid combinations of claim (deduction) type and claim reason exist in Siebel Trade 
Promotion Management. Therefore you must create a claim type and a claim reason in the Trade 
Management Page and set a valid combination in the System Parameter page. Table 3 lists valid 
combinations of claim type and reason type in Siebel Trade Promotion Management. For example, 
you can create Promotion as a value for Claim Type and Bill Back an associated value for Reason and 
set the values in the system parameter to default.

Table 3. Valid Combinations of Claim Type and Reason Type

Claim Type Reason Type

Invoicing Coupon, Discount, Penalty, Post-audit, Price, 
Quantity

Unsaleable Expired, Packaging, Penalty, Post-audit, Spoiled

Returns Discontinued, Penalty, Post-audit, Product, 
Quantity

Transportation Delivery time, Location, Pallet config, Penalty, 
Post-audit

Unknown No OOTB option

Promotion Bill Back, Fixed, Intro Marketing, Off Invoice, 
Penalty, Post-audit, Slotting
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To create a claim type

1 Navigate to Oracle Trade Management > Administration > Claim -> Claim Type. 

2 Click Create.

3 Refer to Table 3 and enter a valid claim type.

To create a claim reason

1 Navigate to Oracle Trade Management > Administration > Claim -> Claim Reason.

2 Click Create.

3 Refer to Table 3 and enter a valid claim reason.

Defining a Claim Default Setup
For any deduction created from Oracle Receivables, you must set a valid pair of type and reason. 

To define a claim default setup

1 Navigate to Oracle Trade Management > Administration > Claim > Claim Defaults.

2 Use the following example to set default values:

a Claim Source to Invoice Deduction

b Custom Setup to SIEBEL DEDUCTION 

c Claim Type to Promotion 

d Claim Reason to Bill Back 

e Start Date to some valid date

Defining the Indirect Sales Parameters
The values defined in a customer's trade profile override the values set in system parameters.

To define the indirect sales parameters

1 Set the batch tolerance as follows:

a For Batch Tolerance Type, select Percent or Amount.

b Enter a numeric value in the Batch Tolerance field.

2 Set the line tolerance as follows: 

a For Line Tolerance Type, select Percent or Amount.

b Enter a number value in the Line Tolerance Field

3 To finish, click Update.
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Enabling a Business Event 
You must enable two business events.

To enable business events

1 Navigate to Workflow Administrator Web Applications responsibility > Business Events.

2 Search for each of the following business events and enable it from the Details screen:

■ oracle.apps.ozf.order.accrual.info 

■ oracle.apps.ozf.bpel.claim

Configuring the Siebel Trade Promotion 
Management Environment
This section lists the setups, patches and manual steps that must be performed in the Siebel Trade 
Promotion Management environment during integration. 

Applying Quick Fix
You must apply Siebel 8.0[20405]QF2007 Quick Fix.

To apply the quick fix

1 Install Siebel Tools 8.0[20405].

2 Download Siebel Tools 8.0[20405]QF2007 from ftp.siebel.com:

ftp://ftp.siebel.com/staging/8.0sba_20405_W32_QF2007

3 Expand the downloaded file.

4 Navigate to [local directory]\8.0[20405]QF2007 \Release\Windows\Client\Siebel_Tools and 
double click install.exe.

Siebel Tools 8.0SIA[20405] is patched, and the quick fix is installed.

5 Navigate to the Siebel Tools home directory, open the REPPATCH folder, and confirm that the 
following sif files have been imported into Siebel Tools:

■ ACR358_GenesisErrorHandler.sif

■ ACR358_Accounts.sif

■ ACR358_Products.sif

■ ACR358_Deductions.sif

■ ACR358_Funds.sif

■ ACR358_Promotions.sif
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Subsequent sections describe applying any prerequisite patches and using the sif files for setting up 
the Siebel environment.

Verifying that Component Groups Are Enabled
After the Siebel servers are installed, verify that required component groups are enabled.

To verify that the component groups are enabled

1 Navigate to Site Map > Administration - Server Configuration > Component Groups.

2 Query for Name as Enterprise Application Integration or Alias as EAI.

3 Query for Name as Siebel eConsumerSector or Alias as eConsumer.

4 Query for Name as Workflow Management or Alias as Workflow.

If any of the above component groups are not enabled, click Enable to activate the component 
groups.

Setting Up Customer Integration
This section includes the following setups:

■ Preparing for the Customer Integration Setup

■ Setting Up a Siebel Trade Promotion Management Inbound Customer

■ Setting Up Siebel Trade Promotion Management Client

■ Setting Up Funds

■ Setting Up Deductions

■ Setting Up Promotions

Preparing for the Customer Integration Setup
To prepare for setting up customer integration, complete the following procedure.

To modify the configuration file for the customer integration setup

1 In Siebel Tools, navigate to $SiebsrvrHome\bin\enu.

2 In the Tools.cfg file, change SymStrPrefix from X_ to SBL_.

3 Re-login to Siebel Tools.
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Setting Up a Siebel Trade Promotion Management Inbound Customer

Projects

To set up projects

1 Log in to Siebel 8.0 Tools and lock the following projects:

2 Import ACR358_Accounts.sif from the Siebel Quick Fix build, which contains new and modified 
repository objects. 

3 For each repository object, shut down Siebel Server and compile the locked projects into the 
server .srf file.

Business Component
Name: Account (Modified)

Applet
Name: Account Address List Applet (SCW)

New? Name Description

Modified Account Modified Account BC, Added New 
Bus Service and Int Object.

Modified Account 
(SCW)

Modified applets

Table 4. Multi Value Link

New? Name Description

Modified Business 
Address

Auto Primary is selected.

Table 5. List Columns

New? Name Description Comments

New Bill To Mapped to Bill Address Flag 
field

By default, this flag must not be 
checked when a new address is 
created.

New Ship To Mapped to Ship Address 
Flag field

By default, this flag must not be 
checked when a new address is 
created.
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Integration Object
■ Name: CGInternalAccountInterface (New)

■ Project: Account

■ Base Object Type: Siebel Business Object 

■ External Name: Account

■ XML Tag: ListOfCgInternalAccountInterface

Integration Components
■ Name & External Name: Account

■ Parent Integration Component: None

■ XML Container Element: None

■ XML Tag: Account

■ Cardinality: Zero or More

Table 6. Integration Component Fields

Name Length Type
External 
Name

External 
Data Type

XML 
Style XML Tag

Name 100 Data Name DTYPE_TEXT Element Name

Account Id 30 Data  Id DTYPE_ID Element AccountId

Account 
Organization 
Integration Id

30 Data DTYPE_TEXT Element None

Competitor Flag Data Competitor DTYPE_BOOL Element CompetitorFlag

CSN 30 Data CSN DTYPE_TEXT Element CSN

Created 30 Data Created DTYPE_DATET
IME

Element Created

Currency Code 15 Data CurrencyCo
de

DTYPE_TEXT Element CurrencyCode

Description 255 Data Description DTYPE_TEXT Element Description

Division 25 Data Division DTYPE_TEXT Element Division

Location 50 Data Location DTYPE_TEXT Element Location

Main Phone 
Number

Data Main Phone 
Number

DTYPE_TEXT Element MainPhoneNum
ber

Main Fax Number Data Main Fax 
Number

DTYPE_TEXT Element MainFaxNumbe
r

Partners 100 Data Partners DTYPE_TEXT Element Partners
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Revenue Growth Data Revenue 
Growth

DTYPE_NUMB
ER

Element RevenueGrowt
h

Key Competitors 100 Data Key 
Competitors

DTYPE_TEXT Element KeyCompetitor
s

Account Status 24 Data Account 
Status

DTYPE_TEXT Element AccountStatus

Type 30 Data Type DTYPE_TEXT Element Type

Alias 50 Data Alias DTYPE_TEXT Element Alias

Assignment Area 
Code

5 Data Assignment 
Area Code

DTYPE_TEXT Element AssignmentAre
aCode

Assignment 
Country Code

5 Data Assignment 
Country 
Code

DTYPE_TEXT Element AssignmentCou
ntryCode

Disable 
DataCleansing

Data Disable 
DataCleansi
ng

 DTYPE_TEXT Element DisableDataCle
ansing

Integration Id 30 Data Integration 
Id

DTYPE_TEXT Element IntegrationId

Language Code Data Language 
Code

 DTYPE_ID Element LanguageCode

Region 25 Data Region DTYPE_TEXT Element Region

Home Page Data Home Page DTYPE_TEXT Element HomePage

Parent Account 
Name

100 Data Parent 
Account 
Name

DTYPE_TEXT Element ParentAccount
Name

Partner Flag Data Partner Flag DTYPE_TEXT Element PartnerFlag

DUNS Number 15 Data DUNS 
Number

DTYPE_TEXT Element DUNSNumber

Domestic 
Ultimate DUNS

15 Data Domestic 
Ultimate 
DUNS

DTYPE_TEXT Element DomesticUltim
ateDUNS

Parent HQ DUNS 15 Data Parent HQ 
DUNS

DTYPE_TEXT Element ParentHQDUNS

Table 6. Integration Component Fields

Name Length Type
External 
Name

External 
Data Type

XML 
Style XML Tag
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Integration Component Key

Integration Components
■ Name & External Name: Account_Business Address & CUT Address

■ Parent Integration Component: Account

■ XML Container Element: ListOfAccount_BusinessAddress

■ XML Tag: Account_BusinessAddress

■ Cardinality: Zero or More

Table 7. Integration Component Key

Key Name Key Type Sequence
Sequential Key 
Fields Comments

V77 Wizard-Generated 
User Key:1

User Key 1 Account Id None

V77 Wizard-Generated 
User Key:2

User Key 2 Integration Id None

V77 Wizard-Generated 
User Key:3

User Key 3 1 Location

2 Name

3 Primary 
Organization

None

Status Key Status Key 4 1 Operation

2 Account Id

3 Integration 
Id

None

Table 8. Integration Component Fields

Name Length Type
External 
Name

External Data 
Type

XML 
Style XML Tag

Address Active 
Status

Data Address 
Active 
Status

DTYPE_TEXT Element AddressActiv
eStatus

Address Id 30 Address 
Id

DTYPE_ID Element AddressId

Address 
Integration Id

30 Data Address 
Integrati
on Id

DTYPE_TEXT Element AddressInteg
ration Id
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Integration Component Key

Bill Address 
Flag

Data Bill 
Address 
Flag

DTYPE_TEXT Element BillAddressFl
ag

City 50 Data City DTYPE_TEXT Element City

Country 30 Data Country DTYPE_TEXT Element Country

County 50 Data County DTYPE_TEXT Element County

Email Address 50 Data Email 
Address

DTYPE_TEXT Element EmailAddress

Fax Number Data Fax 
Number

DTYPE_TEXT Element FaxNumber

Main Address 
Flag

Data Main 
Address 
Flag

DTYPE_TEXT Element MainAddress
Flag

Phone Number Data Phone 
Number

DTYPE_TEXT Element PhoneNumbe
r

Postal Code 30 Data Postal 
Code

DTYPE_TEXT Element PostalCode

Province 50 Data Province DTYPE_TEXT Element Province

Ship Address 
Flag

Data Ship 
Address 
Flag

DTYPE_TEXT Element ShipAddressF
lag

State 10 Data State DTYPE_TEXT Element State

Street Address 200 Data Street 
Address

DTYPE_TEXT Element StreetAddres
s

Street Address 
2

100 Data Street 
Address 2

DTYPE_TEXT Element Street 
Address 2

Table 9. Integration Component Key

Key Name Key Type Sequence
Sequential Key 
Fields Comments

V77 Wizard-Generated 
User Key:1

User Key 1 Address 
Integration Id

None

V77 Wizard-Generated 
User Key:2

User Key 2 Address Id None

Table 8. Integration Component Fields

Name Length Type
External 
Name

External Data 
Type

XML 
Style XML Tag
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Integration Components
■ Name & External Name: Account_Industry & Industry

■ Parent Integration Component: Account

■ XML Container Element: ListOfAccount_Industry

■ XML Tag: Account_Industry

■ Cardinality: Zero or More

V77 Wizard-Generated 
User Key:3

User Key 3 1 City

2 State

3 Street 
Address

None

Status Key Status Key 4 1 Address Id

2 Address 
Integration Id

3 Operation

None

Table 10. Integration Component Fields

Name Length Type
External 
Name

External 
Data Type

XML 
Style XML Tag

Industry 50 Data Industry DTYPE_TEXT Element Industry

Industry Id 30 System Industry Id DTYPE_ID Element Industry Id

Industry 
Integration 
Id

30 Data Industry 
Integrati
on Id

DTYPE_TEXT Element Industry 
Integration Id

IsPrimaryM
VG

1 System IsPrimar
yMVG

 DTYPE_TEXT Element IsPrimaryMVG

Table 9. Integration Component Key

Key Name Key Type Sequence
Sequential Key 
Fields Comments
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Integration Component Key

Integration Components
■ Name & External Name: Account_Organization & Internal Division

■ Parent Integration Component: Account

■ XML Container Element: ListOfAccount_Organization

■ XML Tag: Account_Organization

■ Cardinality: Zero or More

Table 11. Integration Component Key

Key Name Key Type Sequence
Sequential Key 
Fields Comments

V77 Wizard-Generated User 
Key:1

User Key 1 Industry Id None

V77 Wizard-Generated User 
Key:2

User Key 2 Industry 
Integration Id

None

V77 Wizard-Generated User 
Key:3

User Key 3 Industry None

V77 Wizard-Generated User 
Key:4

User Key 4 SIC Code None

Table 12. Integration Component Fields

Name Length Type
External 
Name

External 
Data Type

XML 
Style XML Tag

Organization 50 Data Organization DTYPE_TEXT Element Organization

Organization 
Id

30 Data Organization Id DTYPE_ID Element Organization
Id

Organization 
Integration Id

30 Data Organization 
Integration Id

DTYPE_TEXT Element Organization 
IntegrationId

IsPrimaryMVG 1 System IsPrimaryMVG DTYPE_TEXT Attribute IsPrimaryMV
G
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Integration Component Key

Integration Components
■ Name & External Name: Account_Organization & Internal Division

■ Parent Integration Component: Account

■ XML Container Element: ListOfAccount_Organization

■ XML Tag: Account_Organization

■ Cardinality: Zero or More

Table 13. Integration Component Key Fields

Key Name Key Type Sequence
Sequential Key 
Fields Comments

V77 Wizard-
Generated User 
Key:1

User Key 1 Organization Id None

V77 Wizard-
Generated User 
Key:2

User Key 2 Organization 
Integration Id

None

V77 Wizard-
Generated User 
Key:3

User Key 3 Organization None

Table 14. Integration Component Fields

Name Length Type
External 
Name

External 
Data Type XML Style XML Tag

Organization 50 Data Organization DTYPE_TEXT Element Organization

Organization 
Id

30 Data Organization 
Id

DTYPE_ID Element Organization
Id

Organization 
Integration Id

30 Data Organization 
Integration 
Id

DTYPE_TEXT Element Organization 
IntegrationId

IsPrimaryMVG 1 System IsPrimaryMV
G

DTYPE_TEXT Attribute IsPrimaryMV
G
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Integration Component Key

Integration Components
■ Name & External Name: Account_Position & Position

■ Parent Integration Component: Account

■ XML Container Element: ListOfAccount_Position

■ XML Tag: Account_Position

■ Cardinality: Zero or More

Table 15. Integration Component Key Fields

Key Name Key Type Sequence
Sequential Key 
Fields Comments

V77 Wizard-Generated 
User Key:1

User Key 1 Organization Id None

V77 Wizard-Generated 
User Key:2

User Key 2 Organization 
Integration Id

None

V77 Wizard-Generated 
User Key:3

User Key 3 Organization None

Table 16. Integration Component Fields

Name Length Type
External 
Name

External 
Data Type XML Style XML Tag

Position 50 Data Position DTYPE_TEXT Element Position

Position Id 30 System Position Id DTYPE_ID Element PositionId

Position 
Integration Id

30 Data Position 
Integration 
Id

DTYPE_TEXT Element PositionInt
egration Id

IsPrimaryMVG 1 System IsPrimaryM
VG

DTYPE_TEXT Attribute IsPrimaryM
VG
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Integration Component Key

Integration Components
■ Name & External Name: Account_Business Address & CUT Address

■ Parent Integration Component: Account

■ XML Container Element: ListOfAccount_BusinessAddress

■ XML Tag: Account_BusinessAddress

■ Cardinality: Zero or More

Table 17. Integration Component Key Fields

Key Name Key Type Sequence
Sequential Key 
Fields Comments

V77 Wizard-Generated 
User Key:1

User Key 1 Account Id None

V77 Wizard-Generated 
User Key:2

User Key 2 Integration Id None

V77 Wizard-Generated 
User Key:3

User Key 3 1 Location

2 Name

3 Primary 
Organization

None

Status Key Status Key 4 1 Operation

2 Account Id

3 Integration 
Id

None

Table 18. Integration Component Fields

Name Length Type
External 
Name

External 
Data Type XML Style XML Tag

Address 
Active 
Status

Data Address 
Active 
Status

DTYPE_TEXT Element AddressActiveStatus

Address Id 30 Address 
Id

 DTYPE_ID Element AddressId

Address 
Integratio
n Id

30 Data Address 
Integratio
n Id

DTYPE_TEXT Element AddressIntegration Id
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Integration Component Key

Bill 
Address 
Flag

Data Bill 
Address 
Flag

DTYPE_TEXT Element BillAddressFlag

City 50 Data City DTYPE_TEXT Element City

Country 30 Data Country DTYPE_TEXT Element Country

County 50 Data County DTYPE_TEXT Element County

Email 
Address

50 Data Email 
Address

DTYPE_TEXT Element EmailAddress

Fax 
Number

Data Fax 
Number

DTYPE_TEXT Element FaxNumber

Main 
Address 
Flag

Data Main 
Address 
Flag

DTYPE_TEXT Element MainAddressFlag

Phone 
Number

Data Phone 
Number

DTYPE_TEXT Element PhoneNumber

Postal 
Code

30 Data Postal 
Code

DTYPE_TEXT Element PostalCode

Province 50 Data Province DTYPE_TEXT Element Province

Ship 
Address 
Flag

Data Ship 
Address 
Flag

DTYPE_TEXT Element ShipAddressFlag

State 10 Data State DTYPE_TEXT Element State

Street 
Address

200 Data Street 
Address

DTYPE_TEXT Element StreetAddress

Street 
Address 2

100 Data Street 
Address 2

DTYPE_TEXT Element Street Address 2

Table 19. Integration Component Fields

Key Name Key Type Sequence
Sequential Key 
Fields Comments

V77 Wizard-Generated 
User Key:1

User Key 1 Position Id None

Table 18. Integration Component Fields

Name Length Type
External 
Name

External 
Data Type XML Style XML Tag
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Integration Object User Prop

Business Service
■ Name & Display Name: SEBLCGIntegAccount (New)

■ Class: CSSEAIDataSyncService

■ External Use: Y

V77 Wizard-Generated 
User Key:2

User Key 2 Position 
Integration Id

None

V77 Wizard-Generated 
User Key:3

User Key 3 1 Division

2 Position

None

Table 20. Integration Object User Prop

Name Value Comments

AllLangIndependentVal
s

N None

XMLTagNamespace http://www.siebel.com/xml/
CGInternalAccountInterface

None

XSDTypeNamespace http://www.siebel.com/xml/
CGInternalAccountInterface

None

Table 19. Integration Component Fields

Key Name Key Type Sequence
Sequential Key 
Fields Comments
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■ State Management Type: Stateful

Table 21. Business Service Methods

Name Display Name

Delete Delete

Insert Insert

InsertOrUpdate Insert or Update

Synchronize Synchronize

Update Update

Table 22. Business Service Method Arguments

Name
Data 
Type

Integration 
Object Type Optional

Storage 
Type

Display 
Name Comments

SiebelMes
sage

Integrat
ion 
Object

CGInternalAc
countInterfac
e

Input / 
Output

N Hierarch
y

Account 
Interface

None

StatusObj
ect

String Input Y Property Status 
Object

Pick Field = 
Id

Table 23. Business Service Methods

Name Display Name

QueryByExample Query by Example

Table 24. Business Service Method Arguments

Name
Data 
Type

Integration 
Object Type Optional

Storage 
Type

Display 
Name Comments

SiebelMe
ssage

Integrati
on 
Object

CGInternalA
ccountInterf
ace

Input / 
Output

N Hierarch
y

Account 
Interfac
e

None
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Setting Up Siebel Trade Promotion Management Client

To set up Siebel Trade Promotion Management Client

1 Navigate to Site Map > Administration - Web Services > Inbound Web Services.

2 Import the SEBLCGIntegAccount Web Service. 

The Web Service xml file is available in 
<BuildLocation>\SEBLTPMIntegPkEBSTM\ApplicationChanges\SiebelCRMSIA\8.0\Customer\We
bServices\SEBLCGIntegAccount.xml

3 Validate the address of the Siebel server name in the Service Ports applet.

The address must have the correct Siebel server name that the client connects to. 

Table 25. Business Service Methods

Name Display Name

QueryByID Query by ID

Table 26. Business Service Method Arguments

Name
Data 
Type

Integration 
Object Type Optional

Storage 
Type

Display 
Name Comments

PrimaryRo
wId

String Input N Property ID None

SiebelMess
age

Integrati
on Object

CGInternalA
ccountInterf
ace

Output N Hierarch
y

CGInter
nalAcco
untInter
face

None

Table 27. Business Service User Prop

Name Value

Application Services Interface Y

Internal Integration Object CGInternalAccountInterface
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4 Provide a valid user name and password. 

Service Port:

Operations:

5 Click Clear Cache.

Name Type

Business 
Service/
Process Transport Address Binding

SEBLCGInte
gAccount

Business 
Service

Siebel 
Account

HTTP http://
<webserver>/
eai_<lang>/
start.swe?SWEExtS
ource=SecureWeb
Service&SWEExtC
md=Execute&User
Name=<UserName
>&Password=<Pas
sword>

SOAP_RPC_LITE
RAL

Name
Method Display 
Name

Authentication 
Type

SEBLCGIntegAccount Delete Delete None

SEBLCGIntegAccount Insert Insert None

SEBLCGIntegAccount InsertOrUpdate Insert or Update None

SEBLCGInSEBLCGIntegAccount QueryByExample Query by Example None

SEBLCGIntegAccount QueryById Query by ID None

SEBLCGIntegAccount Synchronize Synchronize None

SEBLCGIntegAccount Update Update None
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Setting Up Product Integration

Repository Changes for Simple Products

Project

To make repository changes in a project

1 Log in to Siebel 8.0 Tools and lock the following projects:

2 Import ACR358_Products.sif from the Siebel Quick Fix build, which contains new and modified 
repository objects.

The table below gives you a description of changes for each repository object:

Business Component
Object Product ImpExp BC (Modified)

■ Integration Object: ISS Prod Def ImpExp (Modified)

■ Integration Component: Object Linked Items ImpExp BC

■ Integration Component Fields:

New? Name Description

New CG Products Interface Holds CG Product Integration related new objects

Modified ISS VOD Import Export Modify Object Product ImpExp BC and ISS Prod Def 
ImpExp

Modified Symbolic Strings None

Name Column
Force 
Active PickList Type

Text 
Length

Description DESC_TEXT Y DTYPE_TEXT 255

IntegrationId INTEGRATION_ID Y DTYPE_TEXT 30

Status STATUS_CD Y PickList 
Impl 
Phase

DTYPE_TEXT 30

Name XML Tag

Context Variable Name ContextVariableName
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Object Product Bu ImpExp BC

Integration Component Fields

Integration Component Key

Integration Component Key Field

Object Product ImpExp BC

Integration Component Field

Name
Date 
Type Required

User 
Visible Type

External 
Name

External 
Required

XML 
Style

XML 
Tag

Org Id DTYPE_ID Y Y Data Org Id Y Element OrgId

Name
Key Sequence 
Number Key Type

User Key:2 2 User Key

Name Field Name Sequence

Prod Int Name Prod Int Name 1

Name
Date 
Type Length

User 
Visible Type

External 
Name

External 
Data 
Type

External 
Length

XML 
Style

XML 
Tag

Descripti
on

DTYP
E_TE
XT

250 Y Data Descripti
on

DTYPE_T
EXT

250 Eleme
nt

Desc
ripti
on

Integrati
onId

DTYP
E_TE
XT

30 Y Data Integratio
nId

DTYPE_T
EXT

30 Eleme
nt

Inte
grati
onId

Status DTYP
E_TE
XT

30 Y Data Status DTYPE_T
EXT

30 Eleme
nt

Stat
us
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Integration Component Key

Integration Component Key Field

Integration Object User Prop

ISS Prod Def ImpExp - External (New)

1 Create a copy of ISS Prod Def ImpExp.

2 Change Name to ISS Prod Def ImpExp - External and Base Object Type to XML.

Symbolic Strings

Business Service

Name Inactive

User Key:1 Y

Name Sequence Key Type

User Key:2 1 User Key

Name Field Name Sequence

VOD Object Num VOD Object Num 1

Name Value

XMLTagNamespace http://www.siebel.com/xml/ISSProdDefImpExp

XSDTypeNamespace http://www.siebel.com/xml/ISSProdDefImpExp

Name Current String Value Definition

SBL_CS_CREATE_SIMPLE_PR
ODUCT

CS Create Simple 
Product

Business Service Display Name for 
CRMIntegSEBLCreateSimpleProduct

SBL_CS_FORMAT_MESSAGE_
AND_IMPORT_PRODUCT

CS Format Message and 
Import Product

Business Service Display Name for 
CSIntegSEBLFormatMsgandProductI
mp

New? Name Cache Class
Display Name - String 
Reference

New CRMIntegSEBLCreateSi
mpleProduct

Y CSSEAIDTEScriptSer
vice

SBL_CS_CREATE_SIMPLE_P
RODUCT
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Business Service Method

Business Service Method Arg

Business Service Method Arg

NOTE: Verify Server Script in both Business Services

Name Display Name - String Reference

Execute SBL_EXECUTE-1004225048-07T

Name Data Type Type Optional Storage Type

MapName String Input Property

OutputIntObject
Name

String Input Y Property

SiebelMessage Hierarchy Input / Output Y Hierarchy

New? Name Class Display Name - String Reference

New CSIntegSEBLFormatMsgandP
roductImp

CSSService SBL_CS_FORMAT_MESSAGE_AND_IM
PORT_PRODUCT

Name Display Name - String Reference

FormatMessage SBL_UMS_FormatMessage

Name Data Type Type Optional Storage Type

SiebelMessage Integration 
Object

Input Not Applicable Hierarchy
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Workflow
CSIntegSEBLSimpleProductInboundFlow (New)

Workflow Deployment

To deploy workflows

1 Log in to Siebel Tools and navigate to Workflows.

2 Right click and select the Import workflow process.

3 Enter the workflows listed above.

Table 28. Workflow Process Property

Name In/Out
Business 
Object Data Type Integration Object

Error Code None VOD ImpExp BO String

Error Message None VOD ImpExp BO String

InternalSiebelMessage Out VOD ImpExp BO Integration 
Object

ISS Prod Def ImpExp

Object Id None VOD ImpExp BO String

Process Instance Id None VOD ImpExp BO String

Siebel Operation 
Object Id

None VOD ImpExp BO String

SiebelMessage In VOD ImpExp BO Integration 
Object

ISS Prod Def ImpExp - 
External

Table 29. Workflow Steps

Name Type
Business Service 
Name

Business 
Service 
Method

Input 
Argument

Output 
Argument

Start Start None None None None

Format Siebel 
Message

Business 
Service

CRMIntegSEBLCre
ateSimpleProduct

FormatMes
sage

SiebelMess
age

None

Map Oracle 
Items to Siebel 
Products

Business 
Service

CSIntegSEBLForm
atMsgandProductI
mp

Execute MapName, 
SiebelMess
age

SiebelMessage

End End Not Applicable Not 
Applicable

Not 
Applicable

Not Applicable
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4 Select the Project as CG Products Interface and click OK.

5 Query for the workflow and deploy the workflow by clicking Publish/Activate button on the WF/
Task Editor Toolbar. 

Toolbar is visible by selecting View > Toolbars > WF/Task Editor Toolbar.

6 Log in to the Siebel UI, navigate to Administration > Business Processes > Workflow Deployment.

7 Query for the Workflow deployed and click Activate.

Web Service Deployment

To deploy Web Services

1 Log in to Siebel UI and navigate to Administration > Web Services > Inbound Web Services.

2 Click Import and specify CSIntegSEBLSimpleProductInboundFlow_WS.xml as the Web Service to 
be imported.
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3 After the import is complete, verify that the address in the Service Ports applet has the correct 
Siebel server name that the client should connect to. 

If required, change the address and provide a valid username and password. 

Service Ports

Operations

4 Click Clear Cache.

Create a Project Workspace

To create a project workspace

1 Log in to the Siebel application and navigate to Site Map > Administration - Product > Workspace 
Projects.

2 Create a new workspace project with the name as CRMIntegProductWS. 

Namespace Name Status Comment

http://siebel.com/asi/ CSIntegSEBLSimpleProductInbound
Flow

Active None

Name Type
Business 
Service Transport Address Binding

CSIntegSEBLSi
mpleProductIn
boundFlow

Workflow 
Process

CSIntegSEBL
SimpleProduc
tInboundFlow

HTTP http://
<webserver>/
eai_<lang>/
start.swe?SWEE
xtSource=Secur
eWebService&S
WEExtCmd=Exec
ute&UserName=
<UserName>&P
assword=<Pass
word>

SOAP_RPC_LI
TERAL

Name
Method Display 
Name

Authentication 
Type

CreateProduct RunProcess None
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Create an Organization in Siebel
Create an Organization in Siebel similar to the Organization in Oracle E-Business Suite which is used 
in the business. For example, if Vision Operations is an Organization created in the Oracle E-Business 
Suite application, create Vision Operations as an Organization in the Siebel application as well.

To create an organization in Siebel

1 Log in to the Siebel application, and navigate to Site Map > Administration - Group > 
Organization.

2 Create a new organization.

Setting Up Funds

Repository Changes for Funds

To import Siebel Artifacts

1 Log in to Siebel 8.0 Tools and lock the following projects:

New? Project Description

New CS CG Fund Integration Holds CG Fund Integration related objects (It is a 
new project, so it would be available for initial 
import)

Modified CPG Fund Modify CS Account Fund BC to apply date specific 
validations at Fund level

Modified CS CG MDF Planning Modify Shipment and Revenue read only at Source 
Product level

Modified CPG Account Fund Added Status field on the form applet

Modified Symbolic Strings None
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2 Import the ACR358_Funds.sif file from the Siebel Quick Fix build.

This contains new and modified repository objects. The following table gives the description of 
changes for each repository object.

Symbolic Strings

PickList

Name Current String Value Definition

SBL_CS_FUND_CREATE_-
_SIEBEL_OUTBOUND

CS Fund Create - Siebel 
Outbound

Business Service Display Name for 
CS Fund Outbound WS

SBL_CS_FUND_UPDATE_-
_SIEBEL_INBOUND

CS Fund Update - Siebel 
Inbound

Business Service Display Name for 
CS Fund Inbound WS

New? Name Description Comments

Modified PickList CPG 
Fund

Search Spec = [Fund Type] = 
LookupValue("CS_FUND_CODE","
Account Fund") AND [Status] = 
LookupValue("CS_FUNDGROUP_S
TATUS","Completed")

Modified searchspec to include 
condition of Completed Status 
Funds.
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Business Component
Name: CS Account Fund (Modified)

CS Account Fund Fields

New? Name Description Comments

New Calc Today Type = DTYPE_DATE, Calculated = Y, 
Calculated value = Today ()

None

New Fund Period Read 
Only Field

Type = DTYPE_BOOL, Calculated = 
Y, Calculated value = IIf([Calc 
Today] >= [Mdf Start Date], "Y", 
"N")

Used in making the 
Start and End Dates 
read-only after 
reaching the Start 
Date 

New No Delete Flag Type = DTYPE_BOOL, Calculated = 
Y, Calculated value = IIf (([Mdf Alloc 
Total Estimate Pending Amount] > 0) 
OR ([Mdf Alloc Total Estimate 
Committed Amount] > 0) OR 
([Status] = LookupValue 
("CS_FUNDGROUP_STATUS","Compl
eted")), "Y", "N")

Used in for disabling 
the Delete button, 
after the deal has 
been created for the 
fund. 

NOTE: This is 
applicable to "CS 
Account Fund" BC 
Only.

New Fund Basis Date 
Field

Type = DTYPE_BOOL, Calculated = 
Y, Calculated value = IIf([Calc 
Today] >= [Basis Start Date], "Y", 
"N")

Used in Products 
code to determine 
the Basis Start Date 
value

Modified Mdf Start Date Validation: <= [Mdf End Date] New validation

Modified Mdf End Date Validation: >= [Mdf Start Date] New validation

Modified Basis Start Date Validation: <= [Basis End Date] New validation

Modified Basis End Date Validation: >= [Basis Start Date] New validation

Modified Amount Validation: >= 0 New validation

Modified Status Added Picklist = PickList CS Fund 
Group Status, Predefault Value = 
Expr: 
'LookupValue("CS_FUNDGROUP_ST
ATUS","In Progress")'

None

New Read Only 
Condition Field

Type = DTYPE_BOOL, Calculated = 
Y, Calculated value = IIf([Status] = 
LookupValue("CS_FUNDGROUP_STA
TUS","Completed"), "Y", "N")

New field used for 
making some other 
fields read-only 
based on its value
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BC User Properties

Name: CS Child Account Fund (Modified)

CS Child Account Fund Fields

BC User Properties

New? Name Value

New No Update Condition 
Field

Read Only Condition Field

New No Update Fields Basis Start Date, Basis Period, Mdf Start Date, 
Period, Amount, Status.

New NoDelete Field No Delete Flag 

New? Name Description Comments

New Fund Period Read 
Only Field

Type = DTYPE_BOOL, Calculated = Y, 
Calculated value = IIf([Status] = 
LookupValue 
("CS_FUNDGROUP_STATUS","Comple
ted"), "Y", "N")

Used in making 
some other fields 
read-only based 
on its value 

Modified Amount Validation: >= 0 New validation 

New Status Column = STATUS_CD, Picklist = 
PickList CS Fund Group Status, 
Predefault Value = Expr: 
'LookupValue("CS_FUNDGROUP_STA
TUS","In Progress")'

None

New? Name Value

New No Update Condition 
Field

Fund Period Read Only Field

New No Update Fields Account, Name, Amount, Status,

New NoDelete Field Fund Period Read Only Field

New Generate Event On 
Parent BC

Y
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Name: CS Fund Group (Modified)

CS Fund Group Fields

BC User Properties

New? Name Description Comments

New Calc Today Type = DTYPE_DATE, 
Calculated = Y, Calculated 
value = Today ()

None

New Fund Period Read 
Only Field

Type = DTYPE_BOOL, 
Calculated = Y, Calculated 
value = IIf([Calc Today] >= 
[Mdf Start Date], "Y", "N")

Used in making the Start 
and End Dates read-only 
after reaching the Start 
Date 

New Fund Basis Date 
Field

Type = DTYPE_BOOL, 
Calculated = Y, Calculated 
value = IIf([Calc Today] >= 
[Basis Start Date], "Y", "N")

Used in Generate Account 
Funds code to determine 
the Basis Start Date value

Modified Mdf Start Date Validation: <= [Mdf End Date] New validation

Modified Mdf End Date Validation: >= [Mdf Start 
Date]

New validation

Modified Basis Start Date Validation: <= [Basis End 
Date]

New validation

Modified Basis End Date Validation: >= [Basis Start 
Date]

New validation

Modified Amount Validation: >= 0 New validation

New? Name Value

New GenerateCurrent
StartDate

N
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Name: CS Fund Source Product

CS Fund Source Product Fields

New? Name Description Comments

Modified Accrual Start 
Date

Validation:<= [Accrual End Date] New validation

Modified Accrual End 
Date

Validation:>= [Accrual Start Date] New validation

New Calc Today Type = DTYPE_DATE, Calculated = Y, 
Calculated value = Today()

Used in comparing the 
Start Date with current 
date for sending data to 
Oracle Trade 
Management.

New Period Read 
Only Field

Type = DTYPE_BOOL, Calculated = 
Y, Calculated value = [Calc Today] 
>= [Fund MDF Start Date], 
Predefault value = N

Used in making the 
Basis Start and End 
Dates read-only after 
reaching the Basis Start 
Date 

New Fund MDF 
Start Date

Join = S_MDF, Column = 
MDF_START_DT, Type = 
DTYPE_DATE

Parent MDF start date

New Fund Basis 
Start Date

Join = S_MDF, Column = 
BASIS_START_DT, Type = 
DTYPE_DATE

Parent Basis start date

New Fund Basis 
Date Field

Type = DTYPE_BOOL, Calculated = 
Y, Calculated value = IIf([Calc 
Today] >= [Fund Basis Start Date], 
"Y", "N")

Used in the Product 
code

New Fund Type Join = S_MDF, Column = FUND_CD, 
Type = DTYPE_TEXT

Parent Fund Type

New Is Account 
Fund

Type = DTYPE_BOOL, Calculated = 
Y, Calculated value = If ([Fund Type] 
= LookupValue("CS_FUND_CODE", 
"Account Fund"), "Y", "N")

Used in Runtime event 
condition 

New Source 
Product Id

Type = DTYPE_ID, Calculated = Y, 
Calculated value = [Id]

Needed by Integration 
object

New Fund Status Join = S_MDF, Column = 
STATUS_CD

Parent Fund Status
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BC User Properties

Name: CPG Fund

CPG Fund Fields

New Read Only 
Condition Field

Type = DTYPE_BOOL, Calculated = 
Y, Calculated value = IIf 
(ParentBCName() = 'CS Account 
Fund', IIf([Fund Status] = 
LookupValue 
("CS_FUNDGROUP_STATUS","Compl
eted"), "Y", "N"), "N")

None

New Integration 
Data Update 
Flag

Column = DIST_FLG Used in BPEL processes 
to force incoming 
update if values are the 
same

New? Name Value

New GenerateCurrentStartDate N

New Cumulative Accrual Data Y

New Generate Event On Parent BC Y

New No Update Condition Field Period Read Only Field

New No Update Fields Accrual Start Date, 
Period,

New NoDelete Field Read Only Condition 
Field

New? Name Description Comments

New Status Column = STATUS_CD, Picklist = 
PickList CS Fund Group Status, 
Link Specification = Y

Used in the PickList CPG 
Fund search spec

New? Name Description Comments
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Applet
Name: CS Fund Source Product Admin List Applet

CS Fund Source Product Admin List Applet List Columns

Name: CS Fund Admin List Applet

CS Fund Admin List Applet List Columns

Map the List column in Edit List Applet Web Template Item.

Name: CS Fund Auto Admin List Applet

CS Fund Auto Admin List Applet List Columns

Map the List column in Edit List Applet Web Template Item.

Name: CS Fund Child Admin List Applet

CS Fund Child Admin List Applet

Map the List column in Edit List Applet Web Template Item.

New? Name Description Comments

Modified Shipment Read Only = Y Read only in UI because these 
values are coming from Oracle 
Trade Management.

Modified Revenue Read Only = Y Read only in UI because these 
values are coming from Oracle 
Trade Management.

New? Name Description Comments

New Status Field = Status, Show 
in List = Y

New field exposed in UI for 
Account Funds

New? Name Description Comments

New Status Field = Status, Show in List = 
Y, Read Only = Y

New field exposed in UI in Read only 
mode for Fund Group - Account 
Funds (bottom applet)

New? Name Description Comments

New Status Field = Status, Show in List = 
Y

New field exposed in UI for Child 
Funds
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Name: CS Fund Summary Admin Form Applet

CS Fund Summary Admin Form Applet Controls

Map the Column in Edit Applet Web Template Item.

Integration Object
■ Name: Internal CSIntegSEBLSIAFundInterface (New)

■ Project: CS CG Fund Integration

■ Base Object Type: Siebel Business Object 

■ External Name: CS Fund

■ XML Tag: ListOfCsintegseblsiafundinterface

Integration Components
■ Name & External Name: CS Account Fund

■ Parent Integration Component: None

■ XML Container Element: None

■ XML Tag: CsAccountFund

New? Name Description Comments

New Status Field = Status New field exposed in Account 
Funds form applet
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■ Cardinality: Zero or One

Integration Component Fields

Name Data Type Length Type
XML 
Style XML Tag Comments

Account DTYPE_TEXT 40 Data Element Account User Prop 
PICKLIST= Y

Account 
Id

DTYPE_ID Data Element AccountId None

Amount DTYPE_CURR
ENCY

Data Element Amount None

Basis DTYPE_TEXT 30 Data Element Basis User Prop 
PICKLIST= N

Currency 
Code

DTYPE_TEXT 20 Data Element CurrencyCode User Prop 
PICKLIST= N

Exchange 
Date

DTYPE_DATE Data Element ExchangeDate None

Fund 
Type

DTYPE_TEXT 30 Data Element FundType Query field for 
BC. We are 
supposed to send 
only Account 
Fund Type data.

Id DTYPE_ID 30 Syste
m

Element Id None

Fund UId DTYPE_ID Data Element FundUId None

Mdf End 
Date

DTYPE_DATE Data Element MdfEndDate None

Mdf Start 
Date

DTYPE_DATE Data Element MdfStartDate None

Mdf Type DTYPE_TEXT 30 Data Element MdfType User Prop 
PICKLIST= N

Name DTYPE_TEXT 50 Data Element Name

Organizat
ion

DTYPE_TEXT 50 Data Element Organization User Prop 
PICKLIST= Y

Organizat
ion Id

DTYPE_ID Data Element OrganizationId None

Parent 
Fund Id

DTYPE_ID Data Element ParentFundId None
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Integration Component Key

■ Name & External Name: CS Fund Source Product

■ Parent Integration Component: CS Account Fund

■ XML Container Element: ListOfCsFundSourceProduct

■ XML Tag: CsFundSourceProduct

Parent 
Fund 
Name

DTYPE_TEXT 50 Data Element ParentFundNa
me

None

operation DTYPE_TEXT Syste
m

Attribute operation None

searchsp
ec

DTYPE_TEXT Syste
m

Attribute searchspec None

Key Name Key Type Sequence Sequential Key Fields Comments

User Key:1 User Key 1 Id None

Status Key Status Key 2 1 Operation

2 Id

None

Name Data Type Length Type
XML 
Style XML Tag Comments
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■ Cardinality: Zero or More

Integration Component Fields

Name Data Type Length Type
XML 
Style XML Tag Comments

Account Id DTYPE_ID Data Element AccountId None

Accrual End 
Date

DTYPE_DA
TE

Data Element AccrualEndDate None

Accrual 
Rate

DTYPE_CU
RRENCY

Data Element AccrualRate None

Accrual 
Rate 
Percentage

DTYPE_NU
MBER

Data Element AccrualRatePerce
ntage

None

Accrual 
Start Date

DTYPE_DA
TE

Data Element AccrualStartDate None

Currency 
Code

DTYPE_TE
XT

20 Data Element CurrencyCode None

Exchange 
Date

DTYPE_DA
TE

Data Element ExchangeDate None

Fund Id DTYPE_ID Data Element FundId None

Id DTYPE_ID 30 System Element Id None

Product Id DTYPE_ID Data Element ProductId None

Product 
Name

DTYPE_TE
XT

100 Data Element ProductName None

Revenue DTYPE_CU
RRENCY

Data Element Revenue None

Shipments DTYPE_INT
EGER

Data Element Shipments2 None

Source 
Product Id

DTYPE_ID Data Element SourceProductId None

Integration 
Data Update 
Flag (Req)

DTYPE_TE
XT

1 Data Element IntegrationDataU
pdateFlag

None

Operation DTYPE_TE
XT

30 System Attribute operation None

searchspec DTYPE_TE
XT

250 System Attribute searchspec None



Installation and Configuration ■ Configuring the Siebel Trade Promotion Management
Environment

Siebel CRM Integration Pack for Trade Promotion Management
Implementation Guide Version 1.00

69

Integration Component Key

Integration Object User Prop

■ Name: CSIntegSEBLSIAFundInterface (New)

■ Project: CG Funds Integration

■ Base Object Type: XML

■ External Name: CS Fund Interface

■ XML Tag: ListOfCsintegseblsiafundinterface 

■ Description: This interface integration object is the pair of "Internal 
CSIntegSEBLSIAFundInterface", so it has all the Integration Components, which are in Internal 
CSIntegSEBLSIAFundInterface.

The following additional new Integration Object components are added to this XML based 
CSIntegSEBLSIAFundInterface integration object:

■ Name & External Name: faultMessage

■ Parent Integration Component: CS Account Fund

■ XML Container Element: XML Tag: faultMessage

Key Name Key Type Sequence
Sequential Key 
Fields Comments

V77 Wizard-Generated 
User Key:1

User Key 1 Id None

Status Key Status Key 2 1 Operation

2 Id

None

Name Value Comments

AllLangIndependen
tVals

Y For each LOV Field, the internal integration 
object returns a LIC, if the user property 
AllLangIndependentVals is set to Y at the 
object level.

XMLTagNamespace http://www.siebel.com/
xml/
CSIntegSEBLSIAFundInte
rface

None

XSDTypeNamespac
e

http://www.siebel.com/
xml/
CSIntegSEBLSIAFundInte
rface

None
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■ Cardinality: Zero or One

Integration Component Fields

■ Name & External Name: errorMessage

■ Parent Integration Component: faultMessage

■ XML Container Element: ListOfErrorMessage

■ XML Tag: errorMessage

Name
Data 
Type Length Type

External 
Name

External 
Data 
Type

External 
Length

XML 
Style XML Tag

faultTe
xt

DTYPE
_TEXT

20,240 Data faultText DTYPE_T
EXT

20,240 Element faultText

FlowCo
ntext

DTYPE
_TEXT

512 Data flowCont
ext

DTYPE_T
EXT

512 Element flowConte
xt

flowNa
me

DTYPE
_TEXT

128 Data flowNam
e

DTYPE_T
EXT

128 Element flowName

Lang DTYPE
_TEXT

20 Data lang DTYPE_T
EXT

20 Element lang

proces
sCallSt
ack

DTYPE
_TEXT

1,024 Data processC
allStack

DTYPE_T
EXT

1,024 Element processCa
llStack

Proces
sName

DTYPE
_TEXT

128 Data processN
ame

DTYPE_T
EXT

128 Element processNa
me

severit
y

DTYPE
_INTE
GER

1 Data severity DTYPE_I
NTEGER

1 Element severity

Type DTYPE
_TEXT

128 Data type DTYPE_T
EXT

128 Element type
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■ Cardinality: Zero or more

Integration Component Fields

Name
Data 
Type Length Type

External 
Name

External 
Data 
Type

External 
Length

XML 
Style

XML 
Tag

AppInsta
nce

DTYPE
_TEXT

30 Data appInsta
nce

DTYPE_TE
XT

30 Element appInst
ance

appType DTYPE
_TEXT

30 Data appType DTYPE_TE
XT

30 Element appTyp
e

argumen
t1

DTYPE
_TEXT

512 Data argument
1

DTYPE_TE
XT

512 Element argume
nt1

argumen
t2

DTYPE
_TEXT

512 Data argument
2

DTYPE_TE
XT

512 Element argume
nt2

argumen
t3

DTYPE
_TEXT

512 Data argument
3

DTYPE_TE
XT

512 Element argume
nt3

argumen
t4

DTYPE
_TEXT

512 Data argument
4

DTYPE_TE
XT

512 Element argume
nt4

argumen
t5

DTYPE
_TEXT

512 Data argument
5

DTYPE_TE
XT

512 Element argume
nt5

argumen
t6

DTYPE
_TEXT

512 Data argument
6

DTYPE_TE
XT

512 Element argume
nt6

argumen
t7

DTYPE
_TEXT

512 Data argument
7

DTYPE_TE
XT

512 Element argume
nt7

argumen
t8

DTYPE
_TEXT

512 Data argument
7

DTYPE_TE
XT

512 Element argume
nt7

argumen
t9

DTYPE
_TEXT

512 Data argument
9

DTYPE_TE
XT

512 Element argume
nt9

Code DTYPE
_TEXT

30 Data code DTYPE_TE
XT

30 Element code

Lang DTYPE
_TEXT

30 Data lang DTYPE_TE
XT

30 Element lang

Text DTYPE
_TEXT

20,240 Data text DTYPE_TE
XT

20,240 Element text
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Integration Object User Prop

Business Service
■ Name & Display Name: CSIntegSEBLSIACGFundUpdate (New)

■ Class: CSSEAIDataSyncService

■ External Use: Y

■ State Management Type: Stateful

Business Service Methods

Business Service Method Arguments

■ Name: QueryByExample

Name Value Comments

AllLangIndependentVals N None

XMLTagNamespace http://www.siebel.com/xml/
CSIntegSEBLSIAFundInterface

None

XSDTypeNamespace http://www.siebel.com/xml/
CSIntegSEBLSIAFundInterface

None

Name Display Name

Delete Delete

Insert Insert

InsertOrUpdate Insert or Update

Synchronize Synchronize

Update Update

Name
Data 
Type

Integration 
Object Type Optional

Storage 
Type

Display 
Name Comments

Siebel
Messa
ge

Integrat
ion 
Object

CSIntegSEB
LSIAFundInt
erface

Input / 
Output

N Hierarchy None

Status
Object

String Input Y Property Pick Field = 
Id PickList = 
EAI Boolean 
Message 
Property 
PickList
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■ Display Name: Query by Example

Business Service Method Arguments

■ Name: QueryById

■ Display Name: Query by ID

Business Service Method Arguments

Business Service User Prop

■ Name & Display Name: CRMIntegUpsertFundSEBL80ToEBS11i10Sync (New)

■ Class: CSSWSOutboundDispatcher

■ External Use: Y

■ State Management Type: Stateful

Business Service Methods
■ Name: process

Name
Data 
Type

Integration 
Object Type Optional

Storage 
Type

Display 
Name Comments

SiebelM
essage

Integra
tion 
Object

CSIntegSEBL
SIAFundInter
face

Input / 
Output

N Hierarchy None

Name
Data 
Type

Integration 
Object Type Optional

Storage 
Type

Display 
Name Comments

Prima
ryRow
Id

String Input N Property None

Siebel
Messa
ge

Integr
ation 
Object

CSIntegSEBL
SIAFundInterf
ace

Output N Hierarch
y

None

Name Value

Application Services Interface Y

Internal Integration Object Internal 
CSIntegSEBLSIAFundInterface
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■ Display Name: process

Business Service Method Arguments

Name
Data 
Type

Integration 
Object Type Optional

Storage 
Type

Display 
Name

BS Method 
Arg User 
Prop

CRMInte
gUpsertF
undSEBL
80ToEBS
11i10Syn
cRequest
Message:
payload

Integrat
ion 
Object

CSIntegSEBL
SIAFundInter
face

Input Y Hierarchy payload WSDLPartN
ame = 
payload

XMLElemen
tName = 
ListOfCsint
egseblsiafu
ndinterface

XMLElemen
tNamespac
e = http://
www.siebel
.com/xml/ 
CSIntegSE
BLSIAFundI
nterface

CRMInte
gUpsertF
undSEBL
80ToEBS
11i10Syn
cRespons
eMessag
e:payloa
d

Integrat
ion 
Object

CSIntegSEBL
SIAFundFault
Message

Output Y Hierarchy payload WSDLPartN
ame = 
payload

XMLElemen
tName = 
ListOfCsint
egseblsiafu
ndinterface

XMLElemen
tNamespac
e = http://
www.siebel
.com/xml/ 
CSIntegSE
BLSIAFundI
nterface

CustomH
eaderCon
text

Hierarc
hy

Input/
Output

Y Hierarchy

XMLHiera
rchyOutp
ut

Hierarc
hy

Output Y XMLHier
archyOu
tput
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3 Shut down the Siebel server and compile the locked projects into the server .srf file.

Workflow Deployment

To deploy workflows

1 Log in to Siebel Tools and navigate to Workflows.

2 Right click and select the Import Workflow process.

3 Enter CSIntegSEBLSIAFundUpsertOutboundFlow as the workflow to import.

4 Select the Project as CS CG Fund Integration and click OK.

5 Query for the workflow. The workflow should be created as follows:

■ Workflow Process Name: CSIntegSEBLSIAFundUpsertOutboundFlow

faultactor String Output Y Property

faultcode String Output Y Property

faultstrin
g

String Output Y Property

Name
Data 
Type

Integration 
Object Type Optional

Storage 
Type

Display 
Name

BS Method 
Arg User 
Prop
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■ Workflow Mode: Service Flow

WF Process Properties

WF Steps

Name In/Out
Business 
Object Data Type

Access 
Mode

BinaryMSG In/Out CS Fund String RW

Error Code In/Out CS Fund String RW

Error Message In/Out CS Fund String RW

Fault Message In/Out CS Fund Hierarchy RW

IsError In/Out CS Fund String RW

Object Id In/Out CS Fund String RW

Process Instance Id In/Out CS Fund String RW

Siebel Outbound 
Message

In/Out CS Fund Hierarchy RW

Siebel Operation 
Object Id

In/Out CS Fund String RW

# Name Type BS Name
BS 
Method

Input 
Argument

Output 
Argument

1 Start Start

2 Query 
Account 
Fund

Business 
Service

CSIntegSEBLSI
ACGFundUpdate

QueryById PrimaryRowI
d

SiebelMessag
e

3 Send 
Account 
Fund

Business 
Service

CRMIntegUpsert
FundSEBL80ToE
BS11i10Sync

process CSIntegSEBL
SIAFundSync
RequestMess
age:payload

faultMessage

4 Check 
Errors

Business 
Service

Genesis Error 
Handler

CheckForE
rrors

SiebelMessag
e

IsError

5 Error? Decision 
Point

6 Translate 
Errors

Business 
Service

Genesis Error 
Handler

TranslateE
rrors

SiebelMessag
e

OutputErrorM
essages

7 Display 
Errors

Business 
Service

Genesis Error 
Handler

DisplayErr
ors

ErrorMessage
s
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6 Deploy the workflow by clicking Publish/Activate on WF/Task Editor Toolbar. 

The toolbar can be enabled by selecting View > Toolbars > WF/Task Editor Toolbar. 

7 Login to Siebel UI and navigate to Administration > Business Processes > Workflow Deployment.

8 Query for the Workflow deployed and click Activate.

Web Service Deployment

To deploy Web Services

1 Login to Siebel UI and navigate to Administration > Web Services > Inbound Web Services.

2 Click Import and specify the Web Service CSIntegSEBLSIACGFundUpdate.xml to be imported:

Inbound Web Service: CSIntegSEBLSIACGFundUpdate

3 After the inbound Web Service is imported, verify the Siebel server name address in the Service 
Ports applet.

The server address should be the one that the client should connect to. If required, change the 
address and provide a valid username and password. 

Name: CSIntegSEBLSIACGFundUpdate (New)

Service Port

Operations

Name Type

Business 
Service/
Process Transport Address Binding

CSIntegSE
BLSIACGF
undUpdate

Business 
Service

CS Fund 
Update - 
Siebel 
Inbound

HTTP http://<webserver>/
eai_<lang>/
start.swe?SWEExtSou
rce=WebService&SW
EExtCmd=Execute&U
serName=<UserNam
e>&Password=<Pass
word>

SOAP_RPC
_LITERAL

Name Method Display Name Authentication Type

SiebelFundDelete Delete None

SiebelFundInsert Insert None

SiebelFundInsertOrUpdate Insert or Update None

SiebelFundQueryByExample Query by Example None

SiebelFundQueryById Query by ID None
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4 Click Clear Cache.

5 Navigate to Administration > Web Services > Outbound Web Services.

6 Click Import and specify the Web Service CRMIntegUpsertFundSEBL80ToEBS11i10Sync.xml to be 
imported:

Outbound Web Service: CRMIntegUpsertFundSEBL80ToEBS11i10Sync.xml

7 After the outbound Web Service is imported, verify the BPEL server name in the Service Ports 
applet.

The server name should be the one that the client should connect to. If required, change the 
address and save.

Outbound Web Service is created as follows:

■ Name: CRMIntegUpsertFundSEBL80ToEBS11i10Sync (New) 

■ Namespace: http://xmlns.oracle.com/CRMIntegUpsertFundSEBL80ToEBS11i10Sync

Service Port

Operations

■ Method Display Name: Process

■ Authentication Type: None

8 Click Clear Cache.

Runtime events

To manage runtime events

1 Navigate to Administration Runtime Events > Action Sets.

SiebelFundSynchronize Synchronize None

SiebelFundUpdate Update None

Name
Service Display 
Name Transport Address Binding

CRMIntegUpsert
FundSEBL80ToE
BS11i10SyncPort

CS Fund Create - 
Siebel Outbound

HTTP http://<host-info>/
orabpel/default/
CRMIntegUpsertFundSEB
L80ToEBS11i10Sync/1.0

SOAP_DOC_
LITERAL

Name Method Display Name Authentication Type
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2 Create a new Action Set as follows:

Action Set

Name: CS Account Fund Update

Events

3 Navigate to Administration Runtime Events > Events.

4 Create new events as follows:

5 Choose the Load Runtime Events menu option.

Setting Up Deductions

Repository Changes for Deduction

To import the Siebel Artifacts

1 Log in to Siebel 8.0 Tools and create a new project CS CG Deduction Interface and lock the 
following existing projects:

■ CS CG Promotion Planning

■ CS CG Deduction Mgmt II 

Name Action Type
Business 
Service Name

Business 
Service Method

Business Service 
Context

Fund Source 
Product Create

BusService Workflow 
Process Manager

RunProcess "ProcessName", 
"CSIntegSEBLSIAFu
ndUpsertOutboundFl
ow"

Sequence
Object 
Name Object Name Event Conditional Expression

1 BusComp CS Account 
Fund

NewRecord [Read Only Condition Field] = 'Y'

2 BusComp CS Account 
Fund

WriteRecord [Read Only Condition Field] = 'Y'

3 BusComp CS Fund Source 
Product

NewRecord ([Is Account Fund] = 'Y' AND 
[Read Only Condition Field] = 'Y')

4 BusComp CS Fund Source 
Product

WriteRecord ([Is Account Fund] = 'Y' AND 
[Read Only Condition Field] = 'Y')
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■ CPG Account Fund

■ CS CG Deduction Management

■ CS CG MDF Planning

■ CS CG Deduction (SCW)

■ CS CG Deduction2 (SCW)

■ Symbolic Strings

2 Import the following .sif files from the Siebel Quick Fix build, which contains new and modified 
repository objects:

■ ACR358_GenesisErrorHandler.sif 

■ ACR358_Deductions.sif

The followings are the repository changes included in ACR358_Deductions.sif.

Project: New
Name: CS CG Deduction Interface

Symbolic Strings

Business Components
■ CG MDF Promotion Allocation - Pick (Modified)

Add new field "Promotion Status" which maps to Column STATUS_CD by Join "Fund Promotion".

■ CG Split Deduction (Modified)

■ Add MVL: CPG Deduction Child Payments using Link CG Split Deduction/CPG Deduction Child 
Payments:

No Copy = Y

■ Add new calculated fields: 

❏ Field: Count Resolution Record

Calculated Value: IfNull(Count("CPG Deduction Child Payments"), 0)

Name
Current Display 
Value Definition

SBL_CS_DEDUCTION_PA
YMENT_INBOUND

Deduction and Payment 
- Siebel Inbound

Deduction and Payment Inbound 
Web Service display name

SBL_CS_RESOLUTION_P
AYMENT_INBOUND

Resolution and 
Payment - Siebel 
Inbound

Resolution and Payment Inbound 
Web Service display name

SBL_CS_RESOLUTION_P
AYMENT_OUTBOUND

Resolution and 
Payment - Siebel 
Outbound

Resolution and Payment - Siebel 
Outbound
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❏ Field: Deduction Amount Read Only Flag

Calculated Value: IIf (ParentFieldValue("Sum Resolution Record Count") > 0 or 

[Payment Status] = LookupValue("DEDUCTION_STATUS","Inactive"), "Y", "N")

■ CPG Account Credit Memo (Modified)

■ Add new Business Component User Property: 

❏ Name: CG Auto Submit On WriteRecord

Value: Y

❏ Name: Named Method 1

Value: "SubmitPayment", "INVOKESVC", "CPG Account Credit Memo", "Workflow Process 
Manager", "RunProcess", "'ProcessName'", "CSIntegSEBLSIAPaymentInsertOuboundFlow", 
"'RowId'", "[Id]"

❏ Name: On Field Update Invoke 1

Value: "Payment Status", "CPG Account Credit Memo", "SubmitPayment", "[Payment 
Status]=LookupValue('FUNDRQ_STATUS', 'Submitted')"

■ CPG Check Payment (Modified)

■ Add new Fields: 

❏ Field: Account Id 

Column: ACCNT_ID

❏ Field: Integration Id

Column:INTEGRATION_ID

Predefault Value:Field: 'Id'

■ Modify an existing field:

❏ Field: Allocation Id

Change PickList to "CPG Checkbook Payment Allocation PickList"

■ Add a new Business Component User Property: 

❏ Name: On Field Update Invoke 1

Value: "Payment Status", "CPG Check Payment", "SubmitPayment", "[Payment 
Status]=LookupValue('FUNDRQ_STATUS', 'Submitted')"

❏ Name: On Field Update Invoke 5

Value: "Payment Status", "CPG Check Payment", "SaveRecord", "[Payment 
Status]=LookupValue('FUNDRQ_STATUS', 'Submitted')"

❏ Name: Named Method 1

Value: "SubmitPayment", "INVOKESVC", " CPG Check Payment", "Workflow Process 
Manager", "RunProcess", "'ProcessName'", "CSIntegSEBLSIAPaymentInsertOuboundFlow", 
"'RowId'", "[Id]"
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❏ Name: Named Method 2

Value: "SaveRecord", "INVOKE", "CPG Check Payment", "WriteRecord"

■ CPG Deduction (Modified)

■ Add new Fields: 

❏ Field: Integration Id

Column:INTEGRATION_ID

Predefault Value:Field: 'Id'

■ CPG Deduction (Modified)

■ Add new Fields: 

❏ Field: Integration Id

Column:INTEGRATION_ID

Predefault Value:Field: 'Id'

■ Modify existing  Fields: 

❏ Field: Chargeback Amount

Validation: >= 0 

❏ Field: Credit Memo Amount

Validation: >= 0 

❏ Field: Total Resolved Amount

Validation: >= 0 

❏ Field: Trade Funds Amount

Validation: >= 0 

■ Modify existing MVL: "CPG Resolution Payments" set "No Copy" = Y.

■ CPG Deduction Admin (Modified)

■ Modify MVL: "CPG Resolution Payments" set "No Copy" = Y.

■ Add MVL: CG Split Deduction using Link CS CG Deduction and Payment/CG Split Deduction.

■ Add new MVFs:

❏ Field: Child Deduction Amount

Destination Field: Deduction Amount

Multivalue Link: CG Split Deduction 

❏ Field: Child Resolution Record Count

Destination Field: Count Resolution Record

Multivalue Link: CG Split Deduction 
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■ Add new calculated fields:

❏ Field: Sum Child Deduction Amount

Calculated Value: Sum ([Child Deduction Amount])

❏ Field: Sum Resolution Record Count

Calculated Value: IfNull(Sum ([Child Resolution Record Count]), 0)

■ CPG Deduction Chargeback (Modified)

■ Add new calculated field: 

❏ Name: CG Auto Paid OnSubmit Flag

Calculated value: Y

■ Add new Business Component User Property: 

❏ Name: On Field Update Invoke 1

Value: "Payment Status", "CPG Deduction Chargeback", "SubmitPayment", "[Payment 
Status]=LookupValue('FUNDRQ_STATUS', 'Submitted')"

❏ Name: On Field Update Invoke 2

Value: "Payment Status", "CPG Deduction Chargeback", "SaveRecord", "[Payment 
Status]=LookupValue('FUNDRQ_STATUS', 'Submitted')"

❏ Name: Named Method 1

Value: "SubmitPayment", "INVOKESVC", "CPG Deduction Chargeback", "Workflow Process 
Manager", "RunProcess", "'ProcessName'", "CSIntegSEBLSIAPaymentInsertOuboundFlow", 
"'RowId'", "[Id]"

❏ Name: Named Method 2

Value: "SaveRecord", "INVOKE", "CPG Deduction Chargeback", "WriteRecord" 

❏ Name: CG Auto Paid OnSubmit

Value: CG Auto Paid OnSubmit Flag

■ CPG Deduction Resolution - Payment (Modified)

■ Add new calculated field: 

❏ Name: CG Auto Paid OnSubmit Flag

Calculated value: IIf ([Payment Credit Num] is not null, "Y", "N")

■ Add a new Business Component User Property: 

❏ Name: On Field Update Invoke 1

Value: "Payment Status", "CPG Deduction Resolution - Payment", "SubmitPayment", 
"[Payment Status]=LookupValue('FUNDRQ_STATUS', 'Submitted')"
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❏ Name: On Field Update Invoke 2

Value: "Payment Status", "CPG Deduction Resolution - Payment", "SaveRecord", "[Payment 
Status]=LookupValue('FUNDRQ_STATUS', 'Submitted')"

❏ Name: Named Method 1

Value: "SubmitPayment", "INVOKESVC", "CPG Deduction Resolution - Payment", "Workflow 
Process Manager", "RunProcess", "'ProcessName'", 
"CSIntegSEBLSIAPaymentInsertOuboundFlow", "'RowId'", "[Id]"

❏ Name: Named Method 2

Value: "SaveRecord", "INVOKE", "CPG Deduction Resolution - Payment", "WriteRecord"

❏ Name: CG Auto Paid OnSubmit

Value: CG Auto Paid OnSubmit Flag

■ CPG Deduction Write-Off (Modified)

■ Add new calculated field: 

❏ Name: CG Auto Paid OnSubmit Flag

Calculated value: Y

■ Add a new Business Component User Property:

❏ Name: On Field Update Invoke 1

Value: "Payment Status", "CPG Deduction Write-Off", "SubmitPayment", "[Payment 
Status]=LookupValue('FUNDRQ_STATUS', 'Submitted')"

❏ Name: On Field Update Invoke 2

Value: "Payment Status", "CPG Deduction Write-Off", "SaveRecord", "[Payment 
Status]=LookupValue('FUNDRQ_STATUS', 'Submitted')"

❏ Name: Named Method 1

Value: "SubmitPayment", "INVOKESVC", "CPG Deduction Write-Off", "Workflow Process 
Manager", "RunProcess", "'ProcessName'", "CSIntegSEBLSIAPaymentInsertOuboundFlow", 
"'RowId'", "[Id]"

❏ Name: Named Method 2

Value: "SaveRecord", "INVOKE", "CPG Deduction Write-Off", "WriteRecord"

❏ Name: CG Auto Paid OnSubmit

Value: CG Auto Paid OnSubmit Flag

■ CPG Mdf Checkbook (Modified)

■ Add new Fields: 

❏ Field: Payments Pending

Column:CG_PENDING_AMT
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❏ Field: Payments Sub

Column:CG_SUBMITED_AMT

❏ Field: Payments Paid

Column:CG_PAID_AMT 

■ Modify existing calculated field:

❏ Field: Payment Lock Flag

Change calculated value:

IIf ([Payment Status] = LookupValue("FUNDRQ_STATUS","Submitted") or [Payment Status] 
= LookupValue("FUNDRQ_STATUS","Paid") or [V/C Flag] = 'Y' or [Payments Sub] > 0.00 or 
[Payments Paid] >0.00, "Y", "N")

■ CS CG Deduction and Payment (New)

■ Clone CPG Dedcution Bussiness Component.

■ Make the following changes:

❏ Remove Search Specification.

❏ Set Buscomp View Mode "Sales Rep" Inactive = Y.

❏ Business Component User Property: 
Add a new User Property:
Name: Is Integration BC
Value: Y

Inactivate the existing User Properties: Name: Deep Copy, Deep Copy 1, Deep Copy 2, 
Deep Copy 3, Deep Copy 4, Rollup Fields 1 and User Position Visibility.

❏ Remove existing User Property: On Field Update Set.

Join
Inactive Join "S_SRC_PAY_ATT".

Modify the existing fields:
Account:Set Required = N
Account Id:Set Required=Y, Set Read Only = N, PickList = PickList CPG Account
Payment Status:PickList = PickList Deduction and Payment Status
Attachment: Inactive = Y
Attachment Name:   Inactive = Y
Chargeback Amount 
Validation:>= 0 
Credit Memo Amount
Validation:>= 0 
Total Resolved Amount
Validation:>= 0 
Trade Funds Amount
Validation:>= 0 
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❏ Add new single value fields:
Deduction Amount Read Only Flag:
Calculated value = IIf ([Source Payment Type] <> 
LookupValue("PAYMENT_METHOD_CODE","Deduction") OR [Count Resolution Record] > 
0 OR [Sum Split Ded Resolution Record]> 0, "Y", "N")
Deduction Status Read Only Flag: Calculated value = [Deduction Amount Read Only Flag]
Integration Id:No Copy = N 
Count Child Deduction:Calculated value = IfNull(Count("CG Split Deduction"), 0) 
Count Resolution Record:Calculated value = IfNull(Count("CPG Deduction Child 
Payments"), 0)
Sum Split Ded Resolution Record:Calculated value = IfNull(Sum ([Count Split Ded 
Resolution Record]), 0)

❏ Add new MLV Field:
Count Split Ded Resolution Record:Destination field = Count Resolution Record by MVL 
"CG Split Deduction"

❏ Add MVLs:
CG Split Deduction:CS CG Deduction and Payment/CG Split Deduction
CPG Deduction Child Payments:CS CG Deduction and Payment/CPG Deduction Child 
Payments

■ CS CG Resolution and Payment (New)

■ Class: CSSBCCSBase

■ Search Specification: [Payment Reason Type] = 
LookupValue("PAYMENT_TYPE_CODE","Deduction") or [Resolution Type] = 
LookupValue("PAYMENT_TYPE_CODE","Chargeback") or [Resolution Type] = 
LookupValue("PAYMENT_TYPE_CODE","Write Off") or [Account Credit Memo Payment Type] 
= LookupValue("PAYMENT_METHOD_CODE","Credit Memo")

■ Table: S_SRC_PAYMENT

■ Join:

❏ Table: S_SRC_PAYMENT

❏ Alias: Parent Payment

❏ Out Join Flag: Y

Table 30. Fields

Name Calculated Value Join Column Type

Account Credit 
Memo Account Id

ACCNT_ID DTYPE_ID

Account Credit 
Memo Amount

PAY_AMT DTYPE_NUMBER

Account Credit 
Memo Date

PERFORM_DT DTYPE_DATE
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Account Credit 
Memo Payment 
Type

PAY_TYPE_CD DTYPE_TEXT

Calc Account Id  IIf([Account Credit 
Memo Account Id] is not 
null, [Account Credit 
Memo Account Id], 
[Deduction or 
Checkbook Account Id])

DTYPE_ID

Calc Amount  IIf ([Account Credit 
Memo Payment Type] = 
LookupValue("PAYMENT
_METHOD_CODE", 
"Credit Memo") AND 
[Account Credit Memo 
Amount] is not null, 
[Account Credit Memo 
Amount], [Calc 
Resolution Amount])

DTYPE_CURREN
CY

Calc Deduction 
Date

 IIf([Account Credit 
Memo Date] is not null, 
[Account Credit Memo 
Date], [Deduction 
Date])

DTYPE_TEXT

Calc Deduction 
Id

 IIf([Parent Payment 
Type] = 
LookupValue('PAYMENT
_METHOD_CODE', 
'Deduction'), [Parent 
Payment Id], [Id])

DTYPE_ID

Calc Payment 
Method Type

IIf ([Account Credit 
Memo Payment Type] is 
not null, [Account Credit 
Memo Payment Type], 
IIf([Calc Resolution 
Type] is not null, [Calc 
Resolution Type], 
[Parent Payment 
Type]))

DTYPE_TEXT

Table 30. Fields

Name Calculated Value Join Column Type
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Calc Resolution 
Amount

IIf ([Trade Funds 
Amount] is not null, 
[Trade Funds Amount], 
IIf([Credit Memo 
Amount] is not null, 
[Credit Memo Amount], 
IIf([Write-off Amount] 
is not null, [Write-off 
Amount], 
IIf([Chargeback 
Amount] is not null, 
[Chargeback Amount], 
0.0))))

DTYPE_CURREN
CY

Calc Resolution 
Type

 IIf ([Resolution Type] = 
LookupValue('PAYMENT
_TYPE_CODE','Chargeb
ack') OR [Resolution 
Type] = 
LookupValue('PAYMENT
_TYPE_CODE','Write 
Off'), [Resolution Type], 
"")

DTYPE_TEXT

Chargeback 
Amount

CHRG_BCK_AMT DTYPE_CURREN
CY

Credit Memo 
Amount

CG_CREDIT_ME
MO_TOT

DTYPE_CURREN
CY

Credit Memo Id CG_CREDIT_ME
MO_ID

DTYPE_ID

Currency Code AMT_CURCY_CD DTYPE_TEXT

Currency 
Exchange Date

AMT_DT DTYPE_DATE

Deduction 
Amount

Parent 
Paymen
t

REQUEST_AMT DTYPE_CURREN
CY

Deduction Date Parent 
Paymen
t

PERFORM_DT DTYPE_DATE

Deduction Debit 
Memo Number

Parent 
Paymen
t

PAYMENT_NUM DTYPE_TEXT

Table 30. Fields

Name Calculated Value Join Column Type
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Pick Lists
■ CPG Checkbook Payment Allocation PickList (New)

■ Business Component: CG MDF Promotion Allocation - Pick

Deduction 
Reason

Parent 
Paymen
t

REASON_CD DTYPE_TEXT

Deduction Status Parent 
Paymen
t

PAY_STAT_CD DTYPE_TEXT

Deduction Type Parent 
Paymen
t

REASON_TYPE_C
D

DTYPE_TEXT

Deduction or 
Checkbook 
Account Id

Parent 
Paymen
t

ACCNT_ID DTYPE_ID

Fund Allocation 
Id

CG_MDF_ALLOC
_ID

DTYPE_ID

Parent Payment 
Id

PAR_PAYMENT_I
D

DTYPE_ID

Parent Payment 
Type

Parent 
Paymen
t

PAY_TYPE_CD DTYPE_TEXT

Payment Id ROW_ID DTYPE_ID

Payment Reason 
Type

REASON_TYPE_C
D

DTYPE_TEXT

Payment Status PAY_STAT_CD DTYPE_TEXT

Resolution 
Created Date

CREATED DTYPE_UTCDATE
TIME

Resolution Type TYPE_CD DTYPE_TEXT

Root Deduction 
Id

Parent 
Paymen
t

PAR_PAYMENT_I
D

DTYPE_ID

Trade Funds 
Amount

CG_TRADE_FUN
D_TOT

DTYPE_CURREN
CY

Write-off Amount CG_GL_TOT DTYPE_CURREN
CY

Table 30. Fields

Name Calculated Value Join Column Type
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■ Search Specification:[Promotion Status] = LookupValue("CAMPAIGN_STATE", "Finalized")

■ CPG Deduction Allocation PickList (Modified)

■ Add Search Specification: [Promotion Status] = LookupValue("CAMPAIGN_STATE", 
"Finalized")

■ PickList Deduction and Payment Status (New)

■ Business Component: PickList Generic

■ Search Specification:[Order By] = 201 or [Order By] = 203 or [Order By] = 401 or [Order 
By] = 402 or [Order By] = 403 or [Order By] = 204 or [Order By] = 207

■ Type Field:Type

■ Type Value: FUNDRQ_STATUS

Links
■ CG Split Deduction/CPG Deduction Child Payments (New)

■ Parent Business Component:CG Split Deduction

■ Child Business Component:CPG Deduction Child Payments

■ Source Field: Id

■ Destination Field:Parent Payment Id

■ Search Specification: 

❏ [Payment Status] = LookupValue("FUNDRQ_STATUS","Submitted") 

or

❏ [Payment Status] = LookupValue("FUNDRQ_STATUS","Paid")

■ CS CG Deduction and Payment/CPG Deduction Child Payments (New)

■ Parent Business Component: CS CG Deduction and Payment

■ Child Business Component:CPG Deduction Child Payments

■ Source Field: Id

■ Destination Field: Parent Payment Id

■ Search Specification: [Payment Status] <> LookupValue("FUNDRQ_STATUS","Inactive") 

■ CS CG Deduction and Payment/CG Split Deduction (New)

■ Parent Business Component: CS CG Deduction and Payment

■ Child Business Component: CG Split Deduction

■ Source Field: Id

■ Destination Field: Parent Payment Id

■ Search Specification: 
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❏ [Payment Status] = LookupValue("FUNDRQ_STATUS","Submitted") 

or 

❏ Payment Status] = LookupValue("FUNDRQ_STATUS","Paid")

Business Objects
■ CS CG Payment (New)

■ Primary Business Component: CS CG Resolution and Payment

■ Business Component: 

❏ CS CG Deduction and Payment

❏ CS CG Resolution and Payment

❏ CPG Check Payment

Integration Objects
■ CSIntegSEBLSIADeductionInterface (New)

■ Base Object Type: XML

■ External Name: CS CG Payment

■ XML Tag: ListOfCsintegseblsiadeductioninterface

■ Integration Component: CS CG Deduction and Payment

Table 31. Integration Component Field

Name
External 
Data Type

External 
Length

External 
Required

XML 
Style XML Tag

Account DTYPE_TEXT 100 N Element Account

Account Id DTYPE_ID Y Element AccountId

Currency Code DTYPE_TEXT 20 N Element CurrencyCode

Currency Exchange Date DTYPE_DATE N Element CurrencyExchan
geDate

Debit Memo Number DTYPE_TEXT 30 N Element DebitMemoNumb
er

Deduction Amount DTYPE_CURR
ENCY

Y Element DeductionAmoun
t

Deduction Date DTYPE_DATE N Element DeductionDate

Deduction Reason Code DTYPE_TEXT 30 N DeductionReaso
nCode

Deduction Status Date DTYPE_DATE N Element DeductionStatus
Date
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■ Integration Component: Fault

■ Parent Integration Component: CS CG Deduction and Payment

■ Integration Component Field: faultText

■ Integration Object User Prop:

■ Name: AllLangIndependentVals

■ Value: N

■ Name: XMLTagNamespace

■ Value: http://www.siebel.com/xml/CSIntegSEBLSIADeductionInterface

■ Name: XSDTypeNamespace

■ Value: http://www.siebel.com/xml/CSIntegSEBLSIADeductionInterface

■ Internal CSIntegSEBLSIADeductionInterface (New)

■ Base Object Type: Siebel Business Object

■ External Name: CS CG Payment

■ XML Tag: ListOfCsintegseblsiadeductioninterface

■ Integration Component: CS CG Deduction and Payment

■ Integration Component Field: Same as Integration Object 
CSIntegSEBLSIADeductionInterface

■ Integration Object User Prop:

❏ Name: AllLangIndependentVals

❏ Value: Y

❏ Name: XMLTagNamespace

Id N Element Id

Integration Id DTYPE_ID N Element IntegrationId

Parent Payment Id DTYPE_ID N Element ParentPaymentI
d

Payment Status DTYPE_TEXT 30 N Element PaymentStatus

Payment Type DTYPE_ID N Element PaymentType

operation N Attribut
e

operation

searchspec N Attribut
e

searchspec

Table 31. Integration Component Field

Name
External 
Data Type

External 
Length

External 
Required

XML 
Style XML Tag
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❏ Value: http://www.siebel.com/xml/CSIntegSEBLSIADeductionInterface

❏ Name: XSDTypeNamespace

❏ Value: http://www.siebel.com/xml/CSIntegSEBLSIADeductionInterface

■ CSIntegSEBLSIAPaymentInterface (New)

■ Base Object Type: XML

■ External Name: CS CG Payment

■ XML Tag: ListOfCsintegseblsiapaymentinterface

■ Integration Component: CS CG Resolution and Payment

Integration Component Fields

Table 32. Integration Component Fields

Name
External 
Data Type

External 
Length

External 
Required XML Style XML Tag

Account Credit 
Memo Account Id

DTYPE_ID N Element AccountCreditMemo
AccountId

Account Credit 
Memo Amount

DTYPE_NU
MBER

N Element AccountCreditMemo
Amount

Account Credit 
Memo Date

DTYPE_DA
TE

N Element AccountCreditMemo
Date

Account Credit 
Memo Payment 
Type

DTYPE_TEX
T

30 N Element AccountCreditMemo
PaymentType

Calc Account Id DTYPE_ID N Element CalcAccountId

Calc Amount DTYPE_CU
RRENCY

N Element CalcAmount

Calc Deduction 
Date

DTYPE_TEX
T

N Element CalcDeductionDate

Calc Deduction Id DTYPE_ID N Element CalcDeductionId

Calc Payment 
Method Type

DTYPE_TEX
T

30 N Element CalcPaymentMetho
dType

Calc Resolution 
Amount

DTYPE_CU
RRENCY

N Element CalcResolutionAmo
unt

Calc Resolution 
Type

DTYPE_TEX
T

N Element CalcResolutionType

Chargeback 
Amount

DTYPE_CU
RRENCY

N Element ChargebackAmount
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Credit Memo 
Amount

DTYPE_CU
RRENCY

N Element CreditMemoAmount

Credit Memo Id DTYPE_ID N Element CreditMemoId

Currency Code DTYPE_TEX
T

20 N Element CurrencyCode

Currency 
Exchange Date

DTYPE_DA
TE

N Element CurrencyExchangeD
ate

Deduction 
Amount

DTYPE_CU
RRENCY

N Element DeductionAmount

Deduction Date DTYPE_DA
TE

N Element DeductionDate

Deduction Debit 
Memo Number

DTYPE_TEX
T

50 N Element DeductionDebitMem
oNumber

Deduction Reason DTYPE_TEX
T

30 N Element DeductionReason

Deduction Status DTYPE_TEX
T

30 N Element DeductionStatus

Deduction Type DTYPE_TEX
T

30 N Element DeductionType

Deduction or 
Checkbook 
Account Id

DTYPE_ID N Element DeductionorCheckb
ookAccountId

Fund Allocation Id DTYPE_ID N Element FundAllocationId

Id N Element Id

Parent Payment 
Id

DTYPE_ID N Element ParentPaymentId

Parent Payment 
Type

DTYPE_TEX
T

30 N Element ParentPaymentType

Payment Id DTYPE_ID N Element PaymentId

Payment Reason 
Type

DTYPE_TEX
T

30 N Element PaymentReasonTyp
e

Payment Status DTYPE_TEX
T

30 N Element PaymentStatus

Resolution 
Created Date

DTYPE_UT
CDATETIM
E

N Element ResolutionCreatedD
ate

Table 32. Integration Component Fields

Name
External 
Data Type

External 
Length

External 
Required XML Style XML Tag
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■ Integration Component: faultMessage

■ Parent Integration Component: CS CG Resolution and Payment

Integration Component Fields

■ Integration Component: errorMessage

Resolution Type DTYPE_TEX
T

30 N Element ResolutionType

Root Deduction Id DTYPE_ID N Element RootDeductionId

Trade Funds 
Amount

DTYPE_CU
RRENCY

N Element TradeFundsAmount

Write-off Amount DTYPE_CU
RRENCY

N Element Write-offAmount

operation N Attribute operation

searchspec N Attribute searchspec

Table 33. Integration Component Field

Name
External 
Data Type

External 
Length

External 
Required

XML 
Style XML Tag

faultText DTYPE_TEXT 20,240 N Element faultText

flowContext DTYPE_TEXT 512 N Element flowContext

flowName DTYPE_TEXT 128 N Element flowName

lang DTYPE_TEXT 20 N Element lang

processCallSt
ack

DTYPE_TEXT 1,024 N Element processCallStack

processName DTYPE_TEXT 128 N Element processName

severity DTYPE_INTE
GER

1 N Element severity

type DTYPE_TEXT 128 N Element type

Table 32. Integration Component Fields

Name
External 
Data Type

External 
Length

External 
Required XML Style XML Tag
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■ Parent Integration Component: faultMessage

Integration Component Fields

■ Integration Object User Prop

■ Name: AllLangIndependentVals

■ Value: N

■ Name: XMLTagNamespace

■ Value: http://www.siebel.com/xml/CSIntegSEBLSIAPaymentInterface

■ Name: XSDTypeNamespace

■ Value http://www.siebel.com/xml/CSIntegSEBLSIAPaymentInterface

■ Internal CSIntegSEBLSIAPaymentInterface (New)

■ Base Object Type: Siebel Business Object

■ External Name: CS CG Payment

■ XML Tag: ListOfCsintegseblsiapaymentinterface

■ Integration Component: CS CG Resolution and Payment

■ Integration Component Field: Same as Integration Object CSIntegSEBLSIAPaymentInterface

Table 34. Integration Component Field

Name
External 
Data Type

External 
Length

External 
Required XML Style XML Tag

appInstance DTYPE_TEXT 30 N Element appInstance

appType DTYPE_TEXT 30 N Element appType

argument1 DTYPE_TEXT 512 N Element argument1

argument2 DTYPE_TEXT 512 N Element argument2

argument3 DTYPE_TEXT 512 N Element argument3

argument4 DTYPE_TEXT 512 N Element argument4

argument5 DTYPE_TEXT 512 N Element argument5

argument6 DTYPE_TEXT 512 N Element argument6

argument7 DTYPE_TEXT 512 N Element argument7

argument8 DTYPE_TEXT 512 N Element argument8

argument9 DTYPE_TEXT 512 N Element argument9

code DTYPE_TEXT 30 N Element code

lang DTYPE_TEXT 30 N Element lang

text DTYPE_TEXT 20,240 N Element text
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■ Integration Object User Prop:

❏ Name: AllLangIndependentVals

❏ Value: Y

❏ Name: XMLTagNamespace

❏ Value: http://www.siebel.com/xml/CSIntegSEBLSIAPaymentInterface

❏ Name: XSDTypeNamespace

❏ Value http://www.siebel.com/xml/CSIntegSEBLSIAPaymentInterface

Business Services
■ CRMIntegUpsertDeductionSEBL80ToEBS11i10Sync (New)

■ Class:CSSWSOutboundDispatcher

■ Display Name String Reference: SBL_CS_RESOLUTION_PAYMENT_OUTBOUND

■ State Management Type: Stateful

■ Business Server Method: process

■ Business Service User Property

■ Name: siebel_port_name

■ Value: CRMIntegUpsertDeductionSEBL80ToEBS11i10SyncPort

■ Name: siebel_web_service_name

■ Value: CRMIntegUpsertDeductionSEBL80ToEBS11i10Sync

Table 35. Business Service Method Arg

Name Data Type 
Integration 
Object Type

Storage 
Type

CRMIntegUpsertDeductionSEBL8
0ToEBS11i10SyncRequestMessa
ge:payload

Integration 
Object

CSIntegSEBLSIA

PaymentInterface

Input Hierarchy

CRMIntegUpsertDeductionSEBL8
0ToEBS11i10SyncResponseMess
age:payload

Integration 
Object

CSIntegSEBLSIA

PaymentInterface

Output Hierarchy

CustomHeaderContext Hierarchy Input / 
Output

Hierarchy

XMLHierarchyOutput Hierarchy Output Hierarchy

faultactor String Output Property

faultcode String Output Property

faultstring String Output Property
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■ Name: siebel_web_service_namespace

■ Value: http://xmlns.oracle.com/CRMIntegUpsertDeductionSEBL80ToEBS11i10Sync

■ CSIntegSEBLSIADeductionAndPayment (New)

■ Class:CSSEAIDataSyncService

■ Display Name String Reference: SBL_CS_DEDUCTION_PAYMENT_INBOUND

■ State Management Type: Stateful

■ Business Server Method: Delete

■ Business Server Method: Insert

■ Business Server Method: InsertOrUpdate

Table 36. Business Service Method Arg

Name Data Type 
Integration 
Object Type Storage Type

SiebelMessage Integration 
Object

CSIntegSEBLSIADe
ductionInterface

Input / 
Output

Hierarchy

StatusObject String Input Property

Table 37. Business Service Method Arg

Name Data Type 
Integration 
Object Type Storage Type

SiebelMess
age

Integration 
Object

CSIntegSEBLSIADe
ductionInterface

Input / 
Output

Hierarchy

StatusObje
ct

String Input Property

Table 38. Business Service Method Arg

Name Data Type Integration Object Type
Storage 
Type

SiebelMessage Integration 
Object

CSIntegSEBLSIADeduction
Interface

Input / Output Hierarchy

StatusObject String Input Property
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■ Business Server Method: QueryByExample

■ Business Server Method: QueryById

■ Business Server Method: Synchronize

■ Business Server Method: Update

Table 39. Business Service Method Arg

Name Data Type 
Integration 
Object Type Storage Type

SiebelMessage Integration 
Object

CSIntegSEBLSIA
DeductionInterfa
ce

Input / Output Hierarchy

Table 40. Business Service Method Arg

Name Data Type 
Integration 
Object Type

Storage 
Type

PrimaryRowId String Input Property

SiebelMessage Integration 
Object

CSIntegSEBLSIA
DeductionInterfa
ce

Input / Output Hierarchy

Table 41. Business Service Method Arg

Name Data Type 
Integration 
Object Type

Storage 
Type

SiebelMessage Integration 
Object

CSIntegSEBLSIA
DeductionInterfa
ce

Input / Output Hierarchy

StatusObject String Input Property

Table 42. Business Service Method Arg

Name Data Type 
Integration 
Object Type

Storage 
Type

SiebelMessage Integration 
Object

CSIntegSEBLSIA
DeductionInterfa
ce

Input / Output Hierarchy

StatusObject String Input Property



Siebel CRM Integration Pack for Trade Promotion Management 
Implementation Guide Version 1.00

Installation and Configuration ■ Configuring the Siebel Trade Promotion Management 
Environment

100 

■ Business Service User Prop:

■ Name: Application Services Interface

■ Value: Y

■ Name: Internal Integration Object

■ Value: Internal CSIntegSEBLSIADeductionInterface

■ CSIntegSEBLSIAResolutionAndPayment (New)

■ Class: CSSEAIDataSyncService

■ Display Name String Reference: SBL_CS_RESOLUTION_PAYMENT_INBOUND

■ State Management Type: Stateful

■ Business Server Method: Delete

■ Business Server Method: Insert

■ Business Server Method: InsertOrUpdate

Table 43. Business Service Method Arg

Name Data Type 
Integration 
Object Type

Storage 
Type

SiebelMessage Integration 
Object

CSIntegSEBLSIA
PaymentInterfac
e

Input / Output Hierarchy

StatusObject String Input Property

Table 44. Business Service Method Arg

Name Data Type Integration Object Type
Storage 
Type

SiebelMessage Integration 
Object

CSIntegSEBLSIAPayment
Interface

Input / Output Hierarchy

StatusObject String Input Property

Table 45. Business Service Method Arg

Name Data Type Integration Object Type
Storage 
Type

SiebelMessage Integration 
Object

CSIntegSEBLSIAPayment
Interface

Input / Output Hierarchy

StatusObject String Input Property
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■ Business Server Method: QueryByExample

■ Business Server Method: QueryById

■ Business Server Method: Synchronize

■ Business Server Method: Update

■ Business Service User Prop:

Table 46. Business Service Method Arg

Name Data Type 
Integration 
Object Type Storage Type

SiebelMessage Integration 
Object

CSIntegSEBLSIA
PaymentInterfac
e

Input / Output Hierarchy

Table 47. Business Service Method Arg

Name Data Type Integration Object Type
Storage 
Type

PrimaryRowId String Input Property

SiebelMessage Integration 
Object

CSIntegSEBLSIAPayment
Interface

Input / Output Hierarchy

Table 48. Business Service Method Arg

Name Data Type Integration Object Type
Storage 
Type

SiebelMessage Integration 
Object

CSIntegSEBLSIAPayment
Interface

Input / Output Hierarchy

StatusObject String Input Property

Table 49. Business Service Method Arg

Name Data Type Integration Object Type
Storage 
Type

SiebelMessage Integration 
Object

CSIntegSEBLSIAPayment
Interface

Input / Output Hierarchy

StatusObject String Input Property
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■ Name: Application Services Interface

■ Value: Y

■ Name: Internal Integration Object

■ Value: Internal CSIntegSEBLSIAPaymentInterface

Applets
■ CG Deduction Admin List Applet (SCW) (Modified)

■ Set "Read Only" = Y for Column "Deduction Amount"

■ Set "Read Only" = Y for Column "Account"

■ Set "No Delete" = Y

■ Remove Applet Web Template Item "DeleteRecord" from Applet Web Template - Edit List

■ CG Deduction Details Form Admin Applet (SCW) (Modified)

■ Set "Read Only" = Y for Control "DeductionAmount"

■ Set "Read Only" = Y for Control "Account"

■ Set "No Delete" = Y

■ Remove Applet Web Template Item "DeleteRecord" from Applet Web Template - Edit

■ CG Deduction Details Form Applet (SCW) (Modified)

■ Set "Read Only" = Y for Control "Account"

■ CG Deduction List Applet (SCW) (Modified)

■ Set "Read Only" = Y for Column "Account"

■ CG Deduction Parent Split Applet (Modified)

■ Set "Read Only" = Y for Column "Deduction Amount"

■ Set "Read Only" = Y for Column "Account"

■ Set "No Delete" = Y

■ Remove Applet Web Template Item "DeleteRecord" from Applet Web Template - Edit List

■ CG Deduction Split Form Applet (Modified)

■ Set "Read Only" = Y for Control "Account"

■ CG Deduction Split List Applet (Modified)

■ Set "Read Only" = Y for Column "Account"

■ CPG Account Credit Memo Admin Form Applet (Modified)

■ Set "No Delete" = Y 

■ Set "No Update" = Y 

■ CPG Account Credit Memo Admin List Applet (Modified)
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■ Set "No Delete" = Y 

■ Set "No Update" = Y 

Enter the following seed data by Siebel Client:

Workflow Deployment

To deploy workflows

1 Log in to Siebel Tools and navigate to Workflows.

2 Right click and select the Import workflow process.

3 Give the above listed workflow "CSIntegSEBLSIAPaymentInsertOuboundFlow.xml" and select the 
Project as CS CG Deduction Interface and click OK.

4 Query for the workflow and deploy it by clicking Publish/Activate on the WF/Task Editor Toolbar.

Enable the toolbar by selecting View > Toolbars > WF/Task Editor Toolbar.

5 Login to the Siebel UI and navigate to Administration > Business Processes > Workflow 
Deployment.

6 Query for the Workflow deployed and click Activate.

Web Service Deployment

To deploy Web Services

1 Log in to Siebel UI and navigate to Administration > Web Services > Inbound Web Services.

2 Click Import and specify the following Web Services to be imported:

■ CSIntegSEBLSIADeductionAndPayment_InboundWS.XML

■ CSIntegSEBLSIAResolutionAndPayment_InboundWS.XML

3 After the inbound Web Service is imported, validate the address of the Siebel server in the 
Service Ports applet.

The address must be the correct Siebel server name that the client must connect to. If required, 
change the address and provide a valid username and password. 

Inbound Web Service is created as follows:

■ Name: CSIntegSEBLSIADeductionAndPayment
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■ Namespace: http://siebel.com/asi/

Service Port

Operations

4 Click Clear Cache.

Inbound Web Service is created as follows:

■ Name: CSIntegSEBLSIAResolutionAndPayment 

Name Type

Business 
Service/
Process Transport Address Binding

Default Business 
Service

Deduction 
and Payment 
- Siebel 
Inbound 

HTTP http://<webserver>/
eai_<lang>/
start.swe?SWEExtSource=Sec
ureWebService&SWEExtCmd=
Execute&UserName=<UserNa
me>&Password=<Password>

SOAP_RP
C_LITERA
L

Name
Method Display 
Name

Authentication 
Type

SiebelDeductionPaymentInsert Insert None

SiebelDeductionPaymentInsertOrUpdate Insert or Update None

SiebelDeductionPaymentQueryById Query by ID None

SiebelDeductionPaymentSynchronize Synchronize None

SiebelDeductionPaymentUpdate Update None
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■ Namespace: http://siebel.com/asi/

Service Port

Operations

5 Navigate to Administration > Web Services > Outbound Web Services.

6 Click Import and specify the Web Service 
"CRMIntegUpsertDeductionSEBL80ToEBS11i10Sync.xml" to be imported.

Outbound Web Service: CRMIntegUpsertDeductionSEBL80ToEBS11i10Sync.xml

7 After the outbound Web Service is imported, validate the address of the BPEL server in the 
Service Ports applet.

The address must be the correct BPEL server that the client must connect to. If required, change 
the address and save. 

The outbound Web Service is created as follows:

■ Name: CRMIntegUpsertDeductionSEBL80ToEBS11i10Sync 

Name Type

Business 
Service/
Process Transport Address Binding

Default Business 
Service

Resolutio
n and 
Payment - 
Siebel 
Inbound

HTTP http://<webserver>/
eai_<lang>/
start.swe?SWEExtSource=
SecureWebService&SWEE
xtCmd=Execute&UserNam
e=<UserName>&Passwor
d=<Password>

SOAP_RPC_LITE
RAL

Name
Method Display 
Name

Authentication 
Type

SiebelPaymentQueryById Query by ID None
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■ Namespace: http://xmlns.oracle.com/CRMIntegUpsertDeductionSEBL80ToEBS11i10Sync 

Service Port

Operations

8 Click Clear Cache.

State Model

To manage states

1 Log in to Siebel UI and navigate to Administration > Application > State Model.

2 Click New to create a new state model:

■ Name: CS CG Deduction and Payment Status

■ Business Component: CS CG Deduction and Payment

■ Field: Payment Status

3 Click the State tab to create the following states:

Name

Service 
Display 
Name Transport Address Binding

CRMIntegUps
ertDeduction
SEBL80ToEBS
11i10SyncPor
t

Resolution 
and 
Payment - 
Siebel 
Outbound

HTTP http://<host-info>/orabpel/
default/
CRMIntegUpsertDeductionSEB
L80ToEBS11i10Sync/1.0

SOAP_DOC_LITE
RAL

Method Display Name Authentication Type

Process None

State 
Name Default No Delete

No 
Update

Restrict 
Transition Description

Closed N N N Y Closed

In Progress N N N Y In Progress

Inactive N N N Y Inactive

Open Y N N Y Open

Resolved N N N Y Resolved

Submitted N N N Y Submitted
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4 Click the Transitions tab to create the following transactions:

Leave other columns empty. 

5 Restart the Siebel Server.

Setting Up Promotions

Repository changes for Promotions

To import Siebel Artifacts

1 Log into Siebel 8.0 Tools and lock the following projects:

From State To State Public Rule Expression

In Progress Inactive Y [Deduction Status 
Read Only Flag] = "N"

In Progress Open Y [Deduction Status 
Read Only Flag] = "N"

Inactive Open Y [Deduction Status 
Read Only Flag] = "N"

Open Inactive Y [Deduction Status 
Read Only Flag] = "N"

Resolved Open Y [Deduction Status 
Read Only Flag] = "N"

Resolved Closed Y

Resolved Inactive Y [Deduction Status 
Read Only Flag] = "N"

Submitted Closed Y

New/Modified Project Description

Modified CPG Plan Holds Promotion Integration related objects. Changed 
BO, New Int Objects, New Bus Comps. New Links

Modified CPG Promotion None

Modified CPG Promotion 
Product

None

Modified CS CG Promotion 
Category

None

Modified Symbolic Strings None
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2 Import the ACR358_Promotions.sif file from the Siebel Quick Fix build, which contains new and 
modified repository objects. 

The following table contains the description of changes for each repository object:

Symbolic Strings

Name Current String Value Definition

SBL_CG_INTEG_PROMOTI
ON_UPSERT_SERVICE_OU
TBOUND

CGIntegPromotionUpse
rtService - Siebel 
Outbound

Siebel Bus Service created while 
importing BPEL Process, used to 
invoke the process

SBL_CG_PROMOTION_UPS
ERT_SERICE_OUTBOUND

CGPromotionUpsertSer
vice - Siebel Outbound

Siebel Bus Service to QueryById to 
create input for Outbound BPEL Web 
Service

SBL_CG_PROMO_PRODUC
T_UPDATE_SERVICE

CGPromoProductUpdat
eService - Siebel 
Inbound

Siebel Inbound Service for Promoted 
Product
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Business Components
■ Name: CPG Plan Account Promotion (Modified)

Table 50. Fields

New? Name Description Comments

Modified Calculated Field 
Read Only Flag

[Field Read Only Flag] Value changed from 
IIf([Phasing Enable Flag]= 
'N', 'N', [Field Read Only 
Flag]).

Modified Delete Flag NOT [Read Only Flag] Value changed from 
IIf([Phasing Enable 
Flag]='N', 'Y', [Phasing 
Delete Flag]

Modified End Date Promo 
for Acct

Changed Type to 
DTYPE_UTCDATETIME

Changed from DTYPE_DATE

Modified Field Read Only 
Flag

[Field Read Only Flag 
Calculated]

None

Modified Start Date Promo 
for Acct

Changed Type to 
DTYPE_UTCDATETIME

Changed from DTYPE_DATE

Table 51. BC User properties

New? Name Value

New Field Read Only Field: Account Read Only Flag

New Field Read Only Field: End Date Cons 
for Acct

Read Only Flag

New Field Read Only Field: End Date 
Shipments for Acct

Read Only Flag

New Field Read Only Field: Organization 
Name

Read Only Flag

New Field Read Only Field: Period Name Read Only Flag

New Field Read Only Field: Plan Account 
Promotion Name

Read Only Flag

New Field Read Only Field: Start Date Cons 
for Acct

Read Only Flag

New Field Read Only Field: Start Date 
Promo for Acct

Read Only Flag

New Field Read Only Field: Start Date 
Shipments for Acct

Calculated Field 
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New Named Method 1 "InvokeWF", "INVOKE", 
"CPG Plan Account 
Promotion", "WriteRecord"

New Named Method 2 "InvokeWF", "INVOKESVC", 
"CPG Plan Account 
Promotion", "Workflow 
Process Manager", 
"RunProcess", 
"'ProcessName'", 
"'CGIntegSEBLPromotionUp
sertOutboundFlow'", 
"'Object Id'", "[Id]"

New Named Method 3 "Commit", "INVOKE", "CPG 
Plan Account Promotion", 
"WriteRecord"

New Named Method 4 "Commit", "INVOKESVC", 
"CPG Plan Account 
Promotion", "Workflow 
Process Manager", 
"RunProcess", 
"'ProcessName'", 
"'CGIntegSEBLPromotionUp
sertOutboundFlow'", 
"'Object Id'", "[Id]"

New On Field Update Invoke 1 "Account Promotion 
Status", "CPG Plan Account 
Promotion", "InvokeWF", 
"[Account Promotion 
Status]=LookupValue(""CA
MPAIGN_STATE"", 
""Finalized"")"

New On Field Update Invoke 3 "End Date Promo for Acct", 
"CPG Plan Account 
Promotion", "Commit", 
"[Account Promotion 
Status]=LookupValue(""CA
MPAIGN_STATE"", 
""Finalized"")"

Table 51. BC User properties

New? Name Value
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■ Name: CPG Plan Account Promotion Product (Modified)

Table 52. Fields

New? Name Description Comments

Modified Delete 
Flag

NOT [Read Only Flag] Changed from [Read Only 
Flag] = "N".

New No 
Insert 
Flag

[Account Promotion Status] = 
LookupValue("CAMPAIGN_STATE", 
"Finalized") OR [Account Promotion 
Status] = 
LookupValue("CAMPAIGN_STATE", 
"Re-opened")

None

Modified Read 
Only 
Flag

IIf((([IsProductFinalized] = "Y" AND 
[IsPromotionFinalized] = "Y") OR 
[Account Promotion Status] = 
LookupValue("CAMPAIGN_STATE", 
"Re-opened")), "Y", "N")

Changed from value 
changed, Phasing Enable 
flag condition removed

Modified Unit of 
Measure

Made Active Was inactive, activated.

Table 53. BC User properties

New? Name Value Description

Modified BC No Insert 
Field

No Insert Flag Changed from Read Only Flag
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■ Name: CS CG MDF Promotion Category Allocation (Modified)

Table 54. Fields

New? Name Description Comments

Modified Account 
Promotion 
Status

Pre-default added:

Parent: 'CS CG Plan Account 
Promotion Category.Account 
Promotion Status' and Immediate 
Post Change =True

None

Modified Amount Field 
Read Only 
Flag

IIf(([Deal Category Type] = 
LookupValue("MDF_ALLOC_CATEG
ORIZATION_TYPE", "Fixed") AND 
[Account Promotion Status] <> 
LookupValue("CAMPAIGN_STATE",
"Finalized")), 'N', 'Y')

Value changed from IIf([Deal 
Category Type] = 
LookupValue("MDF_ALLOC_C
ATEGORIZATION_TYPE", 
"Fixed"), 'N', 'Y')

Modified IsSubmitted
OrPaidPaym
ents

[IIf((([Payments Sub] IS NOT 
NULL AND [Payments Sub] <> 
0.0) OR ([Payments Paid] IS NOT 
NULL AND [Payments Paid] <> 
0.0) OR [Read Only Flag] = 'Y'), 
"Y", "N")

Value changed from 
IIf(([Payments Sub] IS NOT 
NULL AND [Payments Sub] 
<> 0.0) OR ([Payments Paid] 
IS NOT NULL AND [Payments 
Paid] <> 0.0), "Y", "N")

Modified No Insert 
Flag

[Row Id] IS NOT NULL To disable New when 
Promotion is Accepted, since 
Deal gets committed. If 
Insert allowed these new 
deals can never be committed 
[Account Promotion Status] = 
LookupValue("CAMPAIGN_ST
ATE", "Accepted") OR 
[Account Promotion Status] = 
LookupValue("CAMPAIGN_ST
ATE", "Finalized") OR 
[Account Promotion Status] = 
LookupValue("CAMPAIGN_ST
ATE", "Re-opened")

New PriceAdjType
Amount 
Read Only

[Account Promotion Status] = 
LookupValue("CAMPAIGN_STATE", 
"Finalized") OR [Account 
Promotion Status] = 
LookupValue("CAMPAIGN_STATE", 
"Re-opened")

New validation
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Modified Rate Volume 
Field Read 
Only Flag

IIf((([Deal Category Type] = 
LookupValue("MDF_ALLOC_CATEG
ORIZATION_TYPE", "Deferred") or 
[Deal Category Type] = 
LookupValue("MDF_ALLOC_CATEG
ORIZATION_TYPE", "On Invoice")) 
AND [Read Only Flag] <> 'Y'), "N", 
"Y")

Value changed from IIf([Deal 
Category Type] = 
LookupValue("MDF_ALLOC_C
ATEGORIZATION_TYPE", 
"Deferred") or [Deal Category 
Type] = 
LookupValue("MDF_ALLOC_C
ATEGORIZATION_TYPE", "On 
Invoice"), "N", "Y")

Modified Read Only 
Flag

[Account Promotion Status] = 
LookupValue("CAMPAIGN_STATE", 
"Finalized")

Value changed from [Account 
Promotion Status] = 
LookupValue("CAMPAIGN_ST
ATE", "Finalized") AND 
[Promotion Phasing Enable 
Flag] = "Y"; Phasing condn 
removed

New Row Id Mapped to Column ROW_ID Used in Field No Insert Flag.

Table 55. BC User Properties

New? Name Value Description

Modified BC No Insert Field No Insert Flag Changed from Read 
Only Flag

Modified BC Read Only Field Read Only Flag Inactivated

New Field Read Only Field: Price 
Adjustment Amount

PriceAdjTypeAmou
nt Read Only

None

New Field Read Only Field: Price 
Adjustment Type

PriceAdjTypeAmou
nt Read Only

None

Table 54. Fields

New? Name Description Comments
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■ Name: CS CG Plan Account Promotion Category (Modified)

Table 56. Fields

New? Name Description Comments

Modified Delete 
Flag

IIf (([Read Only Flag] = 'Y' OR [Account 
Promotion Status] = 
LookupValue("CAMPAIGN_STATE", "Re-
opened") OR [Account Promotion Status] = 
LookupValue("CAMPAIGN_STATE", 
"Accepted")), "N", "Y")

Value changed from 
IIf([Promotion Phasing 
Enable Flag]='N', 'Y', 
[Phasing Delete Flag])

New No Insert 
Flag

[Account Promotion Status] = 
LookupValue("CAMPAIGN_STATE", 
"Accepted") OR [Account Promotion Status] 
= LookupValue("CAMPAIGN_STATE", 
"Finalized") OR [Account Promotion Status] 
= LookupValue("CAMPAIGN_STATE", "Re-
opened")

New field for No Insert 
for Promoted Category

Modified Read Only 
Flag

IIf ([IsCategoryFinalized] = "Y" AND 
[IsPromotionFinalized] = "Y", "Y", "N")

Value changed from IIf 
([IsCategoryFinalized] 
= "Y" AND 
[IsPromotionFinalized] 
= "Y" AND [Promotion 
Phasing Enable Flag] = 
"Y", "Y", "N").

Table 57. BC User Properties

New? Name Value Description

Modified BC No Insert Field No Insert Flag Value changed 
from Read Only 
Flag

Modified BC Read Only Field Read Only Flag Inactivated

New Field Read Only Field:% 
Promoted ACV

Period Read Only Field None

New Field Read Only Field: 
Category Name

Read Only Flag None

New Field Read Only Field: End 
Date Promo for Acct

Read Only Flag None
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■ Name: ExtIntegCG MDF Promotion Category Allocation (New)

MDF Promotion Category Allocation

New Field Read Only Field: Period 
Name

Read Only Flag None

New Field Read Only Field: Start 
Date Promo for Acct

Read Only Flag None

Table 58. Fields

Name
Pre-default 
Value Join Column Picklist Comments

Promotion 
Name

Fund 
Promotion

NAME None

Account Type S_ORG_EXT OU_TYPE_C
D

PickList 
Account Type

Pick Map: Field 
and value

Organization 
Id

System: 
Organization
Id

Fund 
Promotion

BU_ID None

Organization 
Name

System: 
Organization
Name

S_BU NAME PickList 
Internal 
Division - CPG

Pick Map same 
as in Account 
Promotion BC

Start Date 
Promo for Acct

Fund 
Promotion

PROG_STAR
T_DT

None

End Date 
Promo for Acct

Fund 
Promotion

PROG_END_
DT

None

Period Id ROW_ID None

Price List Id Fund 
Promotion

PROMO_PRI
_LST_ID

None

Price List S_PRI_LST NAME CPG PickList 
Price List

Pick Map same 
as in Promotion 
BC

Start Date 
Shipments for 
Acct

Fund 
Promotion

SHIP_STAR
T_DT

None

End Date 
Shipments for 
Acct

Fund 
Promotion

SHIP_ENDD
T

None

Table 57. BC User Properties

New? Name Value Description
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■ Name: ExtIntegCPG Plan Account Promotion Product (New)

Account Promotion Product

■ Name: IntegCPG Plan Account Promotion Product (New)

Account Promotion Product

Links (New)
■ Name: CPG Plan Account Promotion/ExtIntegCG MDF Promotion Category Allocation

Table 59. Fields

New? Name Description Comments

Modified Unit of Measure Made Active None

Modified Period Id Column changed 
to ROW_ID

Id field is the system field and it does not 
gives a value to in the Int Object-> Int 
Component

Table 60. BC User properties

New? Name Value Description

Modified BC No Insert Field Read Only Flag Made inactive

Modified BC Read Only Field Read Only Flag Made inactive

New IsIntegPromoProductBC Y Used in code; to execute a portion 
of code only if the UP is present in 
the BC

Table 61. Link Spec

Parent Bus Comp Child Bus Comp Source Field
Destination 
Field

CPG Plan Account 
Promotion

ExtIntegCG MDF Promotion 
Category Allocation

Id Fund Promotion 
Id
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■ Name: CS CG Plan Account Promotion Category/IntegCPG Plan Account Promotion Product

■ Name: ExtIntegCG MDF Promotion Category Allocation/ExtIntegCPG Plan Account Promotion 
Product

Business Objects 
■ Name: CPG Plan (modified)

Table 62. Link Spec

Parent Bus Comp Child Bus Comp Source Field
Destination 
Field

CS CG Plan Account 
Promotion Category

IntegCPG Plan Account 
Promotion Product

Id Plan Account 
Promotion Cat Id

Table 63. Link Spec

Parent Bus Comp Child Bus Comp Source Field Destination Field

ExtIntegCG MDF 
Promotion Category 
Allocation

ExtIntegCPG Plan Account 
Promotion Product

Plan Account 
Promotion Cat Id

Plan Account 
Promotion Cat Id

Table 64. Business Object Components

New? Bus Comp Link Comments

New IntegCPG Plan Account 
Promotion Product

CS CG Plan Account Promotion 
Category/IntegCPG Plan Account 
Promotion Product

None

New ExtIntegCPG Plan Account 
Promotion Product

ExtIntegCG MDF Promotion 
Category Allocation/ExtIntegCPG 
Plan Account Promotion Product

None

New ExtIntegCG MDF Promotion 
Category Allocation

CPG Plan Account Promotion/
ExtIntegCG MDF Promotion 
Category Allocation

None
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■ Name: CPG Account Promotion (New)

Primary Business Component specified as 'CPG Plan Account Promotion'

Applets (Modified)
■ Name: CG Promotion List Applet Non-Corporate

Table 65. Business Object Components

New? Bus Comp Link Comments

New IntegCPG Plan Account 
Promotion Product

CS CG Plan Account Promotion 
Category/IntegCPG Plan Account 
Promotion Product

None

New ExtIntegCPG Plan Account 
Promotion Product

ExtIntegCG MDF Promotion 
Category Allocation/ExtIntegCPG 
Plan Account Promotion Product

None

New ExtIntegCG MDF Promotion 
Category Allocation

CPG Plan Account Promotion/
ExtIntegCG MDF Promotion 
Category Allocation

None

Modified CPG Plan Account Promotion CPG Plan Account/CPG Plan 
Account Promotion

Link is 
removed

Table 66. List Columns

New? Name Description Comments

Modified End Date Promo for Acct Display Format specified 
as Date

None

Modified Start Date Promo for 
Acct

Display Format specified 
as Date

None

Modified Phasing Enable Flag Display Name: Phasing 
Enable 

This is 
unmapped
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■ Name: CPG Plan Account Promotion Product List Applet

■ Name: CS CG Promoted Category Deal List Applet

■ Name: CS CG Promoted Category List Applet

Table 67. List Columns/Controls

New? Name Description Comments

Modified Promotion Phasing 
Enable Flag

Display Name: 
Phasing Enable 

This is unmapped

Modified PhaseProduct Display Name: 
Phase

This is a Button that is 
unmapped

Modified RecalcProduct Display Name: 
Recalculate

This is a Button that is 
unmapped

Table 68. Applet User Property

New? Name Value Comments

New CanInvokeMethod: 
DeleteRecord

[Delete Flag] To disable delete button when 
Promotion Finalized

Table 69. List Columns

New? Name Description Comments

Modified Promotion Phasing 
Enable Flag

Display Name: 
Phasing Enable 

This is unmapped

Table 70. List Columns/Controls

New? Name Description Comments

Modified Phasing Enable Flag Display Name: Phasing 
Enable 

This is unmapped

Modified Phasing Pattern Display Name: Phasing 
Pattern

This is unmapped

Modified Phasing Status Display Name: Phasing 
Status

This is unmapped
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Integration Objects
■ Name: InternalCGIntegSEBLPromoProductInterface (New)

■ Project: CPG Plan

■ Base Object Type: Siebel Business Object 

■ External Name: CPG Plan

■ XML Tag: ListOfInternalcgintegseblpromoproductinterface

Integration Components
■ Name & External Name: IntegCPG Plan Account Promotion Product

■ Parent Integration Component: None

■ XML Container Element: None

■ XML Tag: IntegCPG Plan Account Promotion Product

■ Cardinality: Zero or More

■ Name: CGIntegSEBLPromoProductInterface (New)

■ Project: CPG Plan

■ Base Object Type: XML

■ External Name: CPG Plan

■ XML Tag: ListOfInternalcgintegseblpromoproductinterface

Integration Components
■ Name & External Name: IntegCPG Plan Account Promotion Product

■ Parent Integration Component: None

■ XML Container Element: None

■ XML Tag: IntegCPG Plan Account Promotion Product

■ Cardinality: Zero or More

■ Name: CGIntegSEBLPromotionInterface (New)

■ Project: CPG Plan

■ Base Object Type: Siebel Business Object

Modified PhaseProduct Display Name: Phase This is a button that is 
unmapped.

Modified RecalcProduct Display Name: 
Recalculate

This is a button that is 
unmapped.

Table 70. List Columns/Controls

New? Name Description Comments
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■ External Name: CPG Plan

■ XML Tag: ListOfCgintegseblpromotioninterface

Integration Components
■ Name & External Name: ExtIntegCG MDF Promotion Category Allocation

■ Parent Integration Component: None

■ XML Container Element: None

■ XML Tag: ExtIntegCG MDF Promotion Category Allocation

■ Cardinality: Zero or One

■ Name & External Name: ExtIntegCPG Plan Account Promotion Product

■ Parent Integration Component: ExtIntegCG MDF Promotion Category Allocation 

■ XML Container Element: ListOfExtintegcpgPlanAccountPromotionProduct

■ XML Tag: ListOfExtintegcpgPlanAccountPromotionProduct

■ Cardinality: Zero or More

■ Name: CGIntegSEBLSIAPromotionFaultMessage (New)

■ Project: CPG Plan

■ Base Object Type: XML

■ External Name: CPG Plan

■ XML Tag: ListOfCgintegseblpromotioninterface

Integration Components
■ Name & External Name: ExtIntegCG MDF Promotion Category Allocation

■ Parent Integration Component: None

■ XML Container Element: None

■ XML Tag: ExtIntegCG MDF Promotion Category Allocation

■ Cardinality: Zero or One

■ Name & External Name: ExtIntegCPG Plan Account Promotion Product

■ Parent Integration Component: ExtIntegCG MDF Promotion Category Allocation 

■ XML Container Element: ListOfExtintegcpgPlanAccountPromotionProduct

■ XML Tag: ListOfExtintegcpgPlanAccountPromotionProduct

■ Cardinality: Zero or More

■ Name & External Name: faultMessage

■ Parent Integration Component: ExtIntegCG MDF Promotion Category Allocation

■ XML Container Element: None
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■ XML Tag: faultMessage

■ Cardinality: Zero or One

■ Name & External Name: errorMessage

■ Parent Integration Component: faultMessage

■ XML Container Element: None

■ XML Tag: errorMessage

■ Cardinality: Zero or More

Business Service
■ Name: CGIntegSEBLPromoProductUpdate (New)

■ Class: CSSEAIDataSyncService

■ External Use: Y

■ State Management Type: Stateful

■ Display Name: CGPromoProductUpdateService - Siebel Inbound

Table 71. Business Service Methods

Name Display Name

Delete Delete

Insert Insert

InsertOrUpdate Insert or Update

Synchronize Synchronize

Update Update

Table 72. Business Service Method Arguments

Name
Data 
Type

Integration 
Object Type Optional

Storage 
Type

Display 
Name Comments

Siebel
Messa
ge

Integra
tion 
Object

CGIntegSEB
LPromoProd
uctInterface

Input / 
Output

N Hierarch
y

Account 
Interface

None

Status
Object

String Input Y Property Status 
Object

Pick Field = 
Id PickList = 
EAI Boolean 
Message 
Property 
PickList



Installation and Configuration ■ Configuring the Siebel Trade Promotion Management
Environment

Siebel CRM Integration Pack for Trade Promotion Management
Implementation Guide Version 1.00

123

■ Name: QueryByExample

■ Display Name: Query by Example

■ Name: QueryById

■ Display Name: Query by ID

■ Name: CGIntegSEBLPromotionUpsertService (New)

■ Class: CSSEAIDataSyncService

■ External Use: Y

■ State Management Type: Stateful

Table 73. Business Service Method Arguments

Name
Data 
Type

Integration 
Object Type Optional

Storage 
Type

Display 
Name Comments

SiebelM
essage

Integrati
on 
Object

CGIntegSEB
LPromoProd
uctInterface

Input / 
Output

N Hierarch
y

Account 
Interfac
e

None

Table 74. Business Service Method Arguments

Name
Data 
Type

Integration 
Object Type Optional

Storage 
Type

Display 
Name Comments

Primary
RowId

String Input N Property ID None

SiebelM
essage

Integr
ation 
Object

CGIntegSEBLP
romoProductIn
terface

Output N Hierarchy Account 
Interfac
e

None

Table 75. Business Service User Prop

Name Value

Application Services Interface Y

Internal Integration Object InternalCGIntegSEBLPromoProductInterface
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■ Display Name: CGPromotionUpsertService - Siebel Outbound

■ Name: QueryByExample

■ Display Name: Query by Example

■ Name: QueryById

Table 76. Business Service Methods

Name Display Name

Delete Delete

Insert Insert

InsertOrUpdate Insert or Update

Synchronize Synchronize

Update Update

Table 77. Business Service Method Arguments

Name
Data 
Type

Integration 
Object Type Optional

Storage 
Type

Display 
Name Comments

Siebel
Messa
ge

Integra
tion 
Object

CGIntegSEBL
SIAPromotio
nFaultMessag
e

Input / 
Output

N Hierarchy Account 
Interface

None

Status
Object

String Input Y Property Status 
Object

Pick Field = 
Id PickList = 
EAI Boolean 
Message 
Property 
PickList

Table 78. Business Service Method Arguments

Name
Data 
Type

Integration 
Object Type Optional

Storage 
Type

Display 
Name Comments

Siebel
Messa
ge

Integra
tion 
Object

CGIntegSEB
LSIAPromoti
onFaultMess
age

Input / 
Output

N Hierarchy Account 
Interface

None
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■ Display Name: Query by ID

■ Name: CRMIntegUpsertPromotionSEBL80ToEBS11i10Sync (New)

■ Class: CSSWSOutboundDispatcher

■ External Use: Y

■ State Management Type: Stateful

■ Display Name: CGIntegPromotionUpsertService - Siebel Outbound

Business Service Methods
■ Name: process

Table 79. Business Service Method Arguments

Name
Data 
Type

Integration 
Object Type Optional

Storage 
Type

Display 
Name Comments

Primary
RowId

String Input N Property ID None

SiebelM
essage

Integra
tion 
Object

CGIntegSEB
LSIAPromoti
onFaultMess
age

Output N Hierarchy Account 
Interface

None

Table 80. Business Service User Prop

Name Value

Application Services Interface Y

Internal Integration Object CGIntegSEBLPromotionInterface
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■ Display Name: 

Table 81. Business Service Methods

Name
Data 
Type

Integration 
Object Type Optional

Storage 
Type

Display 
Name

BS Method 
Arg User Prop

CRMIn
tegUps
ertPro
motion
SEBL8
0ToEB
S11i10
SyncR
equest
Messa
ge:pay
load

Integra
tion 
Object

CGIntegSEB
LSIAPromoti
onFaultMess
age

Input Y Hierarchy payload WSDLPartName 
= payload

XMLElementNa
me = 
ListOfCgintegse
blpromotioninte
rface

XMLElementNa
mespace = 
http://
www.siebel.co
m/xml/
CGIntegSEBLPr
omotionInterfa
ce

CRMIn
tegUps
ertPro
motion
SEBL8
0ToEB
S11i10
SyncR
espons
eMess
age:pa
yload

Integra
tion 
Object

CGIntegSEB
LSIAPromoti
onFaultMess
age

Output Y Hierarchy payload WSDLPartName 
= payload

XMLElementNa
me = 
ListOfCgintegse
blpromotioninte
rface

XMLElementNa
mespace = 
http://
www.siebel.co
m/xml/
CGIntegSEBLPr
omotionInterfa
ce

Custo
mHead
erCont
ext

Hierarc
hy

Input/
Output

Y Hierarchy
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Seed Data Changes

1 Navigate to Administration Application > State Models.

2 Query for Plan Account Promotion Status.

3 Click the Transitions tab and query for the Finalized state using the From State field. 

A record is retrieved with From State as Finalized and To State as Re-opened.

4 Delete this record.

Workflow Deployment

To deploy workflows

1 Log in to Siebel Tools and navigate to Workflows.

2 Right click and select the Import Workflow process.

3 Enter the above listed workflow "CGIntegSEBLPromotionUpsertOutboundFlow" and select the 
Project as CPG Plan.

4 Click OK.

5 Query for the workflow. The workflow should be created as follows:

■ Workflow Process Name: CGIntegSEBLPromotionUpsertOutboundFlow

■ Workflow Mode: Service Flow

XMLHi
erarch
yOutp
ut

Hierarc
hy

Output Y XMLHier
archyO
utput

faultac
tor

String Output Y Property

faultco
de

String Output Y Property

faultst
ring

String Output Y Property

Table 81. Business Service Methods

Name
Data 
Type

Integration 
Object Type Optional

Storage 
Type

Display 
Name

BS Method 
Arg User Prop
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■ WF Process Properties:

6 Deploy the workflow by clicking Publish/Activate on the WF/Task Editor Toolbar. 

Display the toolbar by selecting View > Toolbars > WF/Task Editor Toolbar.

7 Login to Siebel UI and navigate to Administration > Business Processes > Workflow Deployment.

8 Query for the Workflow deployed and click Activate.

Web Service Deployment

To deploy Web Services

1 Log in to Siebel UI and navigate to Administration > Web Services > Inbound Web Services.

2 Click Import and specify "CGIntegSEBLPromoProductUpdate.xml" as the Web Service to be 
imported. 

Inbound Web Service: CGIntegSEBLPromoProductUpdate

3 After the inbound Web Service is imported, verify the Siebel Server address in the Service Ports 
applet.

It should have the address of the correct Siebel server that the client must connect to. If 
required, change the address and provide a valid user name and password. 

Inbound Web Service is created as follows:

Name In/Out Business Object Data Type
Access 
Mode

BinaryMSG In/Out CPG Account Promotion String RW

Deal Id In/Out CPG Account Promotion String RW

Deal Instance In/Out CPG Account Promotion Hierarchy RW

Error Code In/Out CPG Account Promotion String RW

Error Message In/Out CPG Account Promotion String RW

Fault Message In/Out CPG Account Promotion Hierarchy RW

IsError In/Out CPG Account Promotion String RW

Object Id In/Out CPG Account Promotion String RW

Process Instance 
Id

In/Out CPG Account Promotion String RW

Promotion First 
Exec

In/Out CPG Account Promotion String RW

Siebel Operation 
Object Id

In/Out CPG Account Promotion String RW
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■ Name: CGIntegSEBLPromoProductUpdate (New)

■ Service Port

■ Operations

4 Click Clear Cache.

5 Navigate to Administration > Web Services > Outbound Web Services.

6 Click Import and specify CRMIntegUpsertPromotionSEBL80ToEBS11i10Sync.XML as the Web 
Service to be imported.

Outbound Web Service: CRMIntegUpsertPromotionSEBL80ToEBS11i10Sync

7 After the outbound Web Service is imported, verify the BPEL server name in the Service Ports 
applet.

The address must have the right BPEL server name that the client must connect to. If required, 
change the address and save.

Outbound Web Service is created as follows:

■ Name: CRMIntegUpsertPromotionSEBL80ToEBS11i10Sync (New) 

■ Namespace: http://xmlns.oracle.com/CRMIntegUpsertPromotionSEBL80ToEBS11i10Sync

Name Type

Business 
Service/
Process Transport Address Binding

CGIntegS
EBLPromo
ProductUp
date

Business 
Service

CGPromoP
roductUpd
ateService 
- Siebel 
Inbound

HTTP http://<webserver>/
eai_<lang>/
start.swe?SWEExtSource=Sec
ureWebService&SWEExtCmd=
Execute&UserName=<UserNa
me>&Password=<Password>

SOAP_R
PC_LITE
RAL

Name
Method Display 
Name

Authentication 
Type

SiebelPromoProductDelete Delete None

SiebelPromoProductInsert Insert None

SiebelPromoProductInsertOrUpdate Insert or Update None

SiebelPromoProductQueryByExample Query by Example None

SiebelPromoProductQueryById Query by ID None

SiebelPromoProductSynchronize Synchronize None

SiebelPromoProductUpdate Update None
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■ Service Port

■ Operations

❏ Method Display Name: Process

❏ Authentication Type: None

Setting Up Common Integration Server 
(Including DVMs and Common Services)
This section describes some integration setup steps that are common across all modules. The topics 
covered in this section are:

■ Defining Data Sources

■ Setting Up Asynchronous Error Handling 

■ Setting Up a Custom GUI Generator

■ Setting Up Common Functions

■ Setting Up Common Objects

■ Importing ID-Xref Seed Data

■ Creating Siebel Trade Promotion Management Business Units and Price List Data Mapped to Oracle 
Trade Management.

■ Populating Mappings in ID-Xrefs and DVMs 

■ Validating and Loading DVMs.

Defining Data Sources
NOTE: All names for data sources and connection pools that are created here are case sensitive.

Name
Business 
Service/Process Transport Address Binding

CRMIntegUpsertP
romotionSEBL80T
oEBS11i10SyncP
ort

CRMIntegUpsertPr
omotionSEBL80ToE
BS11i10Sync

HTTP http://<host-info>/
orabpel/default/ 
CRMIntegUpsertPro
motionSEBL80ToEBS
11i10Sync/1.0

SOAP_DOC_LI
TERAL
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Define the following data sources using Oracle Enterprise Manager:

To create database connections

1 Log in to the Application Server Control (for example URL http://localhost:8888/em) as an 
administrator user (oc4jadmin/welcome1).

2 Click oc4j_soa > Home > Administration tab.

3 Click the Go to Task icon for JDBC Resources under Administration Tasks > Services.

A list of Data Sources and Connection Pools is displayed.

To create Connection Pools and Data Sources for Xref and CRMIntgDataSource

1 Under Connection Pools, click Create. 

2 Accept defaults, and click Continue.

Data Source JNDI Name Details

Xref jdbc/xref A data source pointing to a xrefuser on the 10.1.3 
Dehydration Database. Usually it is the database with which 
the SOA is installed.

CRMIntgDataSour
ce

jdbc/crmintg A data source pointing to a xrefuser on the 10.1.3 
Dehydration Database. Usually it is the database with which 
the SOA is installed.

locOracleEBSData
Source

OracleEBSD
ataSource

A data source pointing to the Oracle E-Business Suite data 
source

jdbcOracleEBSDat
aSource

jdbc/
OracleEBSD
ataSource

A data source pointing to the Oracle E-Business Suite data 
source

locErrorDB loc/ErrorDB A data source pointing to error database. It can be any 
database with proper error schema setup in section Setting 
Up Asynchronous Error Handling. Usually it is the database 
with which the SOA is installed. For username and password, 
please refer to section Setting Up Asynchronous Error 
Handling.

jdbcErrorDB jdbc/
ErrorDB

A data source pointing to an error database. It can be any 
database with a proper error schema setup in section Setting 
Up Asynchronous Error Handling. Usually it is the database 
with which the SOA is installed. For username and password, 
please refer to section Setting Up Asynchronous Error 
Handling.
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3 Enter the following (leave defaults for the rest):

4 Click Finish.

5 Click the Test Connection icon for your new connection pool.

6 In the new screen, click Test. 

On the main page, a successful connection message is displayed. If you get an error message, 
check the URL and credentials to ensure you have entered the correct information.

7 Click Finish.

8 Under Data Sources, click Create.

9 Accept the defaults, and click Continue.

10 Enter the following (leave the defaults for the rest):

11 Click Finish.

12 Under Data Sources, click Create again.

13 Accept the defaults, and click Continue.

14 Enter the following (leave the defaults for the rest):

Name Xref Connection Pool

JDBC URL <according to DB Setup> such as jdbc:oracle:thin:@//host:port/service 
name

Username <according to DB Setup> such as orabpel

Password <according to DB Setup> > such as orabpel

Name Xref 

JNDI Location jdbc/xref

Connection Pool Xref Connection Pool

Transaction Level Global & Local Transactions

Name CRMIntgDataSource

JNDI Location jdbc/crmintg

Connection Pool Xref Connection Pool

Transaction Level Global & Local Transactions
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Creating an Oracle E-Business Suite Data Source

To configure the Oracle e-Business Suite Data Source

1 Under Connection Pools, click Create.

2 Accept the defaults, and click Continue.

3 Enter the following (leave defaults for the rest):

4 Click Finish.

5 Click the Test Connection icon for your new connection pool.

6 In the new screen, click Test. 

Back on the main page, a successful connection message is displayed. If you get an error 
message, check the URL and credentials to ensure you've entered the right information.

7 Click Finish.

8 Under Data Sources, click Create.

9 Accept the defaults, and click Continue.

10 Enter the following (leave the defaults for the rest):

11 Click Finish.

12 Under Data Sources, click Create.

13 Accept the defaults, and click Continue.

Name OracleEBSDataSource

JDBC URL <according to Oracle E-Business Suite DB Setup> jdbc:oracle:thin:@//
host:port/service name For example: jdbc:oracle:thin:@//
ap6132rt.us.oracle.com:1525/cgtut102

Username <according to Oracle E-Business Suite DB Setup> enter an E-Business 
Suite username that has APPS schema Privilege (for example, APPS)

Password <according to Oracle E-Business Suite DB Setup> enter an E-Business 
Suite username password that has APPS schema Privilege (for example, 
APPS)

Name locOracleEBSDataSource

JNDI Location loc/OracleEBSDataSource

Connection Pool OracleEBSDataSource
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14 Enter the following (leave the defaults for the rest):

15 Click Finish. 

Creating Error Database Connection Information

To configure the Error DB Data Source

1 Under Connection Pools, click Create.

2 Accept defaults, and click Continue.

3 Enter the following (leave the defaults for the rest):

4 Click Finish.

5 Click the Test Connection icon for your new connection pool.

6 In the new screen, click Test. 

Back on the main page, a successful connection message is displayed. If you get an error 
message, check the URL and credentials to ensure you have entered the right information.

7 Click Finish.

8 Under Data Sources, click Create.

9 Accept the defaults, and click Continue.

10 Enter the following (leave the defaults for the rest):

11 Click Finish.

Name jdbcOracleEBSDataSource

JNDI Location jdbc/OracleEBSDataSource

Connection Pool OracleEBSDataSource

Name ErrorDB

JDBC URL <according to error DB Setup> jdbc:oracle:thin:@//host:port/service name 
For example, jdbc:oracle:thin:@//SDCHS20N405.siebel.com:1521/oracle

Username <according to error DB Setup> 

Password <according to error DB Setup> 

Name locErrorDB

JNDI Location loc/ErrorDB

Connection Pool ErrorDB
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12 Under Data Sources, click Create.

13 Accept the defaults, and click Continue.

14 Enter the following (leave the defaults for the rest):

15 Click Finish.

Creating Adapter Data Source

To configure Adapter Data Source

1 From the Oracle SOA Suite main page, click the link for Application Server Control.

2 Log in as an administrative user.

3 Under All Application Servers, click your SOA application server name.

4 Click your OC4J J2EE container name.

5 Click Applications tab.

6 Click domain name.

7 Configure AppsAdapter

a Click AppsAdapter module.

b Click Connection Factories.

c Click Create above JNDI Location.

d Leave default for Connection Factory Interface and click Continue.

e For JNDI location, enter eis/Apps/OracleEBSDataSource.

f Under Connection Pooling, select No Connection Pool.

g Under Configuration Properties, enter dataSource as loc/OracleEBSDataSource and 
xADataSource as jdbc/OracleEBSDataSource.

h Click Finish.

8 Configure AQ Adapter

a Click AqAdapter module.

b Click Connection Factories.

c Click Create above JNDI Location.

d Leave default for Connection Factory Interface and click Continue.

Name jdbcErrorDB

JNDI Location jdbc/ErrorDB

Connection Pool ErrorDB



Siebel CRM Integration Pack for Trade Promotion Management 
Implementation Guide Version 1.00

Installation and Configuration ■ Setting Up Common Integration Server (Including DVMs 
and Common Services)

136 

e For JNDI location, enter eis/AQ/OracleEBSDataSource.

f Under Connection Pooling, select No Connection Pool.

g Under Configuration Properties, enter the data source as loc/OracleEBSDataSource and 
xADataSource as jdbc/OracleEBSDataSource.

h Click Finish.

9 Configure DB Adapter

a Click DbAdapter module.

b Click Connection Factories.

c Click Create above JNDI Location.

d Leave default for Connection Factory Interface and click Continue.

e For JNDI location, enter eis/DB/OracleEBSDataSource.

f Under Connection Pooling, select No Connection Pool.

g Under Configuration Properties, enter the data source as loc/OracleEBSDataSource and 
xADataSource as jdbc/OracleEBSDataSource.

h Click Finish.

i Click Create above JNDI Location.

j Leave default for Connection Factory Interface and click Continue.

k For JNDI location, enter eis/DB/ErrorDB.

l Under Connection Pooling, select No Connection Pool.

m Under Configuration Properties, enter the data source as loc/ErrorDB and xADataSource as jdbc/
ErrorDB.

n Click Finish.

Setting Up Asynchronous Error Handling 
CRMIntegErrorHandlerService requires a database to store information. Connect to the error 
database using SQL client, as sys user, for example, sys/manager, and do following configuration.

To configure the error database

1 Create Tablespace.

This step is optional; you can use existing table spaces for ERRORADMIN user. 

CREATE SMALLFILE TABLESPACE "ERRORHANDLING" DATAFILE 
'D:\ORACLEDB10G\PRODUCT\10.2.0\ORADATA\GENESIS0\ERRORHANDLING.DAT' SIZE 100M 
AUTOEXTEND ON NEXT 1024K MAXSIZE UNLIMITED LOGGING EXTENT MANAGEMENT LOCAL SEGMENT 
SPACE MANAGEMENT AUTO; 

2 Create User: 
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CREATE USER ERRORADMIN 

   IDENTIFIED BY VALUES <PASSWORD here>

  DEFAULT TABLESPACE ERRORHANDLING 

  TEMPORARY TABLESPACE TEMP 

  PROFILE DEFAULT 

ACCOUNT UNLOCK; 

3 Grant User Privileges: 

GRANT ALTER ANY TABLE TO ERRORADMIN; 

GRANT ALTER ANY TYPE TO ERRORADMIN; 

GRANT CREATE SESSION TO ERRORADMIN; 

GRANT CREATE SYNONYM TO ERRORADMIN; 

GRANT CREATE ANY TABLE TO ERRORADMIN; 

GRANT CREATE ANY TYPE TO ERRORADMIN; 

GRANT DROP ANY TABLE TO ERRORADMIN; 

GRANT CREATE ANY TYPE TO ERRORADMIN; 

GRANT UNLIMITED TABLESPACE TO ERRORADMIN; 

GRANT INSERT ANY TABLE TO ERRORADMIN; 

GRANT SELECT ANY TABLE TO ERRORADMIN; 

GRANT UPDATE ANY TABLE TO ERRORADMIN; 

4 Create ERROR_DATABASE table in ERRORADMIN schema 

CREATE TABLE ERROR_DATABASE 

( 

  CALLINGPROCESSNAME        VARCHAR2(60 BYTE), 

  CALLINGPROCESSINSTANCEID  VARCHAR2(10 BYTE), 

  FAULTTEXT                 VARCHAR2(1000 BYTE), 

  FAULTSTACK                VARCHAR2(1000 BYTE), 

  FAULTCONTEXT              VARCHAR2(200 BYTE), 

  PROCESSINPUTPAYLOAD       CLOB 

); 

5 Configure SMTP for notification



Siebel CRM Integration Pack for Trade Promotion Management 
Implementation Guide Version 1.00

Installation and Configuration ■ Setting Up Common Integration Server (Including DVMs 
and Common Services)

138 

Edit <ORACLE_AS_HOME>/bpel/system/services/config/ns_email.xml.

Set NotificationMode to EMAI. Set SMTPHost, SMTPPort. 

<EmailAccounts xmlns="http://xmlns.oracle.com/ias/pcbpel/NotificationService" 

               EmailMimeCharset="" 

               NotificationMode="EMAIL">

   <EmailAccount>

      <Name>Default</Name>

      <GeneralSettings>

         <FromName>Oracle BPM</FromName>

         <FromAddress>accountId@yourdomain.com</FromAddress>

      </GeneralSettings>

      <OutgoingServerSettings>

         <SMTPHost>mail.oracle.com</SMTPHost>

         <SMTPPort>25</SMTPPort>

      </OutgoingServerSettings>

      <IncomingServerSettings>

         <Server>yourdomain.com</Server>

         <Port>110</Port>

         <Protocol>pop3</Protocol>

         <UserName>accountId</UserName>

         <Password ns0:encrypted="false" xmlns:ns0="http://xmlns.oracle.com/ias/
pcbpel/NotificationService">password</Password>

         <UseSSL>false</UseSSL>

         <Folder>Inbox</Folder>

         <PollingFrequency>1</PollingFrequency>

         <PostReadOperation>

            <MarkAsRead/>

         </PostReadOperation>

      </IncomingServerSettings>
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   </EmailAccount>

6 Create DVM Map for mapping mail IDs: 

CRMIntegErrorHandlerService queries the Email ID of the owner of the faulted process from DVM 
Map CRMIntegProcessMailId. 

a Create DVM Map with the following details:

■ Name: CRMIntegProcessMailId 

■ Domains: 

❏ ProcessName

❏ MailID

b After creating the map, enter process names and the respective email ids. You can also use 
following to import the map:

<?xml version="1.0" encoding="UTF-8"?> 

- <dvm name="CRMIntegProcessMailId" isNew="null">

 <description>DVM description</description> 

- <columns>

  <column name="ProcessName" /> 

  <column name="MailID" /> 

  </columns>

- <rows>

- <row>

  <cell>default</cell> 

  <cell>manish.amle@oracle.com</cell> 

  </row>

- <row>

  <cell>CRMIntegSyncAccount</cell> 

  <cell>manish.amle@oracle.com</cell> 

  </row>

  </rows>

  </dvm>
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Setting Up a Custom GUI Generator
Set up the following environment variables at common prompt. For example, if you are using csh, 
enter 

setenv CRMINTG_DB_USER "APPS"

■ CRMINTG_DB_URL <the same as used by data source CRMIntgDataSource >

■ CRMINTG_DB_USER <the same as used by data source CRMIntgDataSource >

■ CRMINTG_DB_PASSWORD <the same as used by data source CRMIntgDataSource >

■ OC4J_USERNAME

■ OC4J_PASSWORD

■ CLASSPATH add <SOA_HOME>/bpel/system/classes

■ GUID_GENERATOR <set to oracle.crmintg.common.xpath.CRMIntgGUIDGenerator>

Setting Up Common Functions
All related files required for this part are located under the build folder \\build

number\SEBLTPMIntegPkEBSTM\SharedComponents\Utitlity\CommonFunctions.

■ Execute create_crmintgCommon_schema.sql on the database that you wish to use for Common 
Functions. (same database and user which the data source CRMIntgDataSource created in 
section Defining Data Sources).

■ Extract jar file crmintg-common.jar from build folder to <SOA_HOME>\bpel\system\classes with 
folder structure. You can run jar -xvf crmintg-common.jar at the command prompt.

■ Open crmintg-xpath-functionEntries.xml from build folder and copy the contents of this file to 
the end of <SOA_HOME>\bpel\system\config\xpath-functions.xml file. Before modification, 
please make a backup copy of xpath-functions.xml.

NOTE: This content should go inside the top-level element (bpel-xpath-functions), not after that, 
that is, between <function> and </bpel-xpath-functions>. Reapplying a cross-reference patch 
requires that this step be performed again.

■ In order to show the crmintg common functions in your JDev, do the following; 

a Create an xml file with any name, say anyName.xml. Copy the below contents in a file.

 <?xml version="1.0" encoding="UTF-8"?>

   <extension-functions>

    <!-- Cross Reference Functions -->

     <functions xmlns:crmintg="http://www.oracle.com/XSL/Transform/java/
oracle.crmintg.common.xpath.CRMIntgXPathFunctions">

 <function name="crmintg:generateCommonID" as="string">
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 </function>

 <function name="crmintg:generateUniqueID" as="string">

 </function>

    </functions>

</extension-functions>

b Open Oracle JDeveloper and navigate to JDeveloper > Tools > Preferences > XSL Maps.

c In the first box, User Defined Extension Functions Config File, browse for the file created in Step 
a and restart JDeveloper.

Importing ID-Xref Seed Data

Use the following steps to import the ID Xref table and column definitions using Xref 
Command Line Tool:.

1 Copy crmintg_seed_data.txt from <Build 
Location\SEBLTPMIntegPkEBSTM\SharedComponents\Utility\CommonFunctions to 
<SOA_HOME>\integration\esb\bin.

2 Execute the following command at <SOA_HOME>\integration\esb\bin: 

■ On Windows: xreftool -f crmintg_seed_data.txt

■ On linux:./xreftool.sh -f crmintg_seed_data.txt

NOTE: This step needs a cross reference patch setup done. Please refer to cross reference 
documentation for any help to run xreftool command.

Populating Xref Data
This section gives instructions on populating xref data using the xrefimport utility. 

To import the metadata and xref values from the specified xml file, the xml file to be imported should 
comply with xref.xsd.

Some salient points about xref import:

■ Can be performed on a clean repository. Xref table and columns are created if they do not exist.

■ User can specify the preferred way of handling the duplicate values (Details below).

■ User can specify the generation of an xref column along with the values during import.

Syntax:

Can be added to xrefimport classpath by any of the following:

■ In Windows: xrefimport -file <fileName> [-mode <ignore | overwrite>] [ -generate 
<columnName>] 
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■ In Unix: ./xrefimpor.sh -file <fileName> [-mode <ignore | overwrite>] [ -generate 
<columnName>]

■ -file <fileName> Fully qualified location of the file from which the data is imported

■ -mode <ignore | overwrite> (Optional) Preferred way of handling the existing data in case of 
conflicts. The value “ignore” would keep the existing data in the repository and “overwrite” would 
overwrite the existing data with the data present in the xml file which is getting imported. Please 
note that the mode kicks in only in the case of conflicts. The default is “ignore”.

■ -generate <column name> (Optional) Column name that has to be created automatically during 
import. 

The import utility is used to create mapping between Oracle Trade Management and Siebel Trade 
Promotion Management data and the mapping is stored in Xref schema. For example, to create a 
mapping between Oracle E-Business Suite customer account and Siebel account, use the following 
steps.

To create a mapping between Oracle E-Business Suite customer account and Siebel 
Trade Promotion Management account

1 Create a Siebel Trade Promotion Management Account or use an existing account say 
SiebelTestAcct1 and get the account id as well, say SiebelId1. You can similarly have 
SiebelTestAcct2, with SiebelId2, and so on.

2 Create an account in Oracle Trade Management or use an existing account, say OracleAcct1, and 
get the account id for the same, say OracleId1. You can similarly have OracleAcct2, OracleId2.

3 To map, SiebelAcct1 to OracleAcct1, SiebelAcct2 to OracleAcct2, in ACCOUNT table in Xref 
schema, use the following sample file, AccountXref.xml:

<xref xmlns="http://xmlns.oracle.com/xref">

   <table name="ACCOUNT">

      <columns>

         <column name="SIEBEL78_01"/>

 <column name="ORACLE11I10_01"/>

      </columns>

      <rows>

         <row>

            <cell colName="SIEBEL78_01">SiebelId1</cell>

    <cell colName="ORACLE11I10_01">OracleId1</cell>

 </row>

         <row>
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    <cell colName="SIEBEL78_01">SiebelId2</cell>

    <cell colName="ORACLE11I10_01">OracleId2</cell>

 </row>

      </rows>

   </table>

</xref>

4 Put this file, AccountXref.xm,l under the <SOA server install directory>\integration\esb\bin 
directory.

Next, run xrefimport on this file to create a mapping between Siebel Trade Promotion 
Management and Oracle Trade Management accounts.

5 On windows: Navigate to the Command Prompt.

On linux: Open a Shell window.

6 Go to the <SOA server install directory>\integration\esb\bin directory.

7 Make sure that following variables are set correctly, before running the tool.

■ CRMINTG_DB_URL <SOA database connection details>

■ CRMINTG_DB_USER

■ CRMINTG_DB_PASSWORD 

■ OC4J_USERNAME

■ OC4J_PASSWORD

■ CLASSPATH <SOA_HOME>/bpel/system/classes

■ GUID_GENERATOR oracle.crmintg.common.xpath.CRMIntgGUIDGenerator

The values should point to the schema where Xref tables were created during Xref setup. Sample 
values are:

■ DB_URL=jdbc:oracle:thin:@stapm21.us.oracle.com:1521:orcl

■ DB_PASSWORD=oraesb

■ DB_USER=oraesb

8 Run following command to import the above XML file using the ID-Xref import utility with the 
custom GUID generation option configured in CRMIntg custom GUID Generator setup-

■ On Windows: xrefimport -file <import xml file name with full path> -generate COMMON
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■ On Linux: ./xrefimport.sh -file <import xml file name with full path> -generate COMMON

For example, ./xrefimport.sh -file AcoountXref.xml -generate COMMON

Follow similar steps for Product, Organization, and so on to create corresponding mappings 
between Siebel Trade Promotion Management and Oracle Trade Management data. Details on 
mapping Oracle Trade Management and Siebel Trade Promotion Management Organizations are 
explained later in Sections Setting Up Common Objects and Creating Siebel Trade Promotion 
Management Business Units and Price List Data Mapped to Oracle Trade Management. 

A sample file:

<xref xmlns="http://xmlns.oracle.com/xref">

  <table name="ORGANIZATION">

      <columns>

         <column name="SIEBEL78_01"/>

         <column name="ORACLE11I10_01"/>

       </columns>

      <rows>

         <row>

            <cell colName="SIEBEL78_01">42-4YGUO</cell>

            <cell colName="ORACLE11I10_01">888</cell>

         </row>

         <row>

            <cell colName="SIEBEL78_01">42-4YGUI</cell>

            <cell colName="ORACLE11I10_01">911</cell>

         </row>

         <row>

            <cell colName="SIEBEL78_01">42-4YGUB</cell>

            <cell colName="ORACLE11I10_01">204</cell>

         </row>

         <row>

            <cell colName="SIEBEL78_01">42-4YGUU</cell>

            <cell colName="ORACLE11I10_01">207</cell>

         </row>

      </rows>
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   </table>

</xref>

Setting Up Common Objects
Use the following procedure to set up common objects.

To set up common objects

1 Copy the <Build Location>\SEBLTPMIntegPkEBSTM\xmllib\SEBLTPMIntegPkEBSTM folder to the 
<SOA_HOME>/bpel/system/xmllib directory.

2 Restart SOA.

Creating Siebel Trade Promotion Management Business 
Units and Price List Data Mapped to Oracle Trade 
Management
You must create Business Units and Price Lists in Siebel Trade Promotion Management for every 
Operating Unit (OU) in Oracle Trade Management. This is a manual task, and at this point no scripted 
or automated mechanism exists to pre-populate this into Siebel Trade Promotion Management. 

To create and map Siebel Trade Promotion Management Business Units and Price 
Lists to Oracle Trade Management

1 For every operating unit (Organization) in Oracle Trade Management, gather the following 
information:

■ Name, ID, and Code

■ Location

■ Address

■ Name and ID of an Oracle Trade Management Responsibility that has this OU assigned as the 
Default. 

■ Name and ID of a Oracle Apps User to which this responsibility is assigned. 

2 In Siebel Trade Promotion Management, create business units corresponding to every one of the 
Oracle Trade Management OUs. Note the Siebel Trade Promotion Management IDs for the 
following:

a Log in to Siebel Callcenter Client, navigate to Site Map > Administration > Group/Organizations

b Click New in the Organizations applet.

c Enter the exact name as in Oracle Trade Management and save.
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d Highlight the record and then select Help > About Record to check the row number. Use this row 
number for Siebel value ID Xref of ORGANIZATION.

e Follow the above steps for the other Oracle Trade Management operating units.

3 In Siebel Trade Promotion Management, create price lists corresponding to every one of the 
Oracle Trade Management OUs. Note the Siebel Trade Promotion Management IDs for the 
following:

a Log in to Siebel eConsumer Sector, navigate to Site Map > Administration > Pricing > Price Lists

b Click New in the My Price List applet.

c Enter the exact name as in the Oracle E-Business Suite Price List and Save.

d Highlight the record and then choose Help > About Record from the menu to check the Row Id 
of Siebel Trade Promotion Management Price List. Use this Row Id for Siebel Trade Promotion 
Management value ID Xref of PRICE LIST.

Populating Mappings in ID-Xrefs and DVMs
Using the information created in the previous step, populate the following ID-Xrefs with the 
mappings between the Oracle Trade Management ID and the Siebel Trade Promotion Management ID.

■ ID-Xref: ORGANIZATION

■ This ID-Xref stores the mappings between Oracle Trade Management Operating Units 
(ORGANIZATION) and Siebel Trade Promotion Management Business Units. 

■ This ID-Xref has three columns. ORACLE11I10_01, SIEBEL78_01 and COMMON

■ Create an XML file conforming to the Xref data import utility schema. This file has a row for 
every Oracle Trade Management-Siebel Trade Promotion Management mapping, between 
Organization and Business Units. The Oracle Trade Management ID (in ORACLE11I10_01 
column) has the ORGANIZATION_ID, while the Siebel Trade Promotion Management ID (in 
SIEBEL78_01 column) has the Business Unit ID. 

■ Import the above XML file using the ID-Xref import utility with the common-id generation 
option. See Populating Xref Data for instructions.

■ ID-Xref: PRICE LIST

■ This ID-Xref stores the mappings between Oracle Trade Management and Siebel Trade 
Promotion Management Price List. 

■ This ID-Xref has three columns: ORACLE11I10_01, COMMON, and SIEBELSIA80_01.

■ Create an XML file conforming to the Xref data import utility schema. This file has a row for 
every Oracle Trade Management-Siebel Trade Promotion Management mapping, between 
price list. The Oracle Trade Management ID (in ORACLE11I10_01 column) has the 
PRICE_LIST_ID (Query in Oracle APPS schema; for example, "select price_list_id from 
qp_price_lists_v where name = 'Corporate';), while the Siebel Trade Promotion Management 
ID (in SIEBELSIA80_01 column) has the Row ID of price list. 

■ Import the above XML file using the ID-Xref import utility with the common-id generation 
option.
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Validating and Loading DVMs
This integration requires a number of other DVMs. These store various mappings between Oracle 
Trade Management and Siebel Trade Promotion Management lookup values. These are provided with 
sample data, and should each be verified for the specific integration scenario. 

All DVM map xml files can be found in the following directory:

<Build Location>\SEBLTPMIntegPkEBSTM\SharedComponents\Utility\DVM\Maps

To upload DVM

1 Log in to ESB Control. 

2 Click the icon on the top right hand corner. 

The Domain Value Map is displayed on the left panel. 

3 Click Create and select Import a new map.

4 You must import the following DVM used by each module:

■ Customer

■ STATE

■ COUNTRY

■ GENDER

■ DEFAULT ORG: After importing this DVM map, please change the Siebel Trade Promotion 
Management column value according to the setup in Siebel. The value in this DVM map is just 
a sample.

■ PERSONAL TITLE

■ ACCOUNT STATUS

■ CONTACT STATUS

■ ADDRESS STATUS

■ PHONE TYPE CODE

■ WEB TYPE CODE

■ ADDRESS TYPE CODE

■ CUSTOMER TYPE

■ HOME OWNER FLAG

■ MARITAL STATUS

■ Product

■ PRODUCT STATUS

■ UNIT OF MEASURE

■ Fund
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■ BUDGET TYPE

■ ACCRUAL BASIS TYPE

■ CURRENCY CODE

■ Deduction

■ CLAIM STATUS 

■ DEDUCTION REASON 

■ DEDUCTION TYPE 

■ PAYMENT METHOD TYPE

■ CURRENCY CODE

■ Promotion

■ CURRENCY CODE

■ PROMOTION STATUS

■ PROMOTION TYPE

■ DISCOUNT TYPE

Process of Deploying BPEL Processes 
Using Oracle JDeveloper
To deploy BPEL processes using Oracle JDeveloper, perform the following tasks:

1 Configuring the Application Server on page 148

2 Configuring the Integration Server on page 149

3 Deploying BPEL Processes for Siebel CRM Integration Pack for Trade Promotion Management on 
page 149

Configuring the Application Server
Use this procedure to configure the application server.

To configure the application server

1 Open Oracle JDeveloper.

2 Click Connections Navigator.

3 Under Connections, double-click Application Server.

4 Click Next.

5 Enter a name for ConnectionName to represent the SOA Suite application server. 
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6 From Connection Type, select Oracle Application Server 10g 10.1.3.

7 Click Next.

8 For UserName, enter the SOA instance username. 

9 For Password, enter the SOA instance password. 

10 Select Deploy Password.

11 Click Next.

12 For Hostname, enter the server on which the SOA instance runs.

13 For OPMN Port, leave the default.

14 For OC4J Instance Name, enter the OC4J instance name given during the installation. 

15 Click Next.

16 Click Test Connection. 

If the test is successful, a confirmation message is displayed.

Configuring the Integration Server

To configure the integration server

1 Open Oracle JDeveloper.

2 Click Connections Navigator.

3 Under Connections, double-click Integration Server.

4 Click Next.

5 Enter a name for ConnectionName to represent the SOA Suite application server. 

6 Click Next.

7 Under Application Server, select the server created in previous step.

8 Change the port name, as needed, to indicate the port at which the SOA Suite instance runs.

9 Click Next.

10 Click Test Connection. 

If the test is successful, a confirmation message is displayed.

Deploying BPEL Processes for Siebel CRM Integration 
Pack for Trade Promotion Management 
The final step is to deploy the BPEL processes. A number of BPEL processes exist for every module. 
The list of all BPEL processes to be deployed follows. The processes are ordered according to the 
recommended sequence of deployment: 
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1 CRMIntegErrorHandlerService 

2 CRMIntegMapAccountCOMToKeyCrossRefSync

3 CRMIntegMapAccountCOMToSEBL8Sync

4 CRMIntegMapAccountSEBL8ToKeyCrossRefSync

5 CRMIntegXformAcctEBS11i10ToCOM

6 CRMIntegXformEBSToSEBLAndSyncAcct

7 CRMIntegSaveAcctEBS11i10ToSEBL782Sync

8 CSIntegMapSimpleProductCOMToSEBL80

9 CRMIntegXformProductOPOraToComEBS11i10ToSEBL782

10 CSIntegSimpleProductEBSToSEBL80Sync

11 CRMIntegSyncProductOPEBS11i10ToSEBL782Async

12 CRMIntegSubscribeToCreateProductOPEBS11i10ToSEBL782

13 CRMIntegSubscribeToUpdateProductOPEBS11i10ToSEBL782

14 CRMIntegMapPromotionCOMToSEBL80Inboundsync

15 CRMIntegMapPromotionCOMToSEBL80OutboundSync

16 CRMIntegMapPromotionSEBL80ToCOMInboundsync

17 CRMIntegMapPromotionSEBL80ToCOMOutboundSync

18 CRMIntegPromotionCOMToEBS11i10Sync

19 CRMIntegUpdatePromotionCOMToSEBL80Sync

20 CRMIntegUpsertPromotionSEBL80ToEBS11i10Sync

21 CRMIntegFundCOMToEBS11i10Sync 

22 CRMIntegMapFundCOMToSEBL80InboundSync

23 CRMIntegMapFundCOMToSEBL80OutboundSync

24 CRMIntegMapFundSEBL80ToCOMInboundSync

25 CRMIntegMapFundSEBL80ToCOMOutboundSync

26 CRMIntegUpdateFundCOMToSEBL80Sync

27 CRMIntegUpsertFundSEBL80ToEBS11i10Sync

28 CRMIntegAccrualEBS11i10ToSEBL80Sync

29 CRMIntegDeductionCOMToEBS11i10Sync

30 CRMIntegMapDeductionCOMToSEBL80InboundSync

31 CRMIntegMapDeductionCOMToSEBL80OutboundSync

32 CRMIntegMapDeductionSEBL80ToCOMInboundSync

33 CRMIntegMapDeductionSEBL80ToCOMOutboundSync
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34 CRMIntegUpsertDeductionCOMToSEBL80Sync

35 CRMIntegUpsertDeductionSEBL80ToEBS11i10Sync

36 CRMIntegDeductionEBS11i10ToSEBL80Sync

To deploy BPEL processes

1 Launch Oracle JDeveloper.

2 In Oracle JDeveloper, select File > New > Application.

3 Click OK to continue.

4 Enter a meaningful application name e.g BPELDeployer.

A single application can have all the projects or multiple applications can be created for each 
module.

5 Click OK to continue.

6 When prompted to create a project, click Cancel. 

7 In the Applications Navigator, right-click on the BPELDeployer application and select Add to 
BPELDeployer.jws.

8 Browse to <Build 
location>\SEBLTPMIntegPkEBSTM\BusinessProcesses\CommonServices\CRMIntegErrorHandler
Service.

a Select CRMIntegErrorHandlerService.jpr.

b Click Open. 

This brings one process into the workspace. In the same way, bring all the processes from 
the <Build location>\SEBLTPMIntegPkEBSTM\BusinessProcesses folders (Customer, 
Deductions, Promotions, Products), into the workspace. Now they are ready for deployment.

9 Deploy the process in the order specified above for each module.

NOTE: This fails if the BPEL PM Server has not been started.

a Right click each project name in the workspace BPELDeployer.jws.

b Select Deploy > LocalBPELServer (Integration server connection name) > Deploy to default 
domain.

c Enter a password for BPEL server. 

d If the Deploy Properties window is displayed, click OK to overwrite the current version.

e Verify that a successful deployment message appears in the lower left portion of the JDeveloper 
window (Apache int log).

f Ignore any compilation warnings.

Repeat Steps 9a to 9f for all the projects added to BPELDeployer.jws.
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Synchronizing Records after the Oracle 
Server Has Gone Down
If the Oracle server goes down, you can synchronize records between Siebel Trade Promotion 
Management and Oracle Trade Management from either application. This section contains the 
following topics:

■ Synchronizing Records from Siebel Trade Promotion Management on page 152

■ Synchronizing Records from Oracle Trade Management on page 157

Synchronizing Records from Siebel Trade Promotion 
Management
If the Oracle server is down when a user adds or modifies a record in Siebel Trade Promotion 
Management, then Siebel CRM Integration Pack for Trade Promotion Management cannot 
synchronize this entry with Oracle Trade Management. Therefore the integration provides ways for 
the administrator to resend the data from Siebel Trade Promotion Management to Oracle Trade 
Management after the Oracle server comes up. This section discusses two ways to resend data:

■ Sending Siebel Data with the User Interface on page 152

■ Using Workflow to Send Data Through the Database Layer on page 153 

This section uses the Fund module as an example, but you can use the same approach for other 
modules, such as Promotion.

Sending Siebel Data with the User Interface

To send Siebel data through the user interface

1 Within BC: CS Account Fund, add a BC user property as the following table shows.

2 Within applet: CS Fund Admin List Applet, expose a new button for sending a record on CS Fund 
Admin List Applet by defining Control as the following table shows.

The button is enabled for all the funds with status Completed.

Name Value

Named Method 1 "SendFundData", "INVOKESVC", "CS Account Fund", "Workflow 
Process Manager", "RunProcess", "'ProcessName'", 
"CSIntegSEBLSIAFundUpsertOutboundFlow", "'RowId'", "[Id]"

Name Caption HTML Type Method Invoked

SendFundUpdate Send MiniButton SendFundData
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3 Add a new applet user property as the following table shows.

4 Compile the modified objects.

5 If you do not want to expose the button to all users, then do the following:

a Create a new view + clone of CS Fund Admin List Applet with the button.

b Add the new view to the desired responsibility.

Using Workflow to Send Data Through the Database Layer 
You can create a workflow policy object and columns to identify columns to monitor in the Siebel 
database or extension columns. Configure each module as follows to enable a database trigger to 
send data from Siebel Trade Promotion Management to Oracle Trade Management.

Configuring a Workflow Policy Column
Workflow Policy Column identifies a column to monitor from the Siebel database or extension 
columns. 

To configure a workflow policy column

1 Login to Siebel Tools.

2 Navigate to Project.

3 Query for CS CG Fund Integration project.

4 Select the Locked checkbox to lock the project.

5 Navigate to Workflow Policy Column.

6 Query for Fund Group Status. 

7 Lock Object from the R-popup menu. 

8 Edit the object as the following table shows.

 Name Value

CanInvokeMethod: SendFundData [Read Only Condition Field]

New? Name
Table 
Name Column Name Comments

Modified Fund 
Group 
Status

S_MDF STATUS_CD Change Picklist from "PickList 
Deduction Payment Status" to "PickList 
CS Fund Group Status". Remove Pick 
Applet "CPG Deduction Payment Status 
Pick Applet".

New Fund Type S_MDF FUND_CD None
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Configuring a Workflow Policy Object
A workflow policy object groups workflow policy component columns that can be monitored in the 
same workflow policy. Use this procedure to configure the workflow policy object.

To configure a workflow policy object

1 Navigate to Workflow Policy Object.

2 Create an object with Name = CS Account Fund.

3 Navigate to Workflow Policy Component.

4 Create a workplace policy component as follows:

■ Name = CS Account Fund

■ Source Table = S_MDF

5 Navigate to Workflow Policy Component Col.

6 Add component columns as the following table shows.

7 Shut down Siebel Server.

8 Compile the locked projects into the server srf file.

Enabling Workflow Policy and Creating Actions
To make Siebel Tools objects, such as workflow policy objects and columns, accessible in Siebel 
Client, you must update Siebel Repository in the Siebel database. Workflow policy objects and 
columns are read from Siebel Repository, not from the compiled Siebel Repository file (.srf). You can 
connect to the Siebel application database using Siebel Tools and import workflow policy objects and 
columns. Use the following procedure to enable the workflow policy object.

To enable workflow policy and create actions

1 Login to the Siebel eConsumersector application.

2 Navigate to Administration - Business Process > Workflow Policy Actions.

3 Use the following table to create a new action for the workflow.

# Name
Source Table 
Name Source Column Name

1 Fund Group 
Status

S_MDF STATUS_CD

2 Fund Type S_MDF FUND_CD

Name Program Workflow Object

CS Account Fund Run Workflow Process CS Account Fund
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4 Use the following table to create an argument for the action.

5 Navigate to Administration - Business Process > Workflow Policy Groups.

6 Use the following table to create a new workflow policy that defines conditions and generates 
database triggers to capture updates.

7 Use the following table to create a condition for this workflow.

8 Use the following table to create an action for this workflow.

9 Use the following table to create the argument for this action.

Generating Triggers
With the Generate Trigger (GenTrig) component on the Siebel Server, you can crete database 
triggers. Policy Manager uses these database triggers to identify which records may match policy 
conditions. You must regenerate Generate Trigger whenever new policies are created or deleted. 

You can run the Generate Triggers component with either the Server Manager graphical user 
interface (GUI) or command line mode. Both the GUI and the command line use the same 
parameters.

Argument Name Value

ProcessName CSIntegSEBLSIAFundUpsertOutboundFlow

Policy
Workflow 
Object

Workflow 
Policy Group Batch Mode Units Duration

CS Account 
Fund

CS Account 
Fund

CS Account Fund Y Days 1

Condition Field Operation Value

Fund Group Status = Completed

Fund Type = Account Fund

Action Sequence

CS Account Fund 1

Argument Value

ProcessName CSIntegSEBLSIAFundUpsertOutboundFlow
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To run Generate Triggers from the command line

1 Go to cmd.

2 Navigate to the Siebel Enterprise Server Installation>\siebsrvr\bin directory.

3 Type 

Srvrmgr /g <gateway server name:port> /s <Siebel server name> /e <Enterprise name> 
/u <username> / p <password> (Example: srvrmgr /g sdcp1952i028:4330 /s sdcp1952i028 
/e siebel /u sadmin /p sadmin)

4 Press Enter to connect to the server manager.

5 Type

start task for comp gentrig with PrivUser='<Previledge Username>',PrivUserpass='< 
Previledge User Password>', exec='True'

(Example: start task for comp gentrig with 
PrivUser='siebel',PrivUserPass='db2',exec='true')

6 Press Enter to start the GenTrig task.

NOTE: You must have sufficient privilege to run the GenTrig task.

7 Type list task for comp gentrig

8 Press Enter to display the status of the task.

Running the Workflow Monitor
You must start Workflow Monitor Agent in order to execute your policies. Workflow Monitor Agent 
checks to see when the conditions of policies are met.

To run Workflow Monitor Agent from the command line

1 If you are not connected to the server manager, then do the following steps:

a Go to cmd.

b Go to the <Siebel Enterprise Server Installation>\siebsrvr\bin directory.

c Type

Srvrmgr /g <gateway server name:port> /s <Siebel server name> /e <Enterprise 
name> /u <username> / p <password>

Example: srvrmgr /g sdcp1952i028:4330 /s sdcp1952i028 /e siebel /u sadmin /p 
sadmin

d Press Enter to connect to the server manager.

e Type

start task for comp workmon with TableOwner=' <Table Owner> ', tableownpass='< 
Table Owner Password >', Actionagent='false', Groupname=<Workflow Policy Group 
Name>'
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Example: start task for comp workmon with 
TableOwner='smkrdev',tableownpass='smkrdev',Actionagent='false', 
BatchMode='true', Groupname='CS Account Fund'

f Press Enter to start the WorkMon task.

2 Type 

list task for comp workmon

3 Press Enter to display the status of the task.

Synchronizing Records from Oracle Trade Management
Oracle Trade Management has a procedure to update records after the Oracle server has gown down. 
After a connection is restored, the integration passes an error message asynchronously. The error 
message is part of a notification to the administrator that includes the process name, BPEL instance 
ID, and the text of the error message.

Generally, the message text stores error information in a table of entries under object type and 
object ID. For deductions, the object type is Deduction, and the object ID is DeductionID. Similarly 
for accruals, the object type is Accrual, and the object ID is UtilizationID.

A CC job, OZF-TM: Reprocess Accruals and Claims, resends the data, depending on the parameter 
that you specify provide.

The message reflects two processes:

■ CRMIntegDeductionEBS11i10ToSEBL80Sync - Deduction Oracle To Siebel

■ CRMIntegAccrualEBS11i10ToSEBL80Sync - Accrual Oracle To Siebel

To run the OZF-TM job

1 Navigate to Oracle Trade Management Administrator > Run > Request.

2 Select job OZF-TM: Reprocess Accruals and Claims.

3 Select the desired parameter:

a Deduction ID/Deduction for deductions

b Utilization ID/Accrual for accruals

c No parameter, the default, to process everything in the table

4 Submit the job request.
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4 Integrations

This chapter describes the integration points in the Siebel CRM Integration Pack for Trade Promotion 
Management for the Oracle E-Business Suite. This product consists of the following integration 
points:

■ Budget Integration on page 159

■ Deduction to Resolution Integration on page 164

■ Promotion-Deal Integration on page 165

■ Product Integration on page 166

■ Account Integration on page 166

Budget Integration
A trade fund is a named appropriation of money to be spent on promotions over a specific period of 
time for specific accounts and specific categories and products. The two types of funds are fixed and 
accrual. Fixed funds are fixed amounts of money allocated in a lump sum. Accrual funds are funds 
in which the amount of money is calculated based on product movement. Consumer goods 
companies spend millions of dollars in trade funds to promote growth and favorably impact the point 
of sale at retailers. Effectively facilitating the process by which trade funds are created and allocated 
to accounts is a critical success factor for any comprehensive CRM solution. The Siebel Trade 
Promotion Management and Oracle Trade Management-Oracle E-Business Suite integration supports 
this functional need by using the Siebel user interface to create, administer, and manage trade funds. 
The integration also leverages the connectivity of Oracle Trade Management to facilitate the flow of 
trade fund information to Oracle E-Business Suite to perform the necessary accounting transactions.

Creation of Fixed and Accrual Funds
All fixed funds, accrual funds, and related budgets created in Siebel Trade Promotion Management 
are imported into Oracle E-Business Suite when the budget status is changed to Complete in Siebel 
Trade Promotion Management. Only active budgets are imported into Oracle E-Business Suite 
because all approval related processes are managed within Siebel applications and have no 
interaction point with Oracle E-Business Suite.

Fund Allocation
The Siebel Funds module supports an infinite funds hierarchy. For example, a parent fund can have 
child funds, which in turn can have child funds. With this capability, marketing administrators can 
break up a large fund into smaller funds. Child funds are sent to Oracle Trade Management when the 
status on each individual child fund is changed to Complete.
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Fund Grouping
Fund grouping is similar to fund allocation and involves creating a parent fund with the intent to 
distribute funds across customer accounts. In this case, a parent fund is created without a customer 
association, and then child funds and allocations are generated for the parent fund by specifying a 
distribution percent for each child fund. Further, each child fund is associated with a customer 
account.

In the case of a group fund, only the child fund details are imported into Oracle E-Business Suite 
both because the parent fund is not treated as an independent fund or budget and the child fund 
created by group funds does not carry any association with the parent fund. Child funds are sent to 
Oracle Trade Management when the status of each individual child fund is changed to Complete. The 
status field for child funds appears read-only on the fund group screen, and you must navigate to 
the account funds screen to change the status of individual account funds. Also, because multiple 
fund grouping records can have an interface at the same time, the integration provides for it.
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Fund Updates
Siebel users can update or make changes to funds after they are active. Siebel administrative users 
can perform most of these changes, which have an impact on the functioning of the funds. Table 82 
lists updates and changes that can occur in Siebel Trade Promotion Management and their impact on 
the integration. All updates listed are synchronously integrated with Oracle E-Business Suite to 
ensure accurate accrual calculations and posting to Oracle General Ledger.

Table 82. Updates and Changes in Siebel Trade Promotion Management and Their Impact on the 
Integration

Update in Siebel Trade 
Promotion Management Action Impacted Fields

Siebel users can change the 
account associated with a 
fund.

Oracle E-Business Suite 
internally updates the market 
eligibility on the budget based 
on the updates performed in 
Siebel Trade Promotion 
Management. No retroactivity in 
terms of customer or market 
eligibility adjustments is 
supported by Siebel Trade 
Promotion Management.

Market eligibility on the funds

Siebel users can change the 
source categories associated 
with a fund.

Oracle E-Business Suite 
internally updates the product 
eligibility on the budget based 
on the updates performed in 
Siebel Trade Promotion 
Management. No retroactivity in 
terms of product or product 
categories adjustment is 
supported by Siebel Trade 
Promotion Management. 

Product eligibility on the funds

Siebel users cannot delete 
funds but can end-date 
them. In case of fund end-
dating in Siebel Trade 
Promotion Management, 
Oracle E-Business Suite 
ensures that no active deals 
or promotions sourced from 
the funds exist at the time of 
end-dating.

An end date is added to or 
updated on funds so that they 
stop accruing.

No impact



Siebel CRM Integration Pack for Trade Promotion Management 
Implementation Guide Version 1.00

Integrations ■ Budget Integration

162 

Budget Mappings
Table 83 lists the mappings for fixed fund creation.

Siebel users can modify the 
accrual rate or percent 
associated with a source 
category on live funds. Also 
users can change or edit the 
end date for source category 
items.

Oracle E-Business Suite 
internally updates the discount 
percent or amount and end date 
for discount lines on the accrual 
budget based on the updates 
performed in Siebel Trade 
Promotion Management. No 
retroactivity in terms of accrual 
rate adjustments is supported 
by Siebel Trade Promotion 
Management.

Discount rules table for accrual 
budgets

Siebel users can change the 
Organization associated with 
a fund.

No Action No Impact

Siebel users can change or 
edit the basis end date for 
accrual funds. 

Oracle E-Business Suite 
internally updates the end date 
on the accrual budgets based on 
the updates performed in Siebel 
Trade Promotion Management. 

End date on accrual budget

Table 83. Budget Mappings for Fixed Fund Creation

Attribute Name in Siebel Trade 
Promotion Management Attribute Name in Oracle E-Business Suite

Account Customer Account

Name Budget Name

Type Setup Type

Amount Budget Amount

Organization Operating Unit

Currency Currency

Exchange Date Exchange Date

Table 82. Updates and Changes in Siebel Trade Promotion Management and Their Impact on the 
Integration

Update in Siebel Trade 
Promotion Management Action Impacted Fields
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Table 84 lists the mappings for accrual fund creation.

Start Date Budget Start Date

N/A Category

Table 84. Budget Mappings for Accrual Fund Creation

Attribute Name in Siebel Trade 
Promotion Management Attribute Name in Oracle E-Business Suite

Account Customer Account

Name Budget Name

Type Setup Type

Organization Operating Unit

Basis Start Date Budget Start Date

Basis End Date Budget End Date

Currency Currency

N/A Accrue To

N/A Accrual Basis

N/A Discount Level

N/A Liability Flag

N/A Category

Source Category Item Category for discount rules table

Source Product Id Line Id

Start Date From

End Date To

Accrual Rate Discount & Discount Type

Accrual Percent Discount & Discount Type

N/A Tier Type

Table 83. Budget Mappings for Fixed Fund Creation

Attribute Name in Siebel Trade 
Promotion Management Attribute Name in Oracle E-Business Suite
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Deduction to Resolution Integration 
Oracle Trade Management passes deductions created in Oracle Receivables, manually or by lockbox, 
to Siebel Trade Promotion Management so that salespersons, sales managers, and customer sales 
representatives can research and resolve these deductions. In addition, all settlements for the 
deductions established in Siebel Trade Promotion Management are communicated back to Oracle 
Trade Management, which, in turn, passes the settlement document to Oracle Receivables or Oracle 
Payables based on the settlement method.

From the viewpoint of Oracle Trade Management, two main components are involved in the execution 
of this flow:

1 Deduction and subsequent receipt or adjustment export:

■ Exporting all new deductions to Siebel Trade Promotion Management 

■ Exporting any changes or updates to deduction that occur in the Oracle Receivables system, 
such as the following:

❏ Subsequent receipts

❏ Subsequent adjustments

2 Resolution Import:

■ Importing a resolution document from Siebel Trade Promotion Management for the following 
items:

❏ Credit Memo

❏ Previous Open Credit

❏ Check

❏ Chargeback

❏ Write Off

■ Importing deduction split details from Siebel Trade Promotion Management

■ Importing promotional accrual settlement details from Siebel Trade Promotion Management

Deduction Creation
All deductions that come into Oracle Trade Management from Oracle Receivables are exported into 
Siebel Trade Promotion Management. Oracle Trade Management internally generates values for 
various fields captured here in a way similar to how it does currently with some exceptions. However 
because only some values are exposed on the Siebel user interface, these are the only values that 
are exported to the Siebel application. Similarly all subsequent receipts, adjustments, and updates 
to deductions that occur in Oracle Receivables are exported to Siebel Trade Promotion Management 
on a real time basis.
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Deduction and Claim Resolution
After you research the deductions in Siebel Trade Promotion Management, you initiate settlement of 
these deductions from that application. An import mechanism pulls resolution information from 
Siebel Trade Promotion Management into Oracle Trade Management. This import qualifies all claims 
and deductions that have a resolution of status Submitted for a feed into Oracle Trade Management. 
On receiving this feed, Oracle Trade Management internally triggers an update to its deductions, 
releases accruals if any are associated with the deduction, and coordinates the settlement document 
either with Oracle Receivables or Oracle Payables based on the resolution type. Deduction resolution 
requires and uses synchronous integration. Siebel Trade Promotion Management supports the 
following methods for deduction and claim resolution:

■ Credit Memo Resolution: A user determines that a company owes money to a customer and 
indicates that a credit be generated for the customer. A credit memo resolution can result from 
a promotional or accrual payment, in which case the user also associates a promotion or fund 
with the resolution.

■ Previous Open Credit Resolution: A user can query existing open credits and apply them to open 
deductions and indicate resolution by a previous open credit.

■ Chargeback Resolution: A user determines that a deduction is invalid and indicates a chargeback 
be generated for a customer.

■ Write Off: A user cannot associate the deduction with a valid justification but at the same time 
realizes that the claim amount is minimal and hence simply chooses to write off the deduction.

Promotion-Deal Integration
To achieve synchronization between Siebel Trade Promotion Management and Oracle Trade 
Management, Siebel CRM Integration Pack for Trade Promotion Management passes all customer 
deals from Siebel Trade Promotion Management to Oracle Trade Management. The integration also 
ensures that if a deal is updated, then the recall, deletion, or update of the deal in the Siebel Trade 
Promotion Management is also reflected in Oracle Trade Management. 

The integration creates and updates the following deal types:

■ Bill-Back Deal 

■ Off-Invoice Deal

■ Fixed-Cost Deal

After Siebel Trade Promotion Management creates a deal, Oracle Trade Management creates a 
corresponding offer, and all promotional accruals are calculated against the offer from Oracle Trade 
Management. Upon calculation, the accruals are adjusted against the Oracle Trade Management 
Offer/Budget and corresponding Siebel Trade Promotion Management deal or fund. Accrual related 
information and all the shipment related information are passed back and made available to Siebel 
Trade Promotion Management.
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Product Integration
The integration of a simple product within Siebel CRM Integration Pack for Trade Promotion 
Management has the following basic steps. Steps 1 through 4 occur in an Oracle BPEL business 
process flow, while steps 5 through 7 occur in a Siebel workflow process:

1 Query for a simple product from Oracle E-Business Suite.

2 Transform the product message object to a common message object (COM) for simple products 
(coProduct).

3 Transform the common message object to a Siebel message.

4 Invoke the Siebel web service to create or update the product in Siebel Trade Promotion 
Management.

5 Receive the Siebel product messages.

6 Map the Siebel product messages to the wrapper business service.

7 Invoke the Siebel ImpExp business service to create the product.

Figure 1 shows the synchronization flow for a simple product, as described in the preceding text of 
this paragraph.

Account Integration
Whenever a new customer account is created within Oracle E-Business Suite, Siebel CRM Integration 
Pack for Trade Promotion Management initiates real-time synchronization between the related party-
customer account in Oracle E-Business Suite and a new account in Siebel CRM applications.

Figure 1. Synchronization Process Flow for a Simple Product
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All entities in the initial bulk load are synchronized with Siebel CRM so that users can transact against 
them in Siebel applications. Therefore, users can tie an opportunity or capture an order in Siebel 
CRM against a customer that was created in Oracle E-Business Suite. Similarly, new account sites 
and new account site are synchronized with Siebel applications when a new or existing party site 
(use) is associated with an account as an account site (use).

Updates to any supported customer entities in Oracle E-Business Suite are synchronized with Siebel 
CRM in real time.
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Index

No index is available for this guide.
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